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Preface

4th Dimension is a powerful relational database for the Macintosh and 
Windows platforms. As an integrated database environment, 
4th Dimension offers a complete solution to your Web publishing and 
database needs.

About the Manuals
The manuals described below provide a guide to the features of both 
4th Dimension and 4D Server. The only exception is the 
4D Server Reference, which describes features exclusive to 4D Server.

4th Dimension QuickStart leads you through example lessons where you 
create and use a 4th Dimension database. These examples provide 
hands-on experience that help you become familiar with the concepts 
and features of 4th Dimension and 4D Server.

The User Reference provides a description of the User environment — 
the environment in which you use databases and forms to enter and 
manipulate data.

The Design Reference is a guide to the Design environment and provides 
detailed descriptions of the operations that you can perform in this 
environment. You should use it in conjunction with the other volumes 
in your documentation package.

The Language Reference is a guide to using the 4th Dimension language 
as well as the Web Server. Use this manual to learn how to customize a 
database by incorporating 4th Dimension commands and functions.

The 4D Server Reference is a guide to installing 4D Server and managing 
multi-user databases with 4D Server. 
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Supplemental manuals are also available. These manuals are 
particularly in reference to utility programs packaged with 
4th Dimension and 4D Server (4D Customizer Plus, 4D Tools, etc.).

About This Manual
This manual serves as a reference to 4th Dimension’s User environment 
and provides detailed descriptions of the operations that you can 
perform in this environment. It should be used in conjunction with 
the other manuals in the 4th Dimension package.

To use this manual effectively, you should first work through the 
exercises in 4th Dimension QuickStart and start to create your own 
database, referring to the 4th Dimension Design Reference when you need 
to review a process or explanation.

You can then proceed to enter and manipulate data in your database, 
referring to this manual when you need to review a process. 

Windows/Mac™OS 
versions

This manual details use of 4th Dimension both on the MacOS and 
Windows platforms. Although the concepts and functionality of both 
versions of 4th Dimension are nearly identical, the manual addresses 
any differences where necessary. Such differences include the graphical 
user interface and keyboard commands.

This manual contains graphics illustrating the Windows environment. 
If there is a substantial difference in the appearance of the MacOS 
version of a window or dialog box, it is also presented.

Chapter 
Descriptions

This manual is divided into the following chapters and appendices.

■ Chapter 1, “Introduction to the User Environment” introduces you to 
some basic User environment concepts such as the current selection, 
using tables and forms, and processes. It also describes some basic 
operations, such as entering a password-protected database, and 
provides an overview of the User environment menus.

■ Chapter 2, “Managing Structure and Data Files” provides an overview 
of 4th Dimension desktop files.

■ Chapter 3, “Data Entry” describes how to use input and output forms
and how to access forms from different tables.
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■ Chapter 4, “Selecting Records” explains how to create a selection of 
records using the commands in the Queries menu and how to use the 
various search methods to select a specific record or group of records.

■ Chapter 5, “Working with Records” explains how to add, modify, and 
delete records. It also describes how to use the Formula editor to 
automatically update records based on a formula (for instance, adding 
two days to the vacation balance in each employee’s record).

■ Chapter 6, “Sorting Records” describes how to place a selection of 
records in order by sorting them based on the values in one or more 
fields.

■ Chapter 7, “Form Reports” explains how to print reports that use forms 
created in the Design environment.

■ Chapter 8, “Quick Reports” explains how to use the Quick Report 
editor to print data in a columnar report. The chapter describes how to 
design the report using fields from your database as columns in the 
report and how to enhance the report by dividing data into sorted 
groups and performing summary calculations for each group.

■ Chapter 9, “Labels” explains how to use the Label Wizard to design 
and print labels.

■ Chapter 10, “Graphs” explains how to create, modify and print various 
types of graphs using 4D Chart. It also describes how to add a variety 
of objects to your graphs, and how to add dynamic references to field 
values or to 4th Dimension expressions.

■ Chapter 11, “Executing Methods” provides instructions on how to 
execute a project method in the User environment and how to start a 
new process for the method or run it on the server computer as a 
stored procedure.

■ Chapter 12, “Importing and Exporting Data” explains how to import 
and export records and how to use an ASCII map to transfer records 
from different operating systems.

■ Chapter 13, “Web Server” provides an overview of 4th Dimension’s 
capabilities as a Web server and explains how to start and stop 
Web service from the User environment.

■ Appendix A, “ASCII Maps” describes how to create ASCII maps for 
importing and exporting data between 4th Dimension and other appli-
cations.
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Conventions All the manuals in your documentation package, including this one, 
use certain conventions to help you understand the material. 

The following explanatory notes are used:

Note Text emphasized like this provides annotations and shortcuts that will 
help you use 4th Dimension more productively.

4D Server Throughout the manual, 4th Dimension and 4D Server/4D Client are 
referred to simply as 4th Dimension. Differences between the operation 
of the two products are explained in 4D Server notes, which provide 
information about using 4D Server/4D Client. This information is 
provided only when the operation of 4D Server/4D Client differs from 
that of 4th Dimension.

Notes like this alert you to important pieces of information and alert 
you to situations where data might be lost.

In addition, all table names are shown in brackets in the text to help 
distinguish them from the names of fields, forms, and other items. For 
instance, the Employees table is written as the [Employees] table.

Using Hypertext You can take advantage of the hypertext buttons that have been added 
to this manual. All hypertext buttons are printed in blue text. A 
hypertext button looks like this: “For information on using 
4th Dimension as a Web server, see Chapter 13, “Web Server,” on 
page 327.”

You can click a hypertext button to read additional information about 
the topic. You can then use the Adobe Acrobat Go Back button to 
retrace your steps.
14 4th Dimension User Reference



1 Introduction to the 
User Environment

This chapter provides an overview of the 4th Dimension User environ-
ment. It describes important User environment concepts and the User 
environment menus. 

In this chapter, you will learn about:

■ The 4th Dimension environment

■ The 4th Dimension plug-ins

■ The 4th Dimension components

■ 4D Server and 4th Dimension

■ The User environment

■ User environment concepts such as the current selection, tables and 
fields, and multi-tasking

■ Opening a database with another data file

■ Choosing a log file

■ Entering and using a password-protected database

■ The User environment menus
154th Dimension User Reference



Chapter 1  Introduction to the User Environment
The 4th Dimension Environments
4th Dimension manages data, performs calculations on that data, and 
produces output such as summary reports and graphs. These types of 
operations are performed in 4th Dimension’s User environment.

The User environment is the environment in which you enter and man-
age data. You use the User environment to:

■ Add, modify, and delete records

■ Search for a specific record or group of records

■ Create labels, reports, and graphs that use the information in your 
database

■ Import and export data between 4th Dimension and other applications

■ Execute methods

■ Control the publication of the database on the Web

You perform these operations on databases that have been created in 
the Design environment. The Design environment is the environment in 
which you create a database. You design its structure by creating tables 
and fields to store data, forms for data entry and reports, and other fea-
tures such as a password access system.

You can also use the Design environment to create a custom applica-
tion. A custom application has its own menu bars, entry screens, and 
editors. By creating menus and menu bars in the Design environment, 
you can design an application that suits your needs exactly and 
includes only the features you want.

A custom application can be used in 4th Dimension’s Custom Menus 
environment or deployed on 4D Server and 4D Client.

Using the 4th Dimension language, you can include some or all of the 
functions of the User environment in a custom application. For exam-
ple, a custom application can include menu commands that display 
the User environment’s Quick Reports and Labels editors.

To create a stand-alone Windows or Macintosh application, you can 
compile your application and merge it with a 4D engine.
16 4th Dimension User Reference



The 4th Dimension Plug-ins
The 4th Dimension Plug-ins
In addition to the built-in functionality of 4th Dimension, 4D offers 
several plug-ins that work with your database to enhance its capabili-
ties. These plug-ins include the following:

■ 4D Chart, a graphing application that is included with 4th Dimension,

■ 4D Write, a word processing plug-in,

■ 4D Draw, an object-oriented drawing plug-in,

■ 4D Backup, a database backup utility,

■ 4D View, a spreadsheet and data presentation plug-in,

■ 4D ODBC, a developer’s tool that allows you to communicate directly 
with an ODBC database,

■ 4D for OCI, a developer’s tool that allows you to communicate directly 
with an Oracle’s OCI8,

■ 4D Open for 4D, a developer’s tool that lets 4th Dimension 
(single-user) databases access data in 4D Server.

These products are designed to be used within your 4th Dimension 
database. For example, 4D Write and 4D Draw plug-ins allow you to 
include such things as letters and drawings in special areas called 
plug-in areas. These areas appear as part of your data, just like a name 
or any other piece of information. The 4D Chart plug-in is already 
built into 4th Dimension to facilitate graphing of your database infor-
mation.

You can also treat the 4D View, 4D Write, 4D Draw, and 4D Chart 
plug-ins as if they were separate applications by using them in their 
own windows. Your work within these windows can be independent of 
your database or linked to information in your database or in other 
plug-ins.
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The 4th Dimension Components
You can install 4D components within any 4th Dimension database. A 
component adds one or more additional functions to the database. For 
example, it is possible to develop, and install, an e-mail component 
within a 4th Dimension database. 
Unlike plug-ins, 4D components are composed uniquely of 4D objects 
(tables, methods, forms, menu bars, etc.)

4D components are managed and installed using 4D Insider. Each 
component object is defined as either “public”, “protected”, or “pri-
vate” that determines if it is visible or able to be modified once 
installed. Components allow developers to commercialize original 
solutions in total security. For more information on components, 
please refer to 4D Insider Reference manual.

4D Server and 4th Dimension
You can create single-user and multi-user databases with:

■ 4th Dimension (single-user)

■ 4D Server and 4D Client (multi-user)

4th Dimension is a single-user database application. In a single-user 
database, operations such as entering data into a record or searching 
for a specific record are performed by one user at a time, working on a 
single computer. Both 4th Dimension and the database on which the 
user is working are stored locally on the user’s machine.

4D Server and 4D Client together form a multi-user database applica-
tion in which database operations can be performed by several users at 
a time. The users connect to databases from client computers that are 
connected over a network to a dedicated computer (a server) running 
4D Server. 

To set up a multi-user database, you install 4D Server along with the 
database on a separate computer. A copy of 4D Client is then installed 
on each user’s computer. A user accesses the database by launching his 
or her copy of 4D Client. 
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Whenever a user performs an action such as entering data or generat-
ing a report, 4D Server updates the tables on the server computer and 
performs all necessary calculations. Changes made by one user are 
updated on the server so that all users view the most recent informa-
tion. For more information about 4D Server and 4D Client, refer to the 
4D Server Reference manual.

However, the single-user version of 4th Dimension is comparable to a 
multi-user environment when the database is published as a Web 
server. In this case, if custom menus or specific methods have been 
created, Web browsers that connect to the database via the Internet or 
Intranet will have access to the data, in the same way as client 
machines (creation, deletion and modification of records). However, 
unlike 4D Client, a Web browser cannot gain access to the structure of 
the database.

Of course, 4D Server can also publish your database as a Web server, 
which gives both 4D Client machines and browsers simultaneous 
access to it. Moreover, each 4D Client machine can also become a Web 
server. 
For more information about Internet or Intranet operation on your 
database, refer to chapter 13, “Web Server,” as well as the Language 
Reference manual of 4th Dimension. 

The User Environment
The User environment is where you work with your data. The menus 
and editors in this environment provide a complete set of tools for 
managing information. You can use the User environment to:

■ Import or export data

■ Enter, modify, or delete records

■ Search for records and sort lists of records

■ Create and print reports, labels, and graphs

■ Choose a log file

■ Run processes that enable you to perform more than one operation 
simultaneously, also known as multi-tasking

■ Start and stop the built-in Web Server. 
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Choosing a log file and multi-tasking are discussed later in this chapter. 
All other User environment features are explained in the remainder of 
this manual.

Tables and Forms In a 4th Dimension database, you store information in tables. Ideally, 
each table stores a different type of information. For example, a Con-
tacts database might have one table that stores information about peo-
ple and another table that stores information about companies. 

In the User environment and custom applications, you use forms to 
enter and manage data. Each table in your database has an input form 
and an output form.

An input form displays one record at a time. You use an input form 
to enter, view, and modify information in a single record. In the User 
environment and custom applications, the input form is sometimes 
called the Detail form.

An output form displays several records as a list. You use an output form 
to browse through records, select and sort records, and print a selec-
tion of records. You can also enter and modify records directly in an 
output form. In the User environment and custom applications, the 
output form is sometimes called the List form. When you are working 
with a List form, you can display an individual record in its Detail form 
by double-clicking a record.

You can switch from one table to another and change the input and 
output forms with which you work. You will learn how to do this in 
Chapter 3.

The Current 
Selection

When managing data, you select the group of records with which you 
want to work. This group of records is called the current selection. The 
current selection can contain none, one, some, or all records in a table. 
Every table has a current selection of records.

The current selection is an important concept in 4th Dimension. The 
most common data management operations are performed on the 
records in the current selection. 
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These operations include:

■ Sorting records

■ Viewing and modifying individual records

■ Updating a group of records

■ Printing a report

■ Generating labels

■ Graphing data

■ Exporting records.

The current selection of records is always the set of records most 
recently selected. For instance, you might have a company database 
that uses an employees table to keep track of employee records. Sup-
pose that you decide to search for the records of all engineers in the 
company. 

When this query begins, the current selection may contain the records 
of all employees in the company — salespeople, production personnel, 
engineers, and so on. When the query is completed, the current selec-
tion contains only the engineers’ records. 

If you were to print a list of records, the list would contain only the 
records in the current selection — in this case, the records for all of the 
engineers in the company. If you were to graph employee salaries, your 
graph would display the salaries for all of the engineers in the company.

The current selection remains the same until you perform an operation 
that changes it. You change the selection of records in a table when-
ever you select records manually or do a query that selects records. 
Search operations are performed by menu commands in the Queries 
menu, such as Query by Example, which searches for records based on 
the entries you specify for fields in a form.

To restore the current selection to all of the records in the table, you 
choose Show All from the Queries menu.

For more information about selecting records, refer to Chapter 4.
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Multi-tasking in 4th Dimension
When you are working with a database, you typically perform a single 
action at a time — one query, one sort, printing one report.

At times, you would like to be able to perform several actions at once. 
For example, you might want to enter data into an employee’s record 
while a large group of records is printing. You might also want to view 
two selections from the same table (such as engineers in one window 
and salespeople in another) simultaneously.

4th Dimension provides such multi-tasking capabilities by enabling 
you to perform operations in separate processes. A process is a 
4th Dimension task that executes actions specified by a method. 

Although you write methods in the Design environment, you can exe-
cute them in the User environment. When you do so, you can choose 
to start a new process for the method. The method then executes in a 
separate process, allowing you to continue working in another process.

You can start as many processes as you want. The number of processes 
open concurrently is limited only by the amount of memory on your 
computer.

For information about using Execute Method to start a new process, 
refer to Chapter 11 of this manual. For complete information about 
creating and managing processes, refer to the 4th Dimension Design 
Reference.

4th Dimension Desktop Files
On Windows, a 4th Dimension database consists of four disk files: a 
structure file, a structure resource file, a data file, and a data resource 
file. On Macintosh, the contents of the structure and structure resource 
files are contained in a single file, the structure file; the contents of the 
data and data resource files are contained in a single file, the data file.

When you create a new database, 4th Dimension places the structure, 
resource, and data files in the same folder. If you check the Create 
Database Folder check box in the Open Databases dialog box, all the 
database files will be saved into a new folder. 

■ The structure file (denoted by the file extension .4DB on Windows) 
contains all of your specifications for the design of the database.
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■ The structure resource file (denoted by the file extension .RSR on 
Windows) contains resources used by the structure file. These resources 
might include pictures or strings. On Macintosh, there is no resource 
file. The contents of the Windows resource file are stored in the 
Macintosh structure file.

■ The data file (denoted by the file extension .4DD on Windows) con-
tains your data and any indexes you build. On Macintosh, the data file 
has the suffix “.data”.

■ The data resource file (denoted by the file extension .4DR on 
Windows) contains resources used by the data file. On Macintosh, 
there is no resource file. The contents of the Windows resource file are 
stored in the Macintosh data file.

Please refer to Chapter 2 for details on database files.

Choosing and Opening a Log File
For many databases, it is essential to protect important data from cor-
ruption or from inadvertent errors. Data that has been accidentally 
deleted or modified by a user can mean anything from extra work to 
reenter the data to a situation in which the data is irretrievably lost. 

4th Dimension’s backup utility, 4D Backup, can help prevent this type 
of problem by allowing you to back up your database before such an 
accident occurs. With 4D Backup, you create a backup of your database 
and a log file that tracks all changes since the last backup. 

If necessary, the database can be restored to the state it was in at a pre-
vious point in time—before records were deleted, changed, and so on.

❿❿❿❿ To open an existing log file:

1 Open the database.

2 Choose Log File from the File menu in User mode.
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An open-file dialog box appears.

3 To use an existing log file, select the log file name and click Open.
OR
Double-click the log file name in the list of filenames.

Note Log files in 4th Dimension for Windows are denoted by the file 
extension .4DL. On Macintosh, the log files have the suffix “.log”.

❿❿❿❿ To create a new log file in an empty database or after a full backup:

1 Open the database.

2 Choose Log File from the File menu in User mode.

3 Click the New button in the Open File dialog box.
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If you have created a backup, 4th Dimension displays the following 
dialog box:

In the File Name text area, 4th Dimension automatically enters a name 
for the new log file based upon the name of the current structure file.

4 To enter a new name for the log file, type the name in the File Name 
area.
Names of any other log files associated with the structure file are 
displayed in the scrollable area below the File Name text area.

5 Click Save.
4th Dimension creates a log file that keeps track of all changes made to 
the database since the last backup.

Unlike 4th Dimension databases, log files created in 4th Dimension for 
Windows cannot be used in 4th Dimension for Macintosh. Similarly, a 
log file created in 4th Dimension for Macintosh cannot be used in 
4th Dimension for Windows. A log file can be used only on the 
platform on which it was generated.
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If your database becomes damaged or if you want to reverse a user 
error, you can use 4D Backup to return the database to a previous state. 
For complete information about using 4D Backup, refer to the docu-
mentation that comes with 4D Backup.

Note To disable a log file, choose No Log File from the File menu.

4D Server If you are using 4D Server, the Log File and No Log File menu 
commands are available only on the server. You cannot choose, create, 
or disable a log file from 4D Client’s User environment.

Password Protection
4th Dimension’s Design environment includes a comprehensive pass-
word access system. The access system is used to selectively grant 
access to parts of a database. Access can be granted to tables, record 
operations (e.g., adding, modifying, deleting, and viewing records), 
forms, menu commands, methods, and plug-ins. 

The password access system is based onthe notion of user groups. Each 
group has specific access rights and each user belongs to one or more 
groups. The users inherit the access rights of the groups to which they 
belong. 

Each user of the database is given a user name and a password. 
Depending on the type of access system implemented in your 
database, the user must do one of three things: 

■ Select a user name from a list and type a password, or

■ Type both a user name and password, or

■ Type a password only, or type nothing (if the database is in the 
“Default User” mode and no password has been assigned).

The second option provides extra security for a database by requiring 
that users enter both a valid user name and password. For more infor-
mation about designing the password access system, refer to the 
4th Dimension Design Reference manual.
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Entering a 
Password-protected 
Database

If a database is password-protected, you must identify yourself as a 
valid user before you are permitted access to the information in the 
database. 4th Dimension automatically displays an Enter Password dia-
log box whenever you open a password-protected database. You will be 
required to either enter your password or enter both your name and 
password.

❿❿❿❿ To enter a database protected by a password access system:

1 Open or connect to the database as you normally would.

2 If 4th Dimension displays the following Enter Password dialog box, 
select your user name from the user list and type your password in the 
Password entry area at the bottom of the dialog box.

OR

If 4th Dimension displays the following Enter Password dialog box, 
type both your user name and password in the entry areas.

Select your name

Type your password
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OR

If 4th Dimension displays the following Enter Password dialog box, 
the Default User mode1 is activated; type the password for the default 
user in the entry area.

Note that in the dialog boxes, a Lock icon is displayed in place of each 
character you type in the password entry area. 

Note Because the password access system is case sensitive, be sure to type 
your password using the correct uppercase and lowercase characters.

If you type the password correctly, you are given the level of access 
to the database that was specified when the access system was 
designed. If you type the password incorrectly, the computer beeps and 
does not allow you to open the database.

Using a 
Password-protected 
Database

After you have entered a password-protected database, you can use any 
part of the database to which you have been granted access. Unless you 
are the designer of the database or part of a group of users that has 
been given access to the Design environment, you will be unable to 
enter the Design environment.

The access system grants access to tables, record operations, forms, 
menus, methods, and plug-ins. If you try to use part of the database to 
which you do not have access, 4th Dimension displays an alert dialog 
box.

Note When the database is published as a Web server, the password system 
can be applied to browsers that connect to the database. For more 
information about this, refer to the “Connection Security” section in 
the Language Reference manual.

1. In the Default User mode, the password access system may be configured 
so that no dialog box is displayed. 
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User Environment Menus
This section briefly describes the commands in the User environment 
menu bar.

Menu Bar The User environment menu bar contains the following menus:

Toolbar The User environment also includes a toolbar of command buttons for 
easy access to frequently used menu commands. The buttons are 
grouped by the menu to which they correspond. 

When you move the pointer over a button, a button help message box 
(Tool tips) displays the command.

To choose a command from the toolbar, click its button.

Custom Menus and 
Toolbars

In addition to the built-in User environment menus and command 
buttons, you can add custom menus and buttons that will appear in 
the menu bar and the toolbar when a form is displayed. You use these 
custom commands to simplify complex or time-consuming tasks. 

File Edit Use Enter Queries Report Special

Open Database
Import Data
Export Data
Print

Undo
Cut
Copy
Paste
Clear
Select All

Design
User
Custom 
Menus

New
Record
Apply 
Formula

Show All
Query
Order by

Quick
Labels
Charts

Execute
Method
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File Menu The File menu contains the following commands for performing stan-
dard file operations:

■ Open Database  Displays the Open Database dialog box for you to 
open an existing database or create a new one. Before opening this 
dialog box, 4th Dimension first closes and saves the database that is 
currently open.This dialog box is discussed in the 4th Dimension Design 
Reference manual. 

■ Import Data  Displays a standard Open file dialog box, so you can 
designate the file containing data to import. For a discussion of 
importing data, refer to Chapter 12.

■ Export Data  Displays the Export Data dialog box so you can export 
records from the database. For a discussion of exporting data, refer to 
Chapter 12.

■ Log File  Displays a dialog box for you to select a log file or create a new 
one. For more information about log files, refer to “Choosing and 
Opening a Log File” on page 23.

■ No Log File  Disables the log file so that 4th Dimension no longer keep 
track of the database operations being performed. For more 
information about log files, refer to “Choosing and Opening a Log 
File” on page 23.

■ Choose Table/Form  Displays the Choose Table/Form dialog box so 
you can change tables or forms. For a discussion of choosing tables and 
forms, refer to “Choosing Tables and Forms” on page 76. 

■ Page Setup  Displays the Page Setup dialog box for the printer that you 
have specified.

■ Print  Displays the Choose Print Form dialog box so you can print 
reports using a form. For a discussion of printing reports using forms, 
refer to Chapter 7.
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■ Quit  Closes and saves the current database.

Note Under MacOS X, the Quit menu command is only available in the 4D 
application menu, at the system level. 

4D Server In 4D Client, the operations found in the User environment File menu 
differ from those listed, due to the division of the application between 
4D Server and 4D Client. First, the Open Database dialog box is not 
available for creating new databases since new databases are created 
directly on the server. For information about creating new databases, 
refer to the 4D Server Reference manual. The Open Database menu 
command in the File menu allows you to open a database located on 
the server. 
When you want to exit the database that is currently open, you choose 
the 4D Client Quit menu command. This operation exits the database 
on your client machine but does not close the database on the server. 
Finally, Log File and No Log File are not available in the 4D Client User 
environment File menu since log files can be created or disabled only 
on the server.

Edit Menu The Edit menu contains the following standard editing commands:

■ Undo

■ Cut

■ Copy

■ Paste

■ Clear

■ Select All

■ Show Clipboard.

Your system’s standard editing operations are covered in the user guide 
that came with your system. You can use these menu commands when 
managing data with 4th Dimension. 
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Use Menu The Use menu lets you change between the different environments of 
4th Dimension environments: Design, User, and Custom Menus. 
When the database has been compiled, you can also use this menu to 
change between running the database in interpreted or compiled 
mode. 

A checkmark is placed beside the current environment. Selecting a 
command that already has a checkmark has no effect.

■ Design  Switches to the Design environment. When you enter the 
Design environment, all of the Design environment menus and editors 
are available to help you design your database.

Note The Design menu command is dimmed if you do not have access 
privileges to this environment or if the database with which you are 
working has been compiled. 

■ User  Switches to the User environment.

■ Custom Menus  Switches to the Custom Menus environment. When 
you enter the Custom Menus environment, only the custom menus 
defined for the database are displayed in the menu bar. By default, 
4th Dimension creates a custom menu bar containing the File, Edit and 
Use menus.

■ Run compiled/Run interpreted: This command lets you change from 
one mode to the other. It is active when the database has been compi-
led at least once; otherwise, it is dimmed and the database automati-
cally operates in interpreted mode. 
When the database is running in compiled mode, the Design environ-
ment is no longer available. For more information about running in 
compiled mode, refer to the Design Reference manual. 
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Enter Menu The Enter menu contains the following commands used for entering 
and modifying data in records: 

■ New Record  Displays a blank input form for data entry. Choose 
New Record to begin entering data. 

■ Modify Record  Displays the selected (highlighted) record using the 
current input form. Modify Record is dimmed if no records are 
highlighted or if you are currently using an input form. 

■ Apply Formula  Displays the Formula editor. Choose Apply Formula to 
make changes to the current selection of records using a formula.

■ Enter in List  Toggles the Enter in List mode which allows you to enter 
and modify data using an output form. When the Enter in List mode is 
active, a check mark appears next to the menu command. 

For information about entering, modifying, and updating records, 
refer to Chapter 5.

Queries Menu The Queries menu contains the following commands for selecting, 
searching, and sorting records: 

■ Show All  Displays all the records in the table you are working with in 
the output form. Show All is dimmed if you are currently using an 
input form.

■ Show Subset  Displays only the group of records that is highlighted in 
the output form. Show Subset is dimmed if no records are highlighted 
or if you are using an input form.
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■ Query  Displays the Query editor. The Query editor is a general 
purpose search editor that you can use to perform many types of 
queries.

■ Query by Example  This menu command displays the current input 
form as a query-by-example window.

■ Query and Modify  This menu command also displays the current 
input form as a query-by-example window. When you use Query and 
Modify, the first record located by the query is displayed in the input 
form. 

■ Query by Formula  This menu command displays the Formula editor. 
Use Query by Formula when you want to search for records based on 
the results of a formula.

■ Order By  This menu command displays the Order By editor. Use 
Order By to sort the current selection. 

For a discussion of selecting and searching for records, refer to 
Chapter 4. For a discussion of sorting records, refer to Chapter 6.

Report Menu The Report menu contains commands that display the Quick Report, 
Label, and Chart editors. You use these editors to create a wide range of 
printed output.

The Report menu contains the following commands:

■ Quick  Displays the Quick Report editor. Use it to create and print 
columnar reports.

■ Labels  Displays the Label editor. Use it to create and print labels.

■ Charts  Displays the Chart Wizard. Use it to graph data.

The Quick Report, Label, and Chart editors are discussed in Chapters 8, 
9, and 10 respectively.
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Special Menu The Special menu contains three commands that control various fea-
tures of the User environment.

■ Edit Output ASCII Map  This command displays the Output ASCII 
Map dialog box. Use it to create or choose an ASCII map for exporting 
data.

■ Edit Input ASCII Map  This command displays the Input ASCII 
Map dialog box. Use it to create or choose an ASCII map for importing 
data.

■ Execute Method  This command displays the Execute Method dialog 
box. Use it to execute a project method from the User environment. 
When you execute a method from this dialog box, you can choose to 
execute the method in another process or (4D Server only) in another 
4D Client, and to start in debug mode. For more information about 
processes, refer to “Multi-tasking in 4th Dimension” on page 22.

ASCII maps are described in detail in Appendix A. The Execute Method 
dialog box is discussed in Chapter 11.

Web Server The Web Server menu contains two commands that turn the Web 
Server on and off, Start Web Server and Stop Web Server.

4th Dimension or 4D Server can act as a server to browsers on the 
World Wide Web. If your database is intended to provide this service, 
you can enable this feature using this menu or the Publish Database at 
Startup property in Preferences. Preferences can be set only in the 
Design environment. For information on Web publishing, see 
Chapter 13.

For information on using and configuring the built-in Web server, see 
the 4th Dimension Language Reference.
354th Dimension User Reference



Chapter 1  Introduction to the User Environment
Plug-ins Menu The Plug-Ins menu at the far right of the User environment menu bar 
lists the names of any 4th Dimension plug-ins are installed in your 
database. 4D Chart is automatically listed in this menu. The upper por-
tion of the menu contains the names of all plug-ins that have been 
installed. Choosing a plug-in from the Plug-Ins menu opens a window 
(document) for that plug-in.

The bottom portion of the Plug-Ins menu contains the names of any 
currently open plug-in documents. You can open as many documents 
for each plug-in as allowed by available memory. 

Note The included OLE tools plug-in (on Windows) is described in a 
separate manual. 

Help Menu The Help menu gives you access to the on-line Help available for the 
application. It also contains the Update License... command, which 
lets you add or delete serial and/or expansion numbers. For more infor-
mation about this dialog box, refer to the 4th Dimension Installation 
Guide. 

Under Windows, the Help menu also contains the About 4th 
Dimension command; under MacOS X, this command is found in the 
Application menu, at the system level; under MacOS 9, it is found in 
the Apple menu. The About dialog box provides various information 
about the 4th Dimension program being executed, the database, the 
system configuration and the 4D company. 

Custom Menus for 
Forms

The Form editor (available in the Design environment) lets you associ-
ate a menu bar with a form. Whenever the form is used as an input 
form or is displayed by programming, the menus on the custom menu 
bar are appended to the User environment’s menu bar. 

Custom menu
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You use the menus and menu commands on the custom menu bar for 
specialized functions. For example, a custom menu might contain 
menu commands that display custom search dialog boxes, print 
reports, or import data using a special format. You use custom menu 
bars as you would use menus and menu commands in any application.

Refer to the 4th Dimension Design Reference manual for more informa-
tion about designing custom menu bars and associating menu bars 
with forms.
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2 Managing Structure and 
Data Files

This chapter provides an overview of 4th Dimension desktop files. 

4th Dimension Desktop Files
Under Windows, a 4th Dimension database consists of four desktop 
files: a structure file, a structure resource file, a data file, and a data 
resource file. When you create a new database, 4th Dimension places 
the structure, resource, and data files in the same folder. If you check 
Create Database Folder checkbox in the Open Database dialog box, all 
the database files will be saved into a new folder.

■ The structure file (denoted by the file extension .4DB) contains all of 
your specifications for the design of the database.

■ The structure resource file (denoted by the file extension .RSR) 
contains resources used by the structure file. These resources might 
include pictures or strings. 

■ The data file (denoted by the file extension .4DD) contains your data 
and any indexes you build.

■ The data resource file (denoted by the file extension .4DR) contains 
resources used by the data file.

On Macintosh, a 4th Dimension database consists of two desktop files, 
the structure file and the data file. The structure resource file is merged 
with the Macintosh structure file and the data resource file is merged 
with the Macintosh data file. The structure file has no suffix on Macin-
tosh, while the data file has the suffix .data.
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Naming Directories If you check Create Database Folder check box in the Open Database 
dialog box, the directory (folder on Macintosh) is given the name you 
assign to the database. For example, if you name a database Contacts, 
the directory will be named Contacts, the structure file will be named 
Contacts.4DB, the structure resource file will be named Contacts.RSR, 
the data file will be named Contacts.4DD, and the data resource file 
will be named Contacts.4DR. 

On Macintosh, the folder is given the name you assigned to the 
database, followed by an “ƒ”. The data file is also given the same name, 
followed by “.data”. For example, if you name a database “Contacts,” 
the folder will be named Contacts ƒ, the structure file will be named 
Contacts, and the data file will be named Contacts.data.

On Windows, the data resource file (denoted by the file 
extension .4DR) contains Macintosh resources pertaining only to the 
data file, such as the WEDD resource that links a data file with a partic-
ular structure file.

Structure and Data 
File Locations

4th Dimension does not require that the structure and data files have 
the same names, be in the same directory, or be on the same volume. 
You can move either the structure or data file to new locations on the 
same hard disk or to different hard disks. However, the structure and 
resource files must always be in the same location. In the same way, 
the data resource file must be kept in the same location as the data file. 

When you open a structure file, you can choose to use a data file other 
than the one you initially created or you can create a new data file. 
This option gives you the ability to use more than one set of data with 
the same structure file. For example, a developer can use a “dummy” 
data file while working on the database off-line and then redeploy the 
improved structure file with the “real” data file when the development 
is finished.
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If you separate the data file from the structure file by moving it, you 
will need to indicate the data file’s new location. By displaying the 
Open Data File dialog box, 4th Dimension asks for the location of the 
data file the first time you open the structure file.
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Opening a Database
You can open a database by double-clicking the 4th Dimension applica-
tion icon and using the Welcome dialog box to open the desired struc-
ture file. 

4th Dimension will then look in the directory that contains the struc-
ture file for a data file with the same name. If 4th Dimension finds the 
data file, it will open it automatically.

If the data file is not in the same directory or is missing, 4th Dimension 
displays the Select Data File dialog box. Open the data file by double-
clicking its filename or by selecting the filename and clicking Open. 

Names of previously 
opened databases
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If you want to specify a different data file or create a new one, expand 
the Options page of the Welcome dialog box:

In the Options area, select a data file or create a new data file by click-
ing the Other... button. You can then use the Open Data File dialog 
box. The data file chosen will become the default and will open auto-
matically the next time you open the database.

Note For more information about this dialog box, refer to the 4th Dimension 
Design Reference manual. 

Opening a 
Different Data File

You can prevent 4th Dimension from opening the default data file 
automatically.

❿❿❿❿ To open a different data file:

1 Hold down the Alt key (Option key on Macintosh) while opening any 
structure file.
OR
In the Welcome dialog box, expand the Options area, then click the 
Other... button.
4th Dimension displays the Open Data File dialog box.

Expand button

Options area
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2 Double-click the desired data file name or select the data file and click 
Open.

Opening a New 
Data File

You can also create a new data file by preventing 4th Dimension from 
opening the default data file automatically. 

❿❿❿❿ To create a new data file:

1 Hold down the Alt key (Option key on Macintosh) while opening any 
database and click the New... button.
OR
In the Welcome dialog box, expand the Options area, then click the 
Other... button.

2 In the Open Data File dialog box, click the New... button. 
4th Dimension displays a create-file dialog box.

In the File Name text area, 4th Dimension automatically enters a name 
for the new data file based on the name of the current structure file. 

3 If you wish to enter a new name for the data file, type the name in the 
File Name area then click Save. 
The names of any other data files in the directory are displayed. If you 
enter the name of an existing data file, 4th Dimension displays a 
message asking you if you want to replace the existing data file with 
the new data file.
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4th Dimension will “remember” where the data file is from then on 
(4th Dimension stores the pathname of the data file). The Open Data 
File dialog box will not be displayed again unless you call it intention-
ally (as described above), move the data file to a new location, or 
change its name. 

Segmenting Data Files
If you are creating a data file that may become very large, you may 
need to segment the data file. You need to segment a data file if

■ The data file will not fit on your hard disk,

■ The data file will become larger than 2 gigabytes.

Using data file segmentation, you can store a single data file on two or 
more volumes. Each segment can grow to a maximum of 2 gigabytes. 
The maximum size of a 4th Dimension data file is 128 gigabytes. You 
do not need to segment a data file when you first create it. You can 
wait until it becomes too large to manage on your hard disk.

For complete information on segmenting data files, see Appendix A of 
the 4th Dimension Design Reference manual.
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3 Data Entry

This chapter covers the basic skills required to manage information 
using input and output forms. These skills are used whenever you work 
with data — entering new records, modifying existing records, or 
working with a list of records.

Input and Output Forms
Input and output forms provide access to the information in your 
database. You use forms to enter, view, modify, and print information. 

Input forms display one record at a time. The have enterable areas for 
fields and buttons for working with records. For details, see the section 
“Using Input Forms” on page 52. Here is an input form that was 
created using a standard form template.
474th Dimension User Reference



Chapter 3  Data Entry
Output forms display several records as a list. Each row is a record and 
each column is a field. Typically, only a few fields appear in the output 
form. Output forms are described in detail in the section “Using 
Output Forms” on page 49. Here is an output form that was created 
using a standard form template.

You use an output form to do the following:

■ Scroll a list of records

■ Highlight a subset of records

■ Double-click a record to display it in the input form

■ Enter or modify records in the list using the Enter in List mode (in the 
User environment only)

The Enter in List mode changes the way in which you use an output 
form by enabling you to modify records directly in the output form 
instead of having to use an input form. When you are in the Enter in 
List mode, fields in the output form become enterable. 

Input forms display one record at a time. You can enter and modify 
information, move from one field in the form to another, and move 
from one record to another. 
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An input form usually has buttons that you use to:

■ Save a new record to disk or save modifications to an existing record

■ Cancel changes to a record

■ Navigate from one record to another

■ Delete a record.

Using Output Forms
An output form lists records. Although any form can be used as an 
output form, most output forms have these features:

■ Each row is a record

■ Each column is a field or a variable

■ Each column is labeled at the top of the window

The following is a typical output form.

Output Form Modes An output form can be used in either of two modes: 

■ Regular mode, in which you can scroll, highlight, and double-click 
records. Fields on the output form are not enterable in this mode. 

■ Enter in List mode, in which the fields on the output form are 
enterable. You can add new records or modify existing records directly 
in the output form. 

Table name

Number of records 
in current selection

Number of 
records in table

Scroll bars
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Working with 
Output Forms

There are four basic ways to work with output forms:

■ Scrolling to locate records

■ Highlighting to select records

■ Double-clicking to view a record

■ Entering and modifying data in fields.

Scrolling An output form has standard horizontal and vertical scroll bars. You 
can scroll records by clicking either of the scroll arrows, clicking the 
scroll bar, or dragging the scroll box. If the output form has more fields 
than can be displayed in the window, you can scroll horizontally using 
the scroll bar at the bottom of the window.

Highlighting You highlight (select) a record by clicking it. You can highlight one 
record, two or more adjacent records, or two or more non-adjacent 
records. After highlighting records, you can perform operations such as 
displaying them as a subset or deleting them.

❿❿❿❿ To highlight a record:

■ Click a record displayed in the output form.
The record you clicked is highlighted.

❿❿❿❿ To highlight several adjacent records:

1 Click the first record you want to highlight.

2 Hold down the Shift key and click the last record you want 
to highlight. 
All records between the first and last ones you clicked are highlighted.

❿❿❿❿ To highlight several non-adjacent records:

1 Click the first record you want to highlight.

2 Hold down the Ctrl key (Windows) or Command key (Macintosh) and 
click another record.

3 Continue clicking records while holding down the Ctrl key (Windows) 
or Command key (Macintosh).
Each record you click is highlighted.
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❿❿❿❿ To highlight the entire current selection of records in the output form:

■ Choose Select All from the Edit menu.
All records displayed in the output form are highlighted. To highlight 
all records in the table, choose Show All from the Queries menu before 
choosing Select All from the Edit menu.

Double-clicking To view a record in the input form:

■ Double-click the record in the output form.
When you double-click a record, the input form replaces the output 
form in the frontmost window. The selected record is displayed in the 
input form, ready for modification.

Adding and Modifying 
Records

You can add and modify records in an output form using Enter in List 
mode. Enter in List mode is especially useful for modifying a few adja-
cent records because several records are displayed on the screen simul-
taneously. 

You can only enter or modify fields in the current table. You cannot 
enter or modify data in variables, fields from other tables, or subforms.

When you are in Enter in List mode, you can:

■ Add a new record, using the Enter key on the Windows numeric 
keypad or the New Record menu command

■ Move from field to field, using the Tab or Enter keys on the 
alphanumeric keyboard (Return key on Macintosh)

■ Select and edit fields

The following illustration shows an output form in Enter in List mode.

A selected field in 
Enter in List mode
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❿❿❿❿ To enter and modify fields using an output form:

■ Choose Enter in List from the Enter menu. 
The fields in the output form become enterable. A check mark (√) 
appears next to this menu command to indicate that you are in Enter 
in List mode. 

To leave Enter in List mode, choose Enter in List from the Enter menu 
again.

Note When using the Enter in List mode, you cannot click to highlight a 
record or double-click to open the input form.

Saving Changes Tabbing out of a field or clicking on another field saves your changes.

Using Input Forms
The input form is the primary tool for entering and modifying data. 
Most input forms have the following elements to manage information:

■ Enterable Areas  Input forms have enterable areas (fields or variables) 
in which data can be entered. You use enterable areas to enter values 
into the database.

■ Accept Button  A button for accepting the record. You use the Accept 
button to save a new record or to save changes to an existing record. 
When you accept a record, you request 4th Dimension to add the new 
record (or your changes to an existing record) to the database.

■ Cancel Button  A button for canceling the record. You use the Cancel 
button to discard changes you make to an existing record or to discard 
a new record. If you press the Cancel button while entering a new 
record, 4th Dimension does not add the record to the database. If you 
press the Cancel button while modifying an existing record, 
4th Dimension ignores any changes you have made. The record you 
were modifying is not affected by your changes. 

■ Navigation Buttons  Buttons to navigate from one record to another 
(e.g., First Record, Last Record, Next Record, Previous Record) and 
buttons for moving from one page to another (e.g., First Page, Last 
Page, Next Page, Previous Page) within the same record.

When you press a record navigation button, 4th Dimension accepts the 
record you were adding or modifying before displaying a new record.
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■ Delete Button  A button for deleting the record. You use the Delete 
button to permanently delete a record from the database. 

4th Dimension ships with a wide variety of button styles. When an 
input form is created, the database designer can choose among these 
button designs or use other designs. If the database uses any of the 
standard button styles, you can move the pointer over any button to 
view a Tip, as shown in the following illustration.

If your input form has no buttons, 4th Dimension adds a default 
control panel when the form is used for data entry. The default control 
panel is shown in the following illustration.

Enterable Areas and 
the Data Entry 
Order

You enter data into enterable areas. An enterable area can be either a 
field or a variable.

When entering or modifying data, you move from one enterable area 
to another in a consistent order. This order is called the data entry order. 
Every enterable area into which you can type a value is included in 
the data entry order. Boolean fields (shown as radio buttons or check 
boxes), subforms, combo boxes, and areas that accept pictures are also 
included in the data entry order.

Thermometers, rulers, and dials can also be used to enter data. These 
objects, however, are not included in the data entry order. You select 
them by clicking on them. 

Record navigation 
controls

Page navigation 
controls

Accept button

Cancel button

Delete button
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The data entry order can be changed in the Design environment’s 
Form editor. The data entry order for a particular form may not 
necessarily move from left to right or top to bottom. A form with a 
custom data entry order is shown below.

Refer to the 4th Dimension Design Reference manual for information 
about changing the data entry order.

❿❿❿❿ To move forward in the data entry order:

■ Press the Tab key or the Enter key on the alphanumeric keyboard.

Note In a Text field, pressing the Enter key on the alphanumeric keyboard 
(Return key on Macintosh) ends the paragraph you are writing and 
moves the insertion point to the next line in the field. In this case, use 
the Tab key to move forward in the data entry order.

❿❿❿❿ To move backward in the data entry order:

■ Hold down the Shift key and press Tab.

❿❿❿❿ To select any enterable area:

■ Click in the area or tab into it using either Tab or Shift+Tab. 
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Accept Button When you are satisfied with your entry, you can accept the record. 
When you accept a record, you tell 4th Dimension to add the record 
to the database.

❿❿❿❿ To accept a record:

■ Click the Accept button. 
OR
Press the Enter key on the numeric keypad.
4th Dimension adds the record to the database.

Depending on the design of the input form, the Accept button may be 
represented in different ways. 

In multi-page forms, the fields on all the pages are part of the same 
record. In a multi-page form, clicking the Accept button on any page 
saves the entire record. Similarly, pressing the Enter key on the 
numeric keyboard while on any page saves the entire record.

Note 4th Dimension updates the data file stored on your hard disk at regular 
intervals. You can specify this interval using the Preferences dialog box 
in the Design environment. See the 4th Dimension Design Reference 
manual for more information about setting Preferences.

Cancel Button If you decide you don’t want to add a record to the database or save 
modifications to an existing record, you can cancel the entry. When 
you cancel an entry, the data you entered is not saved. If you were 
modifying an existing record when you canceled, 4th Dimension 
ignores the modifications. No changes are made to the record stored 
on disk.

❿❿❿❿ To cancel a record:

■ Click the Cancel button. 
OR
Press Ctrl+Period (Windows) or Command+period (Macintosh)
4th Dimension discards any data you have entered or modified for that 
record and displays the output form. 
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Record Navigation 
Buttons

A form often contains buttons or icons for moving from one record to 
another. 4th Dimension automatically disables navigation buttons 
when appropriate. 

The four navigation buttons are:

■ First Record

■ Last Record

■ Previous Record

■ Next Record

Clicking any of these buttons accepts the current record and then 
moves to another record.

The following illustration shows record navigation buttons from one 
button style that is shipped with 4th Dimension.

4D Server If a record to which you are attempting to move is being used by 
another user, 4D Client displays a message stating that the record is 
locked and you will be unable to modify the record. The record 
remains locked while the other user is working with it. You will only be 
able to enter the view the locked record until the other user frees the 
record by clicking the Cancel or Accept button or by using the 
navigation buttons or icons to move to another record.

First Record

Previous Record

Last Record

Next Record
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Page Navigation 
Buttons

An input form can consist of more than one page. Multi-page forms 
must provide some way for the user to move from one page to another. 
The database designer may use page navigation buttons. The four page 
navigation buttons are: 

■ First Page

■ Previous Page

■ Next Page

■ Last Page

Clicking a page navigation button displays another page in the form 
but does not accept or cancel the record. 

Some forms contain the page navigation buttons shown below. You 
use these buttons to move to the previous or next page of the form.

Note Page navigation buttons are not added to all input forms automati-
cally. Your database may use other page navigation controls or not use 
multi-page input forms.

The Delete Button An input form may have a Delete button. It is used to delete the record 
being displayed. Deleting a record cannot be undone. Before deleting 
the record, 4th Dimension displays a dialog box in which you can 
confirm or cancel the deletion. 

To delete the record, click the OK button.

Previous Page

Next Page
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Editing Data While you are entering or modifying data, you can edit the values you 
enter before accepting the record. Highlight the value you want to edit 
and use standard text editing techniques. You can use the Cut, Copy 
and Paste commands in the Edit menu to modify any entry. You can 
select text by double-clicking or dragging the insertion point over it.

If you make a typing error, you can press the Backspace key (Delete key 
on Macintosh keyboards) to backspace over the incorrect characters. 
You can also choose Undo from the Edit menu to undo your last 
action.

For more information about data entry, see the section “Entering and 
Modifying Different Types of Data” on page 58.

Interrupting Data 
Entry 

When you use an input or output form, you can choose any menu 
command that is not dimmed. For example, you can do a query, print 
a quick report or a set of labels, or graph data. 

If you choose a menu command while you are in the process of 
entering or modifying a record, 4th Dimension displays an alert box 
asking you whether you want to accept the record, discard the record, 
or cancel the menu selection and return to the record being entered.

Entering and Modifying Different Types of Data
Each field in a form has a field type that dictates the kind of data you 
can enter. Most fields are numeric or alphanumeric. You enter data in 
these fields simply by typing. Other types of fields accept data only in 
particular formats. 

Alpha, Numeric, Date and Time fields can have display formats 
associated with them. When you tab out of a field with a display 
format, 4th Dimension applies the format to the data you entered. For 
example, a salary field could have a format that displays a dollar sign 
($) and two decimal places. If you entered 100.500, tabbing out of the 
field would produce $100.50. 
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For more information about the available formats for each data type, 
refer to the 4th Dimension Design Reference manual.

Note The database designer can also use triggers, object methods, and form 
methods to process data as it is entered. These tools may be used to 
validate data, update the contents of other tables, or compute values of 
variables whenever data is saved or modified. The database designer 
may also use methods or triggers to provide customized feedback to 
the user. For more information about triggers, object methods, and 
form methods, see the 4th Dimension Design Reference manual.

Alpha Fields An Alpha field can contain alphanumeric characters (letters and num-
bers), punctuation marks, and special characters such as *, %, and {. 
The maximum length of an Alpha field is set in the Design environ-
ment. If you type more characters than the maximum allowed, the 
extra characters are truncated.

An entry filter can be associated with an Alpha field. An entry filter 
validates the entries that you type on a character-by-character basis. 
See the section “Fields with an Entry Filter” on page 70 for more 
information.

Numeric Fields 4th Dimension supports three types of numeric fields: 

■ Real  This type of field stores real numbers to ±1.7e±308 (15 digits).

■ Integer  This type of field stores integers from -32768 to 32767.

■ Long Integer  This type of field stores integers from -231 to 231 -1.

If you enter a decimal point and numbers to the right of the decimal in 
an Integer or Long Integer field, the number will be truncated. 

Numeric fields do not store formatting characters such as the dollar 
sign or the comma. If you enter a formatting character, it is ignored. To 
format a numeric field, assign a display format to the field in the 
Design environment.
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The only non-numeric characters which are significant when entered 
in a number field are the following:

Note In the United States, the decimal point (.) is used as the decimal 
separator in real numbers. Other countries use a different character 
such as the comma (,) as the decimal separator. When entering 
numbers in an international version of 4th Dimension, you should use 
the character specified by your operating system.

Text Fields A Text field functions like a text processor. It can hold up to 32,000 
characters. Text fields are used for entering long blocks of text such as 
notes or comments. A Text field can have a vertical scroll bar.

A Text field provides basic text editing features: scrolling, word wrap-
ping within the field, and double-clicking to select words. It also sup-
ports use of the arrow keys and the standard cut, copy, and paste 
operations. Using the Enter key on the keyboard (or Return on Macin-
tosh), you can type a Carriage return into a Text field to form para-
graphs. If you press the Enter key (Return on Macintosh), the insertion 
point moves to the next line. You cannot insert Carriage returns in an 
Alpha field.

You cannot use tabs in a Text field. If you press the Tab key while in a 
Text field, the insertion point moves to the next enterable area in the 
data entry order.

4th Dimension lets you paste text into a text field. For example, you 
can paste the contents of a letter written in a word processor into a 
Text field. 

As an alternative, you can install the 4D Write word processing plug-in 
in the database. 4D Write supports multiple fonts, font sizes, styles, 
text alignment, and integrated mail-merge. For more information 
about using 4D Write, refer to the documentation that comes with the 
4D Write plug-in.

Character Purpose Example
Decimal point (.) Used as the decimal separator 54.3321
“e” or “E” Used in scientific notation 1.1e5
Hyphen (-) Used for negative numbers -2090
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Date Fields A Date field accepts any date entered in the format specified by your 
operating system — for example month/day/year format 
(MM/DD/YYYY). 4th Dimension stores dates between the year 100 A.D. 
and the year 32,767. You can enter the year using either two or four 
digits. If you use two digits for the year:

■ 4th Dimension assumes the date is in the 20th century and adds “19” 
before the digits if the value is greater than or equal to 30. For 
example, for 01/25/97, 4D interprets the date as “January 25, 1997”. 
For 01/25/30, the date is interpreted as “January 25, 1930”.

■ 4th Dimension assumes the date is in the 21st century and adds “20” if 
the value is less than 30. For example, 4D interprets the date 01/25/07 
as “January 25, 2007”. The date 01/25/29 is interpreted as “January 25, 
2029”.

Note The default century can be changed programmatically using the 
command SET DEFAULT CENTURY.

The month, day, and year can be separated by any character except 
a number. Some example date entries are shown below. The results are 
shown in the format MM/DD/YYYY.

Note The United States specifies dates in the month/day/year 
(MM/DD/YYYY) format. Other countries use different formats, such as 
DD/MM/YYYY for British systems and YY/MM/DD for Swedish systems. 
When entering dates in 4th Dimension, you should use the format 
specified by your operating system.

Time Fields A time can be entered in 12- or 24-hour format. The time is stored in 
hours/minutes/seconds format (HH:MM:SS). The entries can be 
separated by any character except a number. 

During data entry, 4th Dimension will attempt to interpret partial 
entries. For example, the entry “1 p” is interpreted as 1:00 PM or 
13:00:00. The “p” tells 4th Dimension to add 12 hours to the value you 
enter. The entry “6 a” is interpreted as 6:00 AM or 6:00:00. 

Entry Result
6:23:95 6/23/1995
6/23/95 6/23/1995
6 23 1995 6/23/1995
6/23/1995 6/23/1995
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If you enter “36 3 7”, 4th Dimension interprets the entry as 
“36 hours 3 minutes 7 seconds.”

Some example time entries are as follows:

Boolean Fields A Boolean field takes on one of two values, TRUE or FALSE. A Boolean 
field is displayed as either a check box or a pair of radio buttons. 
Boolean fields can be in the data entry order. When a Boolean field is 
selected, it is outlined by a marquee (a border that surrounds the 
field)1. In the following illustration, the check box is outlined by a 
marquee.

4th Dimension interprets a check box that has been selected (checked) 
as a yes (TRUE) value and an empty box as a no (FALSE) value. If a 
Boolean field is displayed as a pair of radio buttons, the value of the 
Boolean field is TRUE if the first radio button is selected. If the second 
radio button is selected, the value of the field is FALSE.

❿❿❿❿ To enter a value for a Boolean field displayed as a check box:

■ Click the check box to enter the value of TRUE for the field. 
If there is a marquee surrounding the check box, you can press the 
Space bar to toggle between checked and unchecked or type “Y”.

Entry Result
11 a 11:00:00
3 p 15:00:00
3h 11m 3:11:00
23:43 23:43:00
6:00:05 6:00:05
23 8 6 23:08:06

1. The marquee appears if only the field is given the Focusable property in 
the Form editor. Otherwise, it does not change its appearance when selected. 
You can click an enterable check box or radio button even if the field does 
not have the Focusable property.

Marquee Field shows focus when selected

Field is selected but cannot show focus
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❿❿❿❿ To enter a value for a Boolean field displayed as a pair of radio buttons:

■ Click on either radio button. 
If there is a marquee surrounding the radio button, you can press the 
Space bar to toggle between the two radio buttons or use the keyboard 
equivalents. 

The first letters of the labels for the radio buttons can be used as key-
board equivalents. For example, if the radio buttons are labeled “Male” 
and “Female,” you can use the “M” and “F” keys. Also, the “Y” and “N” 
keys can be used to enter values. Typing “Y” is equivalent to clicking 
the first radio button; typing “N” is equivalent to clicking the second 
radio button.

Picture Fields A Picture field accepts bitmapped or object-oriented graphics.

❿❿❿❿ To enter a picture into a Picture field:

1 Copy the picture to the Clipboard. 

2 Select the Picture field into which you want to paste the graphic. 
Select the field either by clicking or by using the Tab key. A selected 
Picture field is inverted. 

3 Choose Paste from the Edit menu.
Graphics stored in a Picture field appear in one of the following display 
formats specified by the database designer:

■ Truncated (Centered and Non-centered)  The boundaries of the 
Picture field act like a “cookie cutter” on the graphic that you paste 
into the field. If the format of the field is Truncated (Centered), the 
picture is centered in the field and any portions that do not fit in 
the field are cropped. If the format of the field is Truncated (Non-
centered), the upper-left corner of the picture is placed in the upper-
left corner of the field and any portions that do not fit in the field 
are cropped.

4th Dimension saves the entire picture, even if only a portion is 
shown on the input form. 

Truncated
(Centered)

Truncated
(Non-centered)
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If you print the form, only a portion of the picture will be printed 
unless the Print with Variable Frame check box has been selected for 
the Picture field. For more information about printing with variable 
frame, refer to the 4th Dimension Design Reference manual.

■ Scaled to Fit  In this display format, 4th Dimension resizes the 
graphic to fit the dimensions of the field area. Because 
4th Dimension may compress or elongate the graphic to fit the 
dimensions of the Picture field, the picture may appear distorted in 
the form.

■ Scaled to Fit (proportional and proportional centered)  In this dis-
play format, the picture pasted into the form is reduced proportion-
ally on all sides to fit the area created for the picture. If the picture is 
smaller than the area defined in the form, the picture will not be 
modified. If you use Scaled to Fit Centered (Proportional) the image 
will be centered rather than occupying the top-left area. If the pic-
ture is bigger than the area defined in the form, the picture is pro-
portionally reduced, and will not appear distorted.

Scaled to fit centered (proportional)Scaled to fit (proportional)
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■ On Background  In this display format, the graphic pasted into 
the form is transparent — any object behind the pasted graphic is 
visible through the graphic. When a picture is displayed in this for-
mat, you can move the pasted picture around the inside of the pic-
ture field by dragging it. 4th Dimension remembers the position of 
the picture after you save the record.

You can change the contrast between the picture and the background.

❿❿❿❿ To change the contrast of a background picture:

1 Double-click the field.
The Choice of Mode palette appears.

2 Select one of the contrasts from the palette.
4th Dimension applies the new contrast to the picture.

The following illustration shows the effect of each Choice of Mode 
selection. The examples are arranged in the same position as the but-
tons in the Choice of Mode palette. Each illustration shows how the 
picture field appears when it is not selected for data entry.

On Background 
graphic
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A variable that displays the name of the graphic is placed on top of the 
On Background picture. 

You can produce additional combinations by setting the foreground, 
background, and fill properties of the objects placed on top of or 
behind the On Background picture field.

QuickTime 
Compression 

Once you have placed a picture in a picture field, you may compress 
the field if Apple QuickTime® (version 4 minimum) is already installed 
on your machine. This option allows you to reduce the space used by 
images on your hard disk. 

In Design mode you can apply a “standard” compression to all images: 
simply check the Compression attribute for the picture field in the 
Design window of the database (for more information, refer to the 
4th Dimension Design Reference manual).

Additionally, you can apply specific compression settings to each 
image pasted within the Picture field, or just compress certain images.

❿❿❿❿ To apply specific compression settings to an image pasted in a picture 
field:

1 Copy the image to the Clipboard.

2 Press the Alt key (Windows) or Option key (MacOS) and select the 
Paste command in the Edit menu.
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The QuickTime Compression Settings dialog box appears.

3 Select your settings and click OK.
The image will be saved using the settings you just selected regardless 
of the initial attributes of the picture field.

For more information on QuickTime compression, refer to the 
4th Dimension Design Reference manual.

Entering Data in Fields with Data Entry Controls
The database designer may have used certain standard data entry 
controls that restrict the values that can be entered into fields. The 
following standard data entry controls may be used:

■ Mandatory attribute,

■ Unique attribute,

■ Range of acceptable values,

■ Entry filters,

■ Choice lists.
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These constraints affect the way in which 4th Dimension processes 
data and provide feedback to users. This section discusses how stan-
dard data entry controls affect data entry.

Note In addition, the database designer may enforce business rules program-
matically. In this case, the nature of the data entry constraint and the 
type of feedback provided to the user is under the control of the data-
base designer. For example, he or she can build in the same types of 
constraints but provide more specific user feedback or build highly cus-
tomized constraints. See your system administrator for information on 
custom data entry constraints.

Mandatory Fields Mandatory fields contain data that is essential to the database such as a 
field that uniquely identifies each record in a table. Any field type can 
be given the Mandatory attribute. 

If a field is mandatory, you must enter a value for that field before 
the record can be accepted. If you do not enter a value into a manda-
tory field, 4th Dimension displays an alert box when you try to accept 
the record.

After you put away the alert box, you can enter a value into the manda-
tory field and accept the record. 4th Dimension will not let you accept 
the record until you have entered a value into the mandatory field.
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Unique Fields A field with the Unique attribute accepts only entries that uniquely 
identify each record in the table. For example, the Unique attribute is 
usually assigned to the primary key field of a table such as a Social 
Security number or invoice number field.

When you enter a value into a unique field and press the Tab key, 
4th Dimension determines whether or not the entry is unique. If you 
enter a value that already exists, 4th Dimension displays an alert box 
that informs you that the key value has already been entered. 

You can then enter a new value.

Note You cannot enter more than one record with a null value in a unique 
field.

Fields with a 
Validation Range

A validation range specifies the minimum and maximum values that 
may be entered in an area. If you enter a value above the maximum 
value or below the minimum value, 4th Dimension displays an alert 
box when you press the Tab key. The alert box will tell you the 
minimum or maximum value you have exceeded.
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Fields with an Entry 
Filter

An entry filter is a data validation tool. It examines each character as it 
is typed. As you type, 4th Dimension compares each character you 
enter to the set of characters specified by the entry filter. If you type an 
invalid character, 4th Dimension rejects the character and does not 
display it on the screen. Invalid characters are disregarded and valid 
characters are displayed normally.

When a field with an entry filter is selected for data entry, the display 
format appears. In the following illustration, a telephone number field 
uses an entry filter and display format. The display format specifies 
parentheses surrounding the area code, a space after the closing paren-
thesis, and a dash between the third and fourth characters. The entry 
filter itself accepts only numeric characters.

When the field is selected, the first enterable position is highlighted. 
Notice that the parenthesis is for display only; it cannot be selected or 
edited.

As you type numbers, 4th Dimension accepts your entries. If you type 
an alphabetic character, the character is filtered out. As you type each 
number, the next enterable position is highlighted.

If you want to delete a character, press Backspace (Delete on Macin-
tosh). An entry filter can also specify the maximum number of charac-
ters that can be entered in a particular field. When you enter the last 
character, the insertion point automatically moves to the next enter-
able area. You do not need to press the Tab key to move to the next 
field in the data entry order. For instance, entering a state abbreviation 
such as “CA” in a two-letter State field automatically moves the text 
insertion point to the next field in which you can enter data.

The cut, copy, and paste functions do not work normally if an entry 
filter is associated with an enterable area. You cannot cut or copy more 
than one character and you cannot paste into a field with an entry 
filter.
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Fields with a Choice 
List

Moving the insertion point into a field with a choice list displays a list 
from which you can choose a value. The list is displayed in the 
Choice List window. An example Choice List window is shown below.

A choice list is often used to limit entries to specific values and prevent 
misspellings. For example, a Payment Type field in an Invoices database 
can be associated with a list of all the procedures used for payment. 

A list can also be used to exclude values from a field or require that only 
certain values be entered. Excluded lists contain values that are not 
acceptable. If you type a value that appears on an excluded list, an alert 
box will be displayed indicating that the value you typed is not allowed. 

❿❿❿❿ To enter data using a choice list:

1 Select the field for data entry by pressing Tab or clicking in the field.
The choice list for the field appears.

2 Double-click the desired item to select and enter the item.
OR
Click the value you want to enter.
OR
If the list is sorted, type an entry.
OR
Use the Up and Down Arrow keys to highlight values on the list.
If you type an entry, the list scrolls to match the value you type. 

3 Press Enter on the alphanumeric keyboard (Return on Macintosh) to 
select a highlighted value. 
To cancel the entry, click Cancel or press the Tab or Esc key.
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Modifying Choice 
Lists

A choice list can be designated as modifiable. In this case, the Modify 
button in the Choice List window is enabled. If a list is modifiable, you 
can do the following: 

■ Add items to the list

■ Modify items on the list

■ Delete items

■ Sort the list alphabetically

❿❿❿❿ To modify a choice list:

1 Click the Modify button in the Choice List window. 
The Items in List dialog box appears.

The dialog box lists the items on the list. The buttons on the right side 
of the dialog box are used to modify the list.

Adding Items If the value you wish to enter is not on the list, you can add the item to 
the list. You should do so if the item will be used again.

❿❿❿❿ To add items to the end of the list: 

1 Click the Append button.

4th Dimension adds an empty area below the last entry in the list and 
places the insertion point in it.

2 Type an item and press Tab or click outside the entry area to save your 
changes. 
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Inserting Items If you insert an item rather than appending it, you can place it above a 
selected element.

❿❿❿❿ To insert an item in the list:

1 Click an item on the list.

2 Click the Insert button.
4th Dimension creates an entry area above the item you clicked on and 
places the insertion point in the entry area.

3 Type an item and press Tab or click outside the entry area to save your 
changes. 

Modifying Items You can also edit any item.

❿❿❿❿ To modify an item:

1 Ctrl+click (Command-click on Macintosh) the item you want to modify.
The item becomes editable.

2 Edit the item as needed.

3 Press Tab or click outside the entry area to save your changes.

Deleting Items You can delete an item that is not appropriate for data entry.

❿❿❿❿ To delete an item:

1 Click the item in the list and click the Delete button.
4th Dimension deletes the item from the list and removes the space it 
occupied.

Sorting the List You can sort the list to facilitate data entry.

❿❿❿❿ To sort the list:

1 Click the Order By button.
4th Dimension sorts the list alphabetically. Sorting the list allows you 
to select an item by typing.

Click OK to save the modified list, close the dialog box, and enter the 
selected item in the field. Or, click Cancel to discard any changes you 
made and close the dialog box.
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Entering Data in Subforms
Some of your forms may contain subforms — forms from other tables 
or subtables that are nested within the current form. The current form 
in this context is sometimes called the parent form. 

Subforms provide a way for you to add data to a subtable or to a related 
table without switching tables or forms. You can enter data into an 
subform in either of two ways:

■ List form  You can enter multiple records directly in the subform area 
on the parent form. An subform that supports entry is called enterable.

■ Detail form  You can also enter data using a Detail form belonging to 
the related table or subtable. A subform that supports this entry 
method is called double-clickable.

A subform can be both enterable and double-clickable. If a subform is 
both enterable and double-clickable, you can enter data directly in the 
subform or through an input form belonging to the related table or 
subtable. 

Note A subform can also be selectable. If a subform is selectable, it cannot be 
enterable. You can select records in a selectable subform, but you 
cannot add or modify records in the List form.

❿❿❿❿ To enter data using the subform: 

1 Select the subform area by clicking it or by tabbing into it. 
When an subform is selected, a flashing triangle points to it.

2 Click the Add to Subform button (if it is included on the form) or press 
Ctrl+/. On Macintosh, press Command+/. 
74 4th Dimension User Reference



Entering Data in Subforms
4th Dimension creates a new record or subrecord and selects the first 
empty field in the subform.

Ctrl+/ (Command+/ on Macintosh) is the default keyboard command 
for creating a record in a subform. If you wish, you can use 
4D Customizer Plus to change the keyboard command. 

3 Enter data in the subform. 
Use the Tab key to move through the data entry order within the 
subform. 

The new record in the subform is saved when you tab out of the 
subform or click another enterable area in the parent form. If the 
subform belongs to a subtable, the new subrecord is not saved until 
you accept the parent record.

4 If you want to create another record, press Ctrl+/ (Command+/ on 
Macintosh) again.

5 Click any field in the parent record to return to the parent form.

If the subform has a Detail form associated with it, you can enter data 
directly into the input form of the related table or subtable. 

Add to subform 
button
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❿❿❿❿ To enter a new record using a Detail form: 

1 Double-click anywhere in the subform area below the last record 
displayed in the subform. 
4th Dimension displays the input form for the subtable or related table. 
If the subform is not double-clickable, double-clicking does nothing.

Note You can also use a button in the parent form to display the detail form. 
For more information, see the description of the Open Subform button 
action in the 4th Dimension Design Reference manual.

2 Enter data in the Detail form as you would in any other input form. 

3 Press Enter on the numeric keypad or click the Accept button to add 
the new record to the database and return to the parent form. 

❿❿❿❿ To modify a record using a Detail form:

1 Double-click the record you want to modify.
4th Dimension displays the record using the Detail form. 

If the subform does not have a Detail form associated with it, double-
clicking does nothing.

2 Modify the record.

3 Press Enter on the numeric keypad or click the Accept button to save 
your modifications and return to the parent form.

Choosing Tables and Forms
In the User environment, you can switch between tables whenever you 
need to work with data in another table. For example, while entering 
data into a company table, you may need to look up a home telephone 
number stored in an employee table. 

Each table can have many forms attached to it. You can create different 
forms to meet specific needs. For example, different report forms can 
be used for different types of reports and different forms can be used 
for different monitor sizes. In the User environment, you can switch 
between tables and forms at any time.

Each table has a current input form and a current output form. You 
specify a default input form and a default output form in the Design 
environment for each table in the database. These forms are used 
unless you specify different forms in the User environment. 
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There are two ways of choosing tables and forms:

■ Using the Choose Table/Form menu item in the File menu

■ Using the List of Tables window.

These two methods can be used interchangeably. They carry out 
exactly the same functions. An advantage of Choose Table/Form is 
that it displays a thumbnail picture of the form. The List of Tables win-
dow is more convenient for switching tables or for switching forms 
when you do not need to view a thumbnail.

You can choose a new table or a new form while you are using either 
an input or an output form. Your choices are implemented immediately. 

Note The changes you make are temporary. The permanent selections are 
made using the Explorer in the Design environment.

Using the Choose 
Table/Form Dialog 
Box

You can use the Choose Table/Form dialog box in two ways:

■ You can switch to another table and use the current input and out-
put forms for that table.

■ You can select new input or output forms, for the current table or 
another table.

❿❿❿❿ To choose a table using the Choose Table/Form dialog box:

1 Choose Choose Table/Form from the File menu.
The Choose Table/Form dialog box appears, listing the names of the 
tables and forms in the database as a hierarchical list. 

2 Select a table and click Choose.
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4th Dimension displays the current selection of the new table in the 
current output form for that table.

❿❿❿❿ To select new input or output forms:

1 Choose Choose Table/Form from the File menu.
The Choose Table/Form dialog box appears, listing the names of the 
tables and forms in the database as a hierarchical list. 

2 Click the plus sign (on Windows) or arrow (on Macintosh) to expand 
the desired table.
4th Dimension displays the forms belonging to that table. The current 
input and output forms are indicated by the “I” and “O” on the right 
of the hierarchical list of tables.

3 Highlight a form that you want to designate as the input or output 
form.
A preview of the form appears in the preview area on the right.

4 Click the Input Form or Output Form check box below the preview area 
to designate the selected form as the current input or output form.
An “I” or “O” appears to the right of the highlighted form name1.

1. If you click both Input and Output, the letter B appears, indicating that 
the form will be used for both purposes.
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5 Click the Choose button to change the current table and input or 
output forms. 
Your changes remain in effect until you change them again.

To cancel your changes and return to the form you were using previ-
ously, click the Done button.

Using the List of 
Tables Window

You can perform the same operations with the List of Tables window.

❿❿❿❿ To choose a table using the List of Tables window:

1 If the List of Tables window is not visible, hold down the Ctrl key 
(Windows) or Command key (Macintosh) and press the Space bar to 
bring it to the foreground.
The List of Tables window moves to the front. 

If necessary, use the scroll bar or the size box to view the names of 
additional tables.

Each table name in the List of Tables window is accompanied by two 
icons that represent input and output forms. The left icon represents 
input forms. The right icon represents output forms.

2 Click the name of the table in the List of Tables window.
4th Dimension displays the current selection for that table using 
the output form. 
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❿❿❿❿ To change forms:

1 Click either the input or output icons next to a table name in the 
List of Tables window and hold down the mouse button.
A pop-up menu appears, listing the names of input or output forms 
belonging to that table. 

An underline in the pop-up menu indicates the current input or 
output form. 

2 Select the name of the form you want to specify as the current input 
or output form.

❿❿❿❿ To hide the List of Tables window:

1 Press Ctrl+Space bar (Windows) or Command+Space bar (Macintosh).
The List of Tables window moves to the back.
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4 Selecting Records

You select records in your database to access information that you 
want to use. For example, you might search a database of contacts to 
look up the telephone number of a person you need to call or to select 
the people to whom you want to send product information.

In 4th Dimension, the group of records you have selected is called the 
current selection. The current selection can be any subset of records in a 
table — from no records up to all the records. For more information 
about the concept of the current selection, see the section “The Cur-
rent Selection” on page 20.

You can change the current selection by:

■ Selecting all records

■ Selecting a subset of records

■ Searching for records

The current selection is the group of records on which operations are 
performed. For example, you can:

■ Sort the current selection

■ Perform a global update of records in the current selection

■ Print the records using a form or a quick report

■ Print labels

■ Graph data

■ Modify or delete records

■ Export records

In other words, creating a current selection in a table is the first step in 
many other data management operations. 
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The title bar of the output form tells you how many records are in the 
current table and how many records from the table are in the current 
selection.

4D Server With 4D Client, only the number of records in the current selection is 
displayed.

Every table in a database has its own current selection. In a relational 
database, changing the current selection in one table can change the 
current selections in related tables. For example, in a database consisting 
of related [Employees] and [Departments] tables, a opening an input 
form in the [Departments] table changes the current selection in the 
[Employees] table. That is, the employees belonging to that department 
become the new current selection in the [Employees] table. For more 
information about relations, see the 4th Dimension Design Reference man-
ual.

If you are using several processes to perform database tasks, you can 
have several current selections for a table simultaneously. Each process 
acts like a separate 4th Dimension environment, allowing you to 
perform separate tasks. 

Table name

Number of records 
in current selection

Number of 
records in table
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The ability to have more than one current selection per table can be 
very useful, especially when comparing two or more subsets of records, 
such as the monthly invoices from several sales territories. For more 
information about processes, see the section “Multi-tasking in 
4th Dimension” on page 22. For information about creating processes, 
refer to the 4th Dimension Design Reference manual.

Selecting All Records
When using an output form to display records, you can reset the 
current selection so that it contains all the records in the current table.

❿❿❿❿ To select all records:

1 Choose Show All from the Queries menu.
All the records in the current table are placed in the current selection. 

Note Show All is dimmed if you are using an input form.

Selecting a Subset of Records 
You can create a new current selection directly in the output form by 
highlighting records and defining the highlighted records as the new 
current selection. 

❿❿❿❿ To create a subset:

1 Highlight one or more records.
Instructions for highlighting a contiguous or discontiguous set of 
records is found in the section “Highlighting” on page 50.

2 Choose Show Subset from the Queries menu.
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4th Dimension displays the new current selection in the output form.

Searching the Database
Searching is one of the most common database operations. It is often 
the most convenient way to select the records with which you want to 
work.

The term searching refers to finding a group of records in the database 
based on the contents of one or more fields. You perform a search by 
specifying a query. A query is the set of instructions that tells 
4th Dimension which records to include in the new current selection, 
such as “Company Name is equal to 4D”.

A query always has three elements: field name, comparison operator, and 
value. The field name is from the current table or a related table. The 
comparison operator tells 4th Dimension how to compare the contents 
of the field to the value you specify (equal to, greater than, less than, 
and so forth). The value specifies the number, string, or other value to 
which each record is compared. 
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Suppose you want to see all the records for employees with salaries 
greater than $30,000. The query you would use is “Salary is greater 
than 30000.” “Salary” is the field, “is greater than” is the comparison 
operator, and “30000” is the value.

When you search a database, 4th Dimension compares the contents of 
the field in the query to the value you specify. The new current selec-
tion is made up of records that satisfy the rules stated in the query. The 
new current selection can be no records, one record, a group of 
records, or all the records in the table.

You can perform a query while you are using either an input or an out-
put form. If you perform a query while you are using an input form, 
the first record in the new current selection is shown in the input 
form. You can view, modify, or print the record. If the new current 
selection consists of more than one record, you can move through the 
records using the navigation buttons (Previous Record, Next Record, 
First Record, Last Record). If you modify a record before pressing a nav-
igation button, 4th Dimension will save the modifications to disk.

In relational databases, you can search on fields from other tables, 
provided that a relation between the tables has been established. For 
more information about relations, see the 4th Dimension Design 
Reference manual.

If you do the query while using an output form, the new current selec-
tion is displayed in the output form. You can reset the current selection 
to all the records in the current table by choosing Show All from the 
Queries menu.

Note If a field in the database structure is not used in the current database, 
the database designer can elect to hide the field by giving it the Invisi-
ble attribute. Only tables and fields which are visible appear in the 
Query editor. For information about making tables and fields invisible, 
refer to the 4th Dimension Design Reference manual.
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Indexed and 
Sequential Queries

4th Dimension can carry out queries very quickly if it has an ordered list of 
records to work from. An ordered list is called an index. An index is associated 
with a particular field and is stored on disk as part of the data file. 

A query that is performed without an index is slower than an indexed 
query because the program must start at the beginning of the table and 
examine each record until it finds the records that meet the criteria 
you have set. To be sure that it has found all the records you are 
looking for, it must examine every record in the table sequentially. 
This process is called a sequential search.

If an index is available, the program “knows” where the target records 
are located. If you are searching for everyone whose last name is Smith, 
the program will know where in the table the Smiths are located. Thus, 
it doesn’t need to examine every record in the table.

A good analogy for an index is a card catalog in a library. The card cat-
alog is an alphabetized list of all the books in the library. Each record 
in the catalog contains information about the book’s location. If you 
are looking for a particular book, it would be inefficient to conduct a 
sequential search of the library’s entire holdings. It is much faster to 
consult the card catalog, obtain the location of the book, and then 
search the particular shelf on which the book is stored.

When you are designing a database, you should index the fields that you 
are likely to use often for searching. As you enter or import records, 
4th Dimension automatically updates all indexes. When you do queries, 
4th Dimension automatically uses indexes if they are available.

Note 4th Dimension allows you to choose between two indexing modes, 
depending on how the index will be used. For more information, refer 
to the 4th Dimension Design Reference manual. 

Comparison 
Operators

When you write a query, you tell 4th Dimension how to compare the 
value you specify to the contents of the database. For example, the 
query, “Last Name equals ‘Smith’” uses the “is equal to” comparison 
operator. It tells 4th Dimension to compare the values in the Last Name 
field to the string “Smith.”

Comparisons involving alphanumeric values are not case-sensitive. A 
search on the last name “Smith” will find records containing “smith,” 
“SMITH,” “sMith,” and so on.
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The following comparison operators are available:

■ Is equal to - Is not equal to

■ Is greater than - Is greater than or equal to

■ Is less than - Is less than or equal to

■ Contains - Does not contain

Note Queries using the Contains and Does Not Contain operators are always 
sequential queries.

The Wildcard Character To make queries easier to specify, 4th Dimension has a wildcard 
character (@) that can replace one or more characters in a search 
involving an Alpha or Text field. For example, if you are looking for all 
occurrences of the name “Belmondo” in a field, you may specify the 
search value in several ways:

Simple and 
Compound Queries

You can search on one or more fields. A query on one field is called a 
simple query. For example, the search “Last name equals ‘Smith’” is a 
simple query. When you do a simple query, 4th Dimension examines 
the contents of one field when searching the database. 

A query on two or more fields is called a compound query. When you do 
a compound query, you combine separate queries using a conjunction 
operator. The conjunction operator tells 4th Dimension how to com-
bine the results of the individual queries. 

A search for: Finds
Bel@ All values beginning with “Bel”
@do All values ending with “do”
Bel@do1

1. In the Preferences dialog box, you can specify that 4th Dimension evalu-
ates the @ character (the “at” sign) as a literal character in searches or char-
acter string comparisons when it is found within a word (but not at the 
beginning or the end of a word). This option is particularly useful for data-
bases that store e-Mail addresses (which are usually “name@provider.com”). 
For more information, please refer to the 4th Dimension Design Reference 
manual. 

All values starting with “Bel” and ending with “do”
@elm@ All values containing “elm”
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There are three conjunction operators:

■ And  This operator finds all the records that meet two conditions 
simultaneously. For example, the query “Find all the employees who 
work in the engineering department and who make over $50,000” will 
find the records of only those engineering employees who make over 
$50,000.

■ Or  This operator finds all the records that meet either of two simple 
queries. For example, the query “Find all the employees who work in 
the engineering department or who make over $50,000” will find the 
records of all the people in the engineering department, as well as all 
the people who make over $50,000 regardless of the department in 
which they work.

■ Except  This operator is the equivalent of “not.” The query “Find all 
the engineers except those who make over $50,000” will exclude the 
engineers making more than $50,000.

The conjunction operators let you create compound queries such as 
“Find the salespeople in New York or California and who have commis-
sion rates in excess of 30 per cent and who had sales volume less than 
$20,000.” 

The figure below shows this query being specified in the Query editor.
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When this query is executed, 4th Dimension finds all the New York 
and California salespeople who may be getting high commissions for 
low volume sales. Additional examples of the uses of comparison and 
conjunction operators are given for each search method.

Using the Queries Menu Commands
4th Dimension provides several powerful methods for searching a 
database. You can use any of the search methods to create a query. 
Records that meet the condition become the new current selection.

You can choose any search method when you are using either an input 
or an output form.

The Queries menu provides four menu commands related to searching. 
Each menu command displays a different dialog box or window or 
provides different options. They differ in the types of queries they 
carry out and the way in which the current selection is displayed.

The four menu commands represent four different search methods:

■ Query  This menu command displays the Query editor. It is a general-
purpose search dialog box that can be used to perform simple or 
compound queries. You can specify compound queries using the 
conjunctions. You can also save queries to disk and restrict the query 
to the current selection.

■ Query by Example  This menu command displays the current input 
form for use as a search window. You specify a query by typing the 
values for which you want to search in the areas corresponding to the 
fields to be searched. You can specify compound queries by typing 
values into more than one area. The results of your query are displayed 
in the current output form.

■ Query and Modify  This menu command is identical to the Query by 
Example menu command, the difference being that the first record of 
the selection from the query is loaded, ready to be modified. You can 
make changes and then browse among found records in order to 
modify them one by one.
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■ Query by Formula  This menu command displays the Formula editor. 
You use the Formula editor to construct a query that uses a formula as 
the query. For example, you can use Query by Formula to search on the 
last three digits of a six-digit part number. A valid formula returns a 
Boolean expression (TRUE or FALSE).

Query Editor The Query editor is a general-purpose editor that can be used to create 
simple or compound queries:

■ You can create compound searches linked with the And, Or, or Except 
conjunctions. For example, you can use the Query editor to perform a 
query for all employees who are over 60 years old or who have an 
income in excess of $45,000.

■ You have the choice of searching through the current selection of 
records or all the records in the table. The other three search methods 
always search the entire table. 

■ You can save queries to disk and open them when you want to repeat 
the query.

■ The Query editor remembers your last query. You can edit the query or 
clear it and enter a new query.

You can search on fields in the current table and fields in related tables. 
You can also search on subfields in the current table or subfields in 
related tables.

If your database includes subtables, you can use subfields in your que-
ries. A query on subrecords creates a new current selection of parent 
records, not subrecords. This group of parent records contain at least 
one subrecord that meets the query. 

However, the query does not remove the other subrecords from the 
parent record. All subrecords stay attached to their parent records.

Suppose a database for employees includes a subtable for information 
about employee children. The fields in the subtable, called subfields, 
are First Name, Middle Name, and Last Name. To find all the employ-
ees with a child named John involves searching the subrecords for 
John in the First Name subfield. 4th Dimension finds all the parent 
records with at least one subrecord with the name “John” in the first 
name subfield. In this case, the selection contains the parent records —
not just the subrecords themselves.
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If your database includes related tables, you can include fields from 
related tables in your query. A query on a field in a related Many table 
works like a search of subrecords. The new current selection in the One 
table consists of all records that are related to at least one record in the 
Many table that meets the query. Queries on related tables are always 
sequential, even if the field being searched on is indexed. 

For example, if employees are stored in the One table and children are 
stored in a related Many table instead of a subtable, a query for 
employees with children named John would produce the same current 
selection of employees.

The Query editor is shown below.

The Query editor contains the following areas:

■ Criteria area  This area displays the query as you create it or after you 
load it from a disk file.

■ Available Fields menu  This menu allows you to select the table or 
tables from which you want to display fields in the Fields list. You can 
display fields from the Master table, the Related tables, or All tables. 

■ Fields list  This area displays a hierarchical list of the fields in the 
selected table or tables. Indexed fields are shown in boldface.

Criteria area

Fields list

Conjunction buttons

Value area

Comparison 
Operator area

Available Fields menu
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■ Comparison Operator area  This area displays a list of comparison 
operators.

■ Conjunction buttons  This area contains three buttons that correspond 
to conjunction operators you can use to join the current simple query 
to the previous simple query.

■ Value area  You enter the value for which you want to search in this 
area.

■ Query in selection button  This button performs the query only on the 
records in the current selection.

■ Query editor buttons  You use this area to save your queries, load other 
queries from disk, cancel the query, or execute the query.

❿❿❿❿ To create a query:

1 Choose Query from the Queries menu.
4th Dimension displays the Query editor, highlighting the first row of 
the Criteria area. 

2 Click a field name in the Fields list1. 
4th Dimension displays the field name in the Criteria area and adds the 
“is equal to” comparison operator, as shown below.

1. If the desired field is in a related table, you need display the fields in the 
related table. See the section “Selecting a Field from Another Table” on 
page 96.

Field name
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3 If you don’t want to use the “is equal to” operator, click the desired 
comparison operator.

Your choices are:

■ Is equal to

■ Is not equal to

■ Is greater than

■ Is greater than or equal to

■ Is less than

■ Is less than or equal to

■ Contains (Alpha and Text fields only)

■ Does not contain (Alpha and Text fields only)

If you want to use the “starts with” comparison (on Alpha or Text 
fields only), see the section “Using the “Begins With” Operator” on 
page 96.

4 Type the value for which you want to search in the Value area.

Value

Value area
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In a Text or Alpha field you can use the wildcard character (@) at the 
end of the value to request a “Begins with” search.

If the field you selected is associated with a choice list, 4th Dimension 
displays the list and prompts you to select a value. If the field you 
selected is a Boolean field, 4th Dimension displays a pair of radio 
buttons. If the field you selected is a subtable, a window listing the 
subfields is displayed.

5 If you want to add another simple query, click Add Line.
4th Dimension adds a new line using the “And” conjunction operator.

6 If you want to use the “Or” or “Except” operator, click the desired 
conjunction operator button.
Repeat steps 2 through 4 to build the second simple query.

When you build a compound query, 4th Dimension evaluates the 
simple queries in the order in which they appear in the Query editor 
(i.e., from top to bottom). There is no precedence among the 
conjunctions. That is, And doesn’t have priority over Or. Thus, if you 
use more than two simple queries in building the compound query, 
the order in which you enter the simple queries can affect the results of 
the query. 
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If you need to add a third simple query, you can choose to either add 
the condition to the existing compound query or insert the new 
simple query between the first two simple queries. To add the new 
query to the end of the existing queries, click Add Line. To insert the 
new query, highlight the last query and click Insert Line. The new 
query is inserted above the line you highlighted.

The following illustration shows the results of clicking Insert Line.

As you build the compound query, you can modify existing parts of 
the query by clicking the line you want to change and clicking a new 
field or operator or typing a new value. For example, if you decided to 
replace the Salary search field with the Department field, you would 
select the second line and click the Department field.

You can remove a simple query by selecting the line and clicking 
Del Line. In a compound search condition, you can remove one line of 
the condition by clicking the Del Line button.

7 (Optional) To save the query to disk, click the Save button and enter a 
filename in the create-file dialog box.
You do not need to save your query to perform the search. 

8 Click Query to search the entire table. 
OR
Click Query in Selection to restrict the query to the current selection.

Click the Cancel button to put away the Query editor without doing a 
query.
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Selecting a Field from 
Another Table

You can use the Query editor to search on related tables and subtables. 
If the field you want to search on is in a related table, choose Related 
Tables in the Available Fields menu, or select All Tables and expand the 
foreign key field in the master table to display fields from the related 
table. The illustration in the following set of instructions shows an 
expanded foreign key field. 

❿❿❿❿ To select a field from another table: 

1 Choose Related Tables from the Available Fields menu.

2 Expand the foreign key field by clicking the plus sign (on Windows) or 
arrow (on Macintosh) in the hierarchical list of fields.
The fields belonging to the related table appear in the hierarchical list.

3 Click the desired field in the related table.

4 Follow steps 3 through 7 at the beginning of this section for directions 
on creating the rest of the query.

Using the “Begins With” 
Operator

If you want to search for records that begin with a specified string, use 
the “is equal to” operator and enter the wildcard character (“@”) at the 
end of the value to search for. 

Foreign key field

Fields in related table

Available Fields menu
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For example, if you want to search for companies whose names begin 
with the string “Frame”, you would use the following query:

Saving a Query to Disk If you perform a query often, you may want to save the query to disk. 
When you save queries to disk, you need to create it only once. In sub-
sequent uses of the Query editor, you simply load the query from disk 
and click Query or Query in Selection to perform the query.

❿❿❿❿ To save a query to disk:

1 Click the Save button.
4th Dimension displays a save-file dialog box where you can enter a 
filename. 

2 Click Save.
The query is saved to disk. The next time that you want to perform this 
query, you need only load the query into the Query editor.

Loading a Saved Query You can reuse a saved query at any time.

❿❿❿❿ To load a saved query:

1 Click the Load button.
4th Dimension displays an open-file dialog box.

2 Select and open the desired file.
4th Dimension loads your query into the Query editor. When you load 
a file, it replaces the query that previously appeared in the Query 
editor.
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Query by Example The Query by Example option is a convenient way to perform many 
queries. In this type of query, you use the current input form to enter 
values on which to search. You can search only on fields in the current 
table. Query by Example performs both indexed and sequential 
queries.

The Query by Example window shown is just an example. Your current 
input form is always used as the Query by Example window. You can 
control the appearance of the Query by Example window by changing 
the current input form using either of the methods described in 
Chapter 3.

You can use comparison operators in Query by Example. For example, 
to use the “is equal to” comparison operator, enter the value to be 
searched on in the appropriate field. If you need a different compari-
son operator, precede the value with one of the following signs:

Comparison Operator Sign Example
is not equal to # #Marketing
is greater than > >30000
is greater than or equal to >= >=30000
is less than < <30000
is less than or equal to <= <=30000
98 4th Dimension User Reference



Using the Queries Menu Commands
You can request a “Begins with” query by placing the wildcard 
character (@) after the value to be searched for. The following figure 
shows the Query by Example window being used to search for all com-
panies whose names begin with “S”.

You can create a compound query by typing values into more than one 
field. If you enter a compound query, the And conjunction is assumed 
(e.g., “Name starts with “S” and is in California”). The following Query 
by Example window illustrates a compound query:
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❿❿❿❿ To use Query by Example:

1 Choose Query by Example from the Queries menu.
4th Dimension displays the input form for the current table as a query-
by-example window. Only Accept and Cancel buttons are enabled.

2 Enter a value to search for in a field. 
For example, to find records for everyone with the last name “Smith,” 
you would enter “Smith” in the Last Name field.

To use a comparison operator, precede the value by the comparison 
operator. To do a “begins with” search, follow the value by the “@” 
symbol.

3 To perform a compound query, enter values in additional fields. 
4th Dimension uses the And conjunction if you enter values for more 
than one field. 

4 Click the Accept button or press the Enter key on the numeric keypad 
to do the query. 
To cancel the query, click the Cancel button or press Ctrl+Period 
( –Period on Macintosh).

Query and Modify The Query and Modify command is intended for quickly finding and 
modifying records. Like Query by Example, it uses the current input 
form as a query window. You specify the query in exactly the same 
manner as with Query by Example.

When a record or selection of records is found, 4th Dimension displays 
the first record in the input form for modification.When you accept 
the record, you are returned to the output form.

■ Using Query and Modify, found records are displayed in the current 
output form. All records within the new selection are simultaneously 
displayed.

■ Using Query and Modify, the current record of the new selection is also 
displayed in the current input form. Thus, you can directly replace the 
values that as desired.

If the new selection contains several records, you can click on the 
navigation buttons on the import form to scroll through each record 
and modify values one by one.
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❿❿❿❿ To use Query and Modify:

1 Choose Query and Modify from the Queries menu.
4th Dimension displays the current input form as a query window. 
Only Accept and Cancel buttons are enabled.

2 Click the entry area for the first field on which you want to search. 

3 Enter a value in the criteria entry area. 
For example, to find records for everyone with the last name “Smith,” 
you would enter “Smith” in the Last Name field.

To use a comparison operator, precede the value by the comparison 
operator. To do a “begins with” query, follow the value by the “@” 
symbol.

4 To perform a compound query, enter values in additional fields. 
4th Dimension uses the And conjunction if you enter values for more 
than one field. For Alpha fields, you can also use the wildcard character 
(@) to perform a “Begins with” search. For example, entering 
“ACME@” in the Company area requests a search of all companies 
whose name begins with ACME.

5 Click the Accept button or press the Enter key on the numeric keypad 
to begin the search. 
To cancel the query, click the Cancel button or press Ctrl+Period 
( –Period on Macintosh).

4th Dimension performs the query, sets the current selection, and 
displays the first record that meets the search criteria in the input form. 

6 Modify the records using standard text editing methods.

7 Click the navigation icons to move to other records in the current 
selection. 
OR
Click the Accept button or press the Enter key on the numeric keypad 
to accept the modified record and return to the output form.
4th Dimension saves each record as you move to another record.

Click the Cancel button to end the editing session — you do not have 
to modify every record in the current selection. 

4th Dimension displays the output form.
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Query by Formula Use the Query by Formula editor to find records based on the results of a 
calculation or data manipulation. You use the Formula editor to write 
the expression on which the query will be performed. The expression 
you write must equal either TRUE or FALSE for each record. You can use 
any function in the language or any user-written function in a formula.

The Query by Formula command is useful for writing queries that 
involve operations such as the following:

■ Performing operations or evaluations on alphanumeric strings

■ Searching on the results of date computations

■ Searching on the results of arithmetic computations

Here are some examples of the uses of the Query by Formula editor.

▼ The following formula is used to search for records in which the last 
seven characters of the Phone number field is equal to “2524444.”

Substring (Phone number;4;7) ="2524444"

▼ The following formula finds people born on the current date regardless 
of year:

(Day of (Current date) = Day of (Birthdate)) & 
(Month of (Current date) = Month of (Birthdate))

▼ The following formula divides annual sales by the cost of living and 
finds records whose calculated value is greater than 1,000:

(Annual Sales / CostOfLiving) > 1000

However, the formula

Annual Sales / CostOfLiving

is incorrect because it returns a numeric value, not TRUE or FALSE. 

Formula Length You can only write formulas that are one logical line long. That is, you 
cannot press the Enter key on the keyboard (Return key on Macintosh) 
and write a second line. The editing area, however, will wrap to the 
next line if the statement is too long.

If you need to use a formula that is more than one line, write it as a 
project method and use the project method in the formula.
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Using the Char Function If you are searching for a character using the Char function, you must 
use Macintosh ASCII codes. For a detailed discussion of the Char 
function, and a list of Macintosh and Windows ASCII codes, refer to 
the 4th Dimension Language Reference.

Saving Formulas You can save formulas to disk and load saved formulas into the 
Formula editor.

Using the Query by 
Formula Editor

The Query by Formula editor enables you to create and use formulas to 
retrieve records. The following figure shows a query (search) formula in 
the Formula editor. 

For a detailed description of the Formula editor, see the section “Global 
Updates” on page 112.
1034th Dimension User Reference



Chapter 4  Selecting Records
❿❿❿❿ To use the Query by Formula editor:

1 Choose Query by Formula from the Queries menu.

2 Use the Formula editor to build a formula. 
OR
Select the name of a user-written function from the Commands area.
OR
Click the Load button to retrieve an existing formula from disk.

If you build a formula in the Formula editor, you can either type your 
function or select operators, fields, and functions from the panels at 
the bottom of the editor. You can drag and drop fields, commands, and 
keywords from their lists into the Formula editing area.

If you click the Load button, 4th Dimension displays an open-file 
dialog box where you can select a file. When you load a file, it replaces 
any formula that appears in the Formula editor.

❿❿❿❿ To save a new formula to disk:

1 Click the Save button.
4th Dimension displays a dialog box and asks you to enter a filename 
for the new formula. 

Note On Windows, the file extension for a formula file is “.4FR”.

2 Click Save to save the formula.
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This chapter discusses the major operations you perform when 
working with data. This includes the following:

■ Adding records

■ Modifying records

■ Updating records

■ Deleting records

After you create a database in the Design environment, you can switch 
to the User environment and begin adding records. To add records to 
the database, you need only to create a table and one or more fields. 
You can then switch to the User environment, begin entering data, and 
return to the Design environment to add tables, fields, forms, 
methods, or make any other changes you like.

After adding records to your database, you usually will need to modify 
the information. If you need to modify one or more records, you can 
use one of the record selection methods described in Chapter 4 to 
display the records. You can then modify the records using either the 
input or output form.

Sometimes you need to make exactly the same change to a group of 
records in a table. This is called a global update. In 4th Dimension, you 
can update the current selection of a table automatically — without 
having to make the change to each record individually.

You may also find that you need to delete one or more records. You can 
delete a record if you discover the record is outdated or irrelevant. If 
the record is needed but the values stored in the record are no longer 
correct, you should modify the record rather than deleting it. You can 
delete the current record from an input form or you can delete a subset 
of records in the current selection using the output form.
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Adding New Records
You can add records using either an input or an output form. For a 
description of the basic operations you use to work with input and 
output forms, see Chapter 3.

Input Forms To add a new record using an input form:

1 Choose New Record from the Enter menu.
You can choose New Record while you are using either an input or an 
output form.

4th Dimension displays a blank input form and places the insertion 
point in the first enterable area in the form.

2 Enter data into the first enterable area.

3 Press Tab.
4th Dimension moves the insertion point to the next enterable area.

4 Enter data into this area.

5 Press Tab.
Repeat the process of entering data into each enterable area until all 
data for that record has been entered.

When you have finished entering data and are satisfied with the values 
you have entered, you can accept the record. 
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6 Press the Enter key on the numeric keypad1 or click the Enter button 
on the input form to accept the record. 

By accepting the record, you are requesting that 4th Dimension add 
the record to the database stored on disk.

After you press enter, a new blank input form is displayed.

7 Repeat the data entry process until you want to stop.

8 When you finish entering data, click the Cancel button on the form or 
press Ctrl+Period ( –Period on Macintosh) when the next blank 
record is displayed. 
Either of these actions displays the output form.

Output Forms You can also add records from the Output form using Enter in List 
mode.

❿❿❿❿ To add a new record using an output form:

1 Choose Enter in List from the Enter menu.
The fields in the current table become enterable. You cannot enter into 
variables, fields from other tables, or subforms. 

2 Choose New Record from the Enter menu or press the Enter key on 
the numeric keypad. 
An insertion point appears in the first field below the last record 
displayed in the output form.

1. Keyboard assignments can be modified using the 4D Customizer Plus tool.
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3 Type in the field and use the Tab key to move through the fields for 
that record. 

Any data validation controls that are attached to the fields on the 
output form will be used when you select those fields. For example, a 
field with a choice list will display the choice list when you tab into 
the field.

Note If the designer of the database has placed the data validation controls 
only on the input form, use of Enter in List will bypass these controls.

4 Press the Enter key on the numeric keypad to save the new record and 
create a new blank record. 
OR
Click a field in another record.
4th Dimension accepts the entries in the record you added.

5 Choose Enter in List from the Enter menu to leave the Enter in List 
mode.

Modifying Records
You modify records when you need to update information or when 
you discover that the information originally entered is incorrect. 
Before modifying a group of records, select the records to modify as the 
current selection. You can search to select records for modification or 
select the records after highlighting them in the output form. 

For information about selecting records and searching the contents of 
a database, refer to Chapter 4. 

Firefly’s address being 
entered in Enter in List 
mode
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You can modify records using either the input or output form. The 
output form is convenient for modifying a group of records because 
several records are displayed at the same time. However, the output 
form typically does not include all the fields on the input form and 
may not duplicate the input form’s data entry controls. 

If a record is being modified in another process, the record is said to be 
locked. Locked records can be viewed, but they cannot be modified. If you 
open a locked record, you will be able to view the entries in the fields, but 
you will not be able to change any data. For a general description of 
processes, see the section “Multi-tasking in 4th Dimension” on page 22. 
For a more detailed discussion of what processes are and how to create 
them, refer to the 4th Dimension Design Reference manual.

4D Server In 4D Server, record locking also occurs when a record is being 
modified by another user. If you open a record that is being used by 
another user or by another process, you will be able to view the 
contents of the record, but will be unable to modify it.

Input Forms You ordinarily enter and modify data using input forms. 

❿❿❿❿ To modify records using an input form:

1 Double-click the record on the output form.
OR
Highlight a record in the output form and choose Modify Record from 
the Enter menu.
4th Dimension displays the record in the default input form.
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2 Select certain fields and edit, replace, or delete the values. 
See Chapter 3 for more information about editing data.

3 Click the Enter button or press the Enter key on the numeric keypad to 
accept the modified record and return to the output form. 
OR
Click a navigation button (Previous Record, First Record, Next Record, 
Last Record) to accept the record and move to another record in the 
current selection.
Clicking a navigation button moves between records in the current 
selection. 

You can cancel your changes and return to the output form at any time 
by clicking the Cancel button or pressing Ctrl+Period 
(Command–Period on Macintosh). 

Output Forms You can modify the fields displayed on the output form using Enter in 
List.

❿❿❿❿ To modify records using an output form:

1 Choose Enter in List from the Enter menu.
The fields in the output form become enterable. A check mark appears 
next to Enter in List to indicate that the Enter in List mode is active.

2 Select a field and edit, replace, or delete the value. 

Middle initial is added 
to First Name field
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When the Enter in List mode is active, double-clicking selects a field in 
a record rather than displaying the record in the input form.

Note When you are in Enter in List mode, you can choose Modify Record 
from the Enter menu to modify the record in the input form.

3 Type the new text and press Tab or the Enter key on the keyboard. 
In the example shown above, typing will replace the address with a 
new value. 4th Dimension saves your changes to a field when you press 
Tab or Enter (Return on Macintosh) and selects the next field.

4 Continue modifying fields as needed.

5 Click a field in another record in the output form to modify another 
record. 
OR
Press the Enter key on the numeric keypad to accept the modified 
record and create a new blank record.
4th Dimension saves your modifications.

6 Choose Enter in List from the Enter menu to leave the Enter in List mode.

Job title field 
selected
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Global Updates
You do a global update when you want to make a specific change to a 
group of records. You perform a global update to automate changes to 
a group of records that would otherwise be tedious and time-
consuming. For example, you would perform a global update if you 
wanted to do the following:

■ Change all prices in an Inventory table by a certain percentage,

■ Format a numeric or Alpha field.

The global update is done by “applying” a formula to the current 
selection of records. That is, the formula is used to make the change to 
each record in the current selection.

Here are some example formulas and explanations of the functions 
they perform. 

▼ The following formula multiplies the Salary field by 1.05. It could be 
used when a salary increase goes into effect.

Salary := Salary * 1.05

▼ The following uses a built-in function to make the contents of the 
State field uppercase. It ensures uniformity in the way State appears in 
labels and reports. 

State := Uppercase (State)

▼ This formula includes a user-written function that formats the 
Last Name field. It sets the initial letter of the Last Name field to upper-
case and all the remaining letters to lowercase. 

Last Name := Capitalize (Last Name)

The ability to include user-written functions when doing global 
updates is a powerful feature of 4th Dimension.

To perform a global update, you use the Formula editor to write a for-
mula that is applied to each record in the current selection.

You can use 4th Dimension’s built-in routines, user-written project 
methods, or plug-in functions to create formulas. For more informa-
tion about creating functions, see the 4th Dimension Design Reference 
manual. See the 4th Dimension Language Reference manual for detailed 
information about programming syntax and functions.
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The Formula Editor The Formula editor provides many shortcuts for writing formulas. You 
can click field names, operators, and routines to add them to the 
formula.

The Formula editor contains the following areas:

■ Editing area  This area displays the formula as you build and edit it. 
You create the formula in this area by either typing your function or 
selecting operators, fields, and functions from the toolbar or panels at 
the bottom of the editor. You can add a field to the Editing area by 
double-clicking or using drag and drop.

■ Operators toolbar  The toolbar contains a row of buttons that you can 
use to insert operators into a formula. See the 4th Dimension Language 
Reference for a detailed discussion of operators. 

The operators are shown in the following illustration.

Editing area

Fields list

Tables drop-
down list

Operators 
toolbar

Commands list

Keywords Comparison operators Braces Quotes

Assignment
Addition
Subtraction
Multiplication
Division
Modulo

Equals
Not Equal To
Greater Than
Less Than
Less Than or Equal To
Greater Than or Equal To 

Parentheses
Curved Brackets (Array elements)
Double Brackets (Char. Ref.)

(MacOS)
1134th Dimension User Reference



Chapter 5  Working with Records
■ Tables drop-down list  This list controls the fields displayed in the 
Fields list. You can choose to display fields from:

■ The Master table  Fields from the current table are displayed.

■ Related tables  Fields from the current table are displayed in a hier-
archical list. You can expand a foreign key field to display related 
fields.

■ All tables  All tables and fields are displayed in a hierarchical list. 
You can expand any table to display the list of fields in that table.

■ Fields list  This area displays the names of tables and fields or fields in 
the master table. The information in the Fields list depends on the 
Tables drop-down list setting. The three options are shown in the 
following illustration:

Click the plus sign (on Windows) or arrow (on Macintosh) to expand a 
foreign key field to show the list of related fields.

Note Only visible fields appear in the Fields list. For information about 
making fields invisible, refer to the 4th Dimension Design Reference 
manual.

■ Commands list  This area contains a list of drop-down menus or an 
alphabetical list of commands and user-written methods. Each drop-
down menu lists a group of 4th Dimension functions and commands. 
The Commands list also displays the names of project methods and 
plug-in commands. These methods appear at the end of the list of 
drop-down menus. 

Master table:
The fields in the master 
table are listed.

Related tables:
The fields in the master table are 
listed in a hierarchical list. A foreign 
key field can be expanded to show 
fields in a related table (as shown).

All tables:
All tables are shown in a hier-
archical list. You can expand 
a table to display fields in that 
table (as shown).
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The menu above the Commands list controls whether the commands 
are grouped by theme or listed alphabetically. Use this menu to control 
the display in the Commands area. See the 4th Dimension Language 
Reference for a detailed discussion of 4th Dimension commands and 
functions.

■ Buttons area  This area contains buttons for saving your formula, 
loading a saved formula from disk, canceling an editing session, and 
applying the formula.

You can build a formula by clicking operators and commands. You 
double-click field names or add them to the editing area using drag 
and drop. When you click an item, it automatically appears in the Edit-
ing area, where you can modify it with standard cut, copy, and paste 
techniques. You can also type directly into the Editing area.

A formula can be only one logical line long. You cannot press Return 
and type another line. However, the formula can accept any user-
written method. Your methods can be many lines long.

As you write the formula, the Formula editor performs basic syntax 
checking. If it finds an error, it displays the error message above the 
Editing area, as shown in the following illustration.

Correct the error before attempting to apply the formula to the current 
selection.

Error message
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❿❿❿❿ To perform a global update by applying a formula:

1 Set the current selection to the records to be updated. 
For more information about setting the current selection, refer to 
Chapter 4.

2 Choose Apply Formula from the Enter menu.

3 Use the Formula editor to build the formula. 
OR
Click the Load button to retrieve an existing formula from disk.

■ To add a field to the formula, double-click a field name or drag the 
field name from the Fields list to the editing area. If the field is in a 
related table, first expand the foreign key field to display the list of 
related fields. A foreign key field has a plus sign (on Windows) or 
arrow (on Macintosh) indicating that it can be expanded.

■ To add an operator to the formula, click an operator button.

■ To add a command or project method to the formula, click the 
command or method.

If you click the Load button, 4th Dimension displays an open-file 
dialog box and so that you can select a file (“.4FR” file extension on 
Windows). When you load a file, it replaces any formula that currently 
appears in the Formula editor.

After you load a formula, you can modify it in the editing area.

4 (Optional) If you want to save a new formula to disk, click the Save 
button.
4th Dimension displays a create-file dialog box and asks you to name 
the file to store the new formula.

5 Click OK to apply the formula to the current selection.
4th Dimension closes the editor and applies the formula to the records 
in the current selection.

Click the Cancel button to close the editor and return to the output 
form without applying the formula.
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Deleting Records
You may want to delete a record that is outdated or no longer neces-
sary. If the record is needed but the values stored in the record are 
incorrect, you should modify the record rather than delete it. 

You can delete records in two ways:

■ Delete records individually from the input form,

■ Delete a subset of records from the output form.

Deleting records is permanent and cannot be undone. When you 
delete records, 4th Dimension displays a dialog box asking you to 
confirm the deletion.

Deleting Records 
Using the Input 
Form

Deleting records from the input form lets you verify the contents of 
each record before you delete it. 

❿❿❿❿ To delete records using the input form:

1 Use a query or a navigation button to display the record you want to 
delete.

2 Click the Delete button to delete the record. 
Depending on the design of the input form, the Delete button may be 
represented in different ways.

When you click the Delete button, 4th Dimension asks you to confirm 
the deletion. You cannot undo the deletion after 4th Dimension 
removes the record.

3 Click the Yes button to complete the deletion. 
4th Dimension removes the current record from the database and 
returns to the output form.
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Deleting Records 
Using the Output 
Form

Using the output form, you can delete several records in one opera-
tion. If necessary, use one of the methods to select records that you 
want to delete. You can select records by clicking or by doing a query.

❿❿❿❿ To delete records using the output form:

1 Highlight the record or records that you want to delete. 

Note If you want to delete all the records in the table, choose Show All from 
the Queries menu and Select All from the Edit menu.

Highlighting records is described in the section “Highlighting” on 
page 50.

2 Choose Clear from the Edit menu.
4th Dimension displays a dialog box asking you to confirm the 
deletion. You cannot undo a deletion.

3 Click the Yes button to complete the deletion. 
4th Dimension removes the highlighted record or records from the 
database.
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Deleting Locked 
Records

You cannot delete locked records. Records are locked when they are 
being used by another process. For instance, if a process opens a record 
for modification, 4th Dimension locks that record so that other pro-
cesses cannot modify it.

4D Server Records are also locked when they are being used by another user.

Before deleting records, you create a selection of the records you want 
to delete. If your selection includes any locked records, the deletion 
will proceed but the locked records will not be deleted and will remain 
in the current selection after the deletion. You must wait until these 
records are unlocked (i.e., no longer being used) to delete them.

Records Deleted in 
Another Process

The current selection may be altered by records deleted in another 
process. For example, while you are working in your database, you 
might start another process that deletes certain records from a table. 
The records deleted in that process are permanently removed from the 
table. However, the records you see while working with the database in 
the User environment may not reflect those changes to the table until 
a new selection of records is created. 

To illustrate this point, suppose that a table contains fifty records and 
that all of the records are in the current selection. At this point, the 
title bar of the output form says that “50 of 50” records are selected. If 
one of the records is deleted in another process, the title bar changes to 
say that “50 of 49” records are selected. There now appear to be more 
records in the current selection than in the table! The title bar will be 
updated when you change your current selection.

If you attempt to modify or delete the deleted record, a dialog box will 
appear saying that the record has been deleted.

4D Server Records deleted by another user have the same effect on the current 
selection. The records are deleted from the table, but not from the cur-
rent selection. Thus, the current selection may appear to contain more 
records than actually exist in the table.
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6 Sorting Records

A sort reorders records according to the values in the table. It is 
common to sort records:

■ To view records on screen in a particular order

■ Before printing a report or labels

■ Before graphing data

As you enter data into a new database, 4th Dimension stores the 
records in the order in which they are entered or imported. When you 
list records in an output form or print records, they appear in this 
order. Often, you want to view records in another order. For example, 
you might want to alphabetize a list of names in a report — a sort on 
the Last Name field reorders the records alphabetically by Last Name.

A sort can be done while you are using an input or an output form. If 
you sort from an input form, the first record in the new sort order is 
displayed in the input form. Otherwise, the sorted records are 
displayed in the output form. 

4th Dimension conducts indexed sorts very quickly. If you are sorting 
on only one field and that field is indexed, 4th Dimension uses the 
index.
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Sort Levels
You can sort records on up to 30 different fields or formulas. Each field 
or formula you sort on is referred to as a sort level. For example, the 
results of a two-level ascending sort on the last name and first name 
fields would produce a list such as this: 

Aardvark, Anthony
Aardvark, Artemis
Aardvark, Arthur
.
.
Zygote, Elena
Zymosian, Elmer

When sorting the contents of fields, 4th Dimension is not case 
sensitive (i.e., “Smith” = “smith”) or diacritical sensitive (i.e., “Aá” = 
“Aa”).

Note If you are using an international version of 4th Dimension and your 
operating system is diacritical sensitive (e.g., “Aá” ≠ “Aa”), sorting 
operations will also take diacritical marks into account. 

Ascending and Descending Order
You can specify either an ascending or descending order for each field or 
formula that you are sorting on. Sorting from A to Z or smallest to 
largest is known as an ascending sort. Sorting in the reverse order is called 
a descending sort — largest to smallest, latest to earliest, and Z to A.

If you are sorting on more than one level, you can freely mix 
ascending and descending sort orders. A multiple-level sort can mix 
fields and formulas and ascending and descending sort orders.
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The Order By Editor
You use the Order By command in the Queries menu to sort the records 
in the current selection. Sorting the current selection changes the order 
in which records are displayed or printed. This is a temporary sort; it 
does not affect the order in which the records are stored on disk. 

When you choose Order By, the Order By editor enables you to specify 
the sort you want to perform.

The Order By editor contains the following areas:

■ Fields list  This area displays a hierarchical list of fields in the current 
table. Indexed fields are shown in boldface. You can sort on fields from 
subtables and related tables (provided the relation is automatic). To use 
a field from a related table or subtable, expand a foreign key field by 
clicking on the plus sign (on Windows) or arrow (on Macintosh) to 
display the fields from the related table. 

Note Only tables and fields that are visible appear in the Order By editor. For 
information about making tables or fields invisible, refer to the 
4th Dimension Design Reference manual.

■ Sort area  This area displays the sort fields or sort formulas and the 
direction of each sort. The arrows on the right of this area are used to 
specify an ascending or descending sort.

Fields list

Sort area

Indexed field 
shown in bold

Foreign key field
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■ Add Formula button  You use the Add Formula button to write a for-
mula as one of the sort criteria. You use a formula when you want to 
sort on something that is not a field — such as a calculated value or a 
portion of a field. For instance, you might sort on a calculated failure 
rate for parts or on the last four digits of a Part Number field.

■ Button panel  The Button panel has buttons for adding or removing 
fields from the Sort list.

■ Modify button  When you click the Modify button, it displays the 
selected sort criterion in the Formula editor. If the selected criterion is a 
formula, the formula is presented for editing. If the criterion is a field, 
the field name appears in the editing window of the Formula editor.

■ Cancel button  You use this button to cancel the sort and return to the 
form you were using.

■ Order By button  You use this button to perform the sort.

Note The Quick Report editor can sort records that appear in a quick report. 
For more information about the Quick Report editor, see Chapter 8. 

Sorting a Selection
Use the Order By menu command to sort the current selection of 
records. This sort is temporary and applies only to the current 
selection; it does not affect the order in which records are stored in the 
database. The Order By command is commonly used immediately after 
a query and before printing a report or labels.

Note You can carry out a permanent sort of table records using the 4D Tools 
utility, which is supplied with 4th Dimension and 4D Server. For more 
information about this point, refer to the documentation for 4D Tools. 

❿❿❿❿ To sort the current selection:

1 Choose Order by from the Queries menu.
4th Dimension displays the Order By editor.

Adds selected field to Sort list

Removes all fields from Sort list

Removes selected field from Sort list
124 4th Dimension User Reference



Sorting a Selection
2 Double-click the name of a field on which you want to sort.
OR
Drag the field name from the Fields list to the Sort area.
OR
To sort on a formula, click the Add Formula button.
When you open the Order By editor, the Fields list displays the fields 
from the master table. You can choose fields from related tables or sub-
tables by expanding a foreign key field or subtable field.

If you clicked the Add Formula button, 4th Dimension displays the 
Formula editor. For information on writing a formula, see the section 
“Sorting on a Formula” on page 126.

The field name or formula appears with a sort direction arrow in the 
Criteria area.

3 If necessary, click the sort direction arrow in the Sort area to switch 
between ascending and descending sort order. 
Up is ascending; down is descending. 

4 If necessary, repeat steps 2 and 3 to add secondary sort levels to the 
list.
For each sort level, you can specify ascending or descending order.

For example, the sort order shown requests a listing of employees 
sorted by department. Within each department, the employees are 
sorted by salary, with the highest salary first.

Ascending sort

Descending sort
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5 Click the Order By button.
4th Dimension sorts the current selection. If you are using an input 
form, the first record in the sorted current selection is displayed. 

Sorting on a 
Formula

You can sort on a field or on a formula. For example, the following 
formula sorts on the month of a birth date field. 

Month of (Birth Date)

❿❿❿❿ To create a sort formula:

1 In the Order By editor, click the Add Formula button.
4th Dimension displays the Formula editor. 

You use the Formula editor to create a formula that returns the values 
to sort on. The formula can return values of any data type. For more 
information about how to use the Formula editor, see the section 
“Global Updates” on page 112.

2 Click OK when you are finished writing the formula. 
4th Dimension displays the formula in the Sort area.

The formula appears with a sort direction arrow in the Sort area.

Modifying a Sort 
Order

You can remove or reorder fields or formulas in the Sort area.

■ Removing a field or formula  To remove a field or formula, highlight 
the field or formula in the Sort area and click the Remove button  
or press Backspace (Delete on Macintosh). To remove all fields or for-
mulas, click the Remove All button .

■ Reordering the sort criteria  To reorder fields or formulas in the Sort 
area, drag the field or formula up or down.

Sorting While a Record Is Being Modified
If a record in the current selection is being modified in another process 
at the same time that you are performing a sort, 4th Dimension uses 
the last saved value of the field in the sort. 

For example, if an employee’s job title is in the process of being 
changed from “Engineer” to “Staff Engineer” while you are sorting on 
Job Title, the employee record will still be listed as “Engineer” and 
sorted with the engineer records. 
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If you were to perform the sort again, after the record has been 
modified and saved, the new job title would be used and the employee 
record would be sorted as a staff engineer.

4D Server The last saved value of a field is also used if a record in the current 
selection is being modified by another user. If the sort is performed 
again, after the other user has finished modifying the record, the newly 
saved value of the field is used.

Sorting While an Index Is Being Built
Sorting on an indexed field is extremely rapid, as the values for the 
field have already been organized by 4th Dimension. However, if the 
index for a field is being built or rebuilt at the same time that you are 
performing a sort on the field, 4th Dimension will be unable to use the 
index and the sort will be sequential.
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7 Form Reports

One of the major functions of a database is to produce reports. 
In 4th Dimension, you can produce a report using either a form or 
using the Quick Report editor. This chapter explains how to print 
a report using a form.

There are several advantages to using a form for a report: you can use 
graphic elements on the form, you can control the placement of report 
elements precisely, you can use methods to perform calculations, and 
you can use headers to identify each subsection of a break report.

You can use a form to create reports that:

■ Require a non-columnar format

■ Display subforms

■ Contain embedded graphics

■ Require special graphic elements, such as hairlines.

Chapter 8 discusses designing and printing reports using the 
Quick Report editor. The Quick Report editor is excellent for printing 
tabular reports that use a standard columnar format.

This chapter assumes that you have already created a form for the 
report. For information about designing output forms for reports, 
see the 4th Dimension Design Reference manual.
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Standard Reports and Reports with Breaks
There are two kinds of reports that can be printed using output forms, 
standard reports and reports with breaks. When you create a standard 
report, you simply print the current selection using a form. Reports 
with breaks separate records into groups. To create a report with breaks, 
you must sort the current selection before printing.

Printing Standard 
Reports

4th Dimension prints the records in the current selection. Set the cur-
rent selection to the subset of records you want to print. If you want 
the report to list the records in a particular order, sort the current selec-
tion before printing the report.

❿❿❿❿ To print a standard report:

1 Select the records to be included in the report. If desired, sort the 
records.
Selecting records is discussed in Chapter 4 and sorting records is 
discussed in Chapter 6.

2 Choose Print from the File menu.
The Print Form dialog box appears.

3 Choose the form you want to use.
You can choose a form by clicking on it, using the arrow keys, or by 
typing the first letter of a form name.

When you click on a form, a preview appears in the preview area. 

4 Click OK or press Enter.
4th Dimension displays the Page Setup dialog box for your selected 
printer. Choose any desired options and click OK.
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4th Dimension displays the Print dialog box for the printer you 
selected in the Print Manager. To preview the report on the screen, 
check the Preview on Screen check box.

If you checked the Preview on Screen check box, the report will be dis-
played on screen, one page at a time. The figure below shows a report 
previewed on screen.

When a page of the report is being previewed, you can do the follow-
ing:

■ View a close up of the report by clicking the Zoom button. When you 
use Zoom, you can move around the page by dragging the hand 
pointer.

■ View the next page of the report by clicking the Next Page button.

■ Print the page being previewed by clicking the Print button.

Zoom button

Next and previous 
page buttons

Print button

Stop button
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If you did not check the Preview on Screen check box, the report will 
be sent to the printer you selected in the Print Manager (Chooser on 
Macintosh).

Printing Reports 
with Break Levels

Break levels are used to separate records into groups and print sum-
mary calculations for each group. The output form used to print a 
report with break levels must contain at least one break area. For infor-
mation about designing output forms with break levels, see the 
4th Dimension Design Reference manual.

If your report includes break levels, you must sort the current selection 
before printing. When sorting records for a report with break levels, 
you normally sort on at least one more sort level than the number of 
break levels in your output form. If your report has one break level, use 
at least two sort levels. For example, if your report lists employees by 
department, the report has one break level (Departments). 

You can sort on your break field (Department Name) and one more 
field — Last Name. Employees will be listed alphabetically by last name 
within each department.

When you print a report with break levels, you must turn on break 
processing. Break processing causes 4th Dimension to break the records 
into groups and compute summary calculations.

Header area

Detail area

Break area

Total area

Footer area

Break Header area
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There are two ways to turn on break processing. If an object on the 
form uses the Subtotal function, break processing is turned on auto-
matically. Break processing can also be turned on by executing a 
method when the report is printed. The method must contain two 
commands, ACCUMULATE and BREAK LEVEL. For more information 
about using these commands in a method, refer to those commands in 
the 4th Dimension Language Reference manual.

For information about how to use the Subtotal function in output 
forms, see the 4th Dimension Design Reference manual.

❿❿❿❿ To print a report with breaks:

1 Select the records to be included in the report. 
Selecting records is discussed in Chapter 4.

2 Sort the records by at least one more level than the number of breaks 
in the report.
Sorting records is discussed in Chapter 6.

3 Execute the method that turns on break processing.

Note This step can be skipped if the output form turns on break processing 
automatically by using the Subtotal function.

4 Choose Print from the File menu.
The Print Form dialog box appears.

5 Choose the form you want to use.

6 Click OK.
4th Dimension displays the Page Setup dialog box for your selected 
printer. Choose any desired options and click OK.

4th Dimension displays the Print dialog box for your selected printer. 
To preview the report on the screen, check the Preview on Screen 
check box.

If you checked the Preview on Screen check box, the report will be dis-
played on screen, one page at a time. See the description of the options 
available for previewing a report in the section “Printing Standard 
Reports” on page 130.

If you did not check the Preview on Screen check box, the report will 
be sent to the printer you selected in the Print Manager (Chooser on 
Macintosh). A dialog box keeps you informed of the progress of the 
operation.
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8 Quick Reports

Introduction
One of the most important tasks in data management is report genera-
tion. The Quick Report editor is one of two tools made available by 
4th Dimension for the purpose of designing reports. You use the Quick 
Report editor to create ad-hoc reports in the User environment. The 
other tool is the Form editor, which you can use to design reports in 
the Design environment. You should use an output form to design 
reports that require complex designs or programmatic processing.

Using the Quick Report editor, you can:

■ Produce lists of records.

■ Create break areas.

■ Produce cross-table reports.

■ Compute summary calculations.

■ Modify fonts and styles in the report.

■ Define borders and background colors on a cell basis.

■ Save and open quick report designs to disk.

■ Select different output types such as HTML or text file, 4D View or 4D 
Chart area, print or save to disk.

The Quick Report editor produces reports from the current selection of 
records. Before generating a report, set the current selection of records 
that you want to include in your report.
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Overview of the editor

In the user environment, the Quick Report editor appears as follows:

It consists of two main areas:

■ The Quick Report data area that is used to specify the type of report to 
be built and the data to be integrated; it also can be used to access the 
Quick Report Wizard:
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■ The actual Quick Report area:

This shows the area as it appears when a Quick Report area is inserted 
in a form. This is where actual column and row contents are created, 
where sort orders are defined, etc. Also, this area includes various 
toolbars, its own menu bar and contextual menus.

For example, this area could be placed in a form as depicted below:
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List Mode and 
Cross-table Mode

In the Quick Report editor there are two operation modes available 
which generate two specific types of reports: List and Cross table.

■ List mode
This is the default mode and was the only mode available in the 
previous version of the Quick Report editor. In this mode, reports 
would typically display records as a list with break levels where sums 
would be performed.The following is a typical List quick report. 

■ Cross-table mode
This mode allows you to display your report as a two-dimensional 
table. This is useful when you want to display data from a data source 
broken down into categories that actually are a function of two other 
data sources. 
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For example, a cross-table form would let you display in a table how 
many of each product type was sold in each quarter. The following is a 
typical Cross-table Quick Report.

Quick Report Basics
This section describes basic operations used when working with the 
Quick Report editor to design a report.

Creating a New 
Quick Report

By default, the Quick Report editor lets you create reports in the User 
environment. 
It is also possible to create reports from the Custom Menus mode, if a 
Quick Report area has been inserted into a form.

❿❿❿❿ To design a quick report:

1 Choose Quick... from the Report menu.
4th Dimension displays the Quick Report editor. If a previous report 
has been defined, it appears in the window. To erase the contents of 
the window, choose New from the File menu or click the icon New in 
the file management toolbar to begin a new Quick Report design.

2 Choose the type of report to be generated by clicking either on the 
List or Cross table button, located at the bottom left corner of the 
Quick Report editor:
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The List type is generally selected by default. The selection of a type 
modifies the Quick Report area. 

Loading and 
Saving a Quick 
Report Design

You can save a quick report design as a file that you can open from the 
Quick Report editor. The quick report design includes all of your speci-
fications for the report, but not the data. By saving report designs, you 
can maintain a library of quick report designs that you can use accord-
ing to your needs.

Note If you do not save your design, it is displayed the next time you open 
the Quick Report editor but only during the same work-session. 

Saving a Quick Report 
Design

❿❿❿❿ To save a quick report design:

1 Choose Save as from the File menu.
OR
Click the Save as icon in the file management toolbar .
4th Dimension displays a create-file dialog box in which you can name 
the quick report design.

Note Quick report files in 4th Dimension for Windows are denoted by the file 
extension .4QR.

2 Enter a filename for the quick report and click OK. 
4th Dimension saves the report as a file that you can open with the 
Quick Report editor. You can save the file on your hard disk. If you 
modify the parameters of the report subsequently and want to save 
them again, you just need to choose the Save command in the File 
menu. 

The new file will replace the previous one on the disk, without the 
standard save file dialog box appearing. 

Loading a Quick Report 
Design

When the Quick Report editor is open, you can load a saved design 
and use it to print a new report. You can use the same quick report 
design repeatedly to print different selections of records.

❿❿❿❿ To load a report design:

1 Choose Open from the File menu.
OR
Click the Open icon in the file management toolbar .
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The Quick Report Wizard
4th Dimension displays an open-file dialog box displaying a list of 
available quick report designs. 

2 Double-click a filename or select a filename from the list and click OK.

4th Dimension replaces the current design with the design you opened.

The Quick Report Wizard
When creating a manual Quick report, you can use the Wizard to guide 
you through the creation of the report.

To invoke the wizard, click the Open wizard button in the Quick 
Report editor:

The pages of the wizard then replace the data area in the window of 
the Quick Report editor:

The construction of the report is then carried out through detailed 
steps with comments appearing in the right-hand part of the window. 

List of steps

Information
area
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To create a Quick Report using the wizard, follow the instructions 
displayed on the screen. 

To exit the wizard, click on the button to return to Manual mode:

Using the Quick Report Editor

Interface When you create a quick report, you can specify the following:

■ Columns that display fields or formulas, either from the current table 
or from related tables,

■ Sort levels and order (list mode),

■ Summary calculations,

■ Display format,

■ Text for labels,

■ Formats for numeric and Boolean data,

■ Font, font size, style, and justification for labels, summary calculations, 
and data,

■ Background colors on a cell column or row basis,

■ Borders,

■ Page headers and footers.
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List mode:

Cross-table mode:

Fields list

Sort list

Tool bars 
and menu bars

Report type
selection buttons

Master Table
drop-down list

Break row

Title and detail rows
Column divider

Field

Cell

selection list

Fields list
Sort orders

Tool bars 
and menu bars

Report type
selection buttons

Master Table
drop-down list

Title and detail rows

Column divider

Field

Cell

selection list
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The Quick Report editor contains the following elements: 

■ Master Table drop-down list: This menu is used to specify the master 
table that will be used as a basis for generating the report. The fields of 
this table are displayed in the Fields list and the related fields will be 
displayed in relation to this table. 

■ Fields list: This list lets you select the fields to be inserted into the 
report by double-clicking or by drag and drop. It displays either the list 
of fields found in the master table, the hierarchical list of tables and 
related fields or the hierarchical list of all the tables and fields of the 
database. You choose the type of display in the Field selection list 
located just above the area. 
Indexed fields appear in bold. You can also display and select the fields 
of related tables.

Note Only tables and fields which are not hidden appear in the Fields list of 
the Quick Report editor. For information about hiding tables and 
fields, refer to the 4th Dimension Design Reference manual.

■ All relations in automatic: This option is used to specify the way in 
which the Quick Report editor will make use of the relations between 
the different tables of the database. 
On principle, the editor can only use automatic relations. By default, 
the option is not checked and only automatic relations can be used by 
the editor. 
If the All relations in automatic option is checked, the Quick Report 
editor considers the manual relations of the database as automatic 
relations and will thus enable access to all the data related to the 
database. 

Note to developers The All relations in automatic option causes all the relations to pass 
into automatic for the current process, even after the Quick Report 
editor has been closed. If you want to make sure that all the relations 
will be manual after using the Quick Report editor, execute the 
statement AUTOMATIC RELATIONS(False;False). 

■ Column dividers: These lines indicate the boundaries between columns 
of the report. They can be moved manually in order to enlarge or 
reduce the size of each column. Manual resizing deselects the Auto-
matic Width option if it has been activated for the column concerned.

■ Cells: A cell is the intersection of a row and a column.
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■ Scroll bars: You use the scroll bars to view parts of the quick report 
design that extend beyond the area of the quick report form. 

■ Sort list/Sort order display area: 

■ In List mode, this list displays the fields of the report on which the 
sort will be carried out, as well as the sort order and whether it will 
be ascending or descending. Each field inserted into this list causes 
a sub-total row to be added in the Quick Report area. 

■ In Cross-table mode, this area displays the sort order for each data 
source.

■ Quick Report area: This area lets you build your report by inserting 
fields using drag and drop, double-clicking or via the contextual menu; 
you can also adjust the width of the columns added or delete breaks or 
formulas, define the colors and borders of cells, etc.

■ Title row: The title row is repeated for each page. This row displays 
the names of fields or formulas that have been inserted into the 
report. It is repeated for each page of the report. The Quick Report 
editor inserts field names by default, but you can modify the con-
tents.

■ Detail row: This row contains information drawn from each record 
and is repeated in the report for each record. You can associate a dis-
play format with it, depending on the type of data represented.

■ Subtotal rows: These rows display intermediate calculations as well 
as the wording that is associated with them. A row is created for 
each sort order.

Title row

Detail row

Column data source

Grand total row

Subtotal rows
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■ Column data sources: These titles indicate the source of the data for 
each column.

■ Data Sources: These two cells will house fields that will be used for 
the two categories of the array. The center cell can also accept fields 
sources and calculations at the same time.

■ Total cells: These cells are designed to house calculations on the col-
umn’s contents.

■ Title cells: These cells house the titles for the last column or the last 
row. Their contents can be modified.

The following figures shows completed quick report designs and the 
relationship between the specifications in the design and the printed 
output:

Data Sources

Last Column Title

Last row title

Total cells

List Report
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Contextual menus The Quick Report editor has contextual menus that make it easy to 
access certain row, column, and cell operations. Instead of making 
menu selections or working with the Cell or Column properties areas, 
you can perform certain operations by displaying a Quick Report 
contextual menu.

There are separate contextual menus for row, column, and cell 
operations.

❿❿❿❿ To use a contextual menu:

1 Position the pointer in a cell, a row title, or a column heading and hold 
down the right mouse button (on windows) or press the Control key 
while clicking in the report area (MacOS).
A contextual menu appears. The commands in the contextual menu 
depend on where your pointer is (i.e., a row label, column heading, or 
cell). Also, menu commands that are inappropriate for the particular 
row, column, or cell are disabled.

Cross-table 
mode
1474th Dimension User Reference



Chapter 8  Quick Reports
2 Choose the desired menu command:

As with any contextual menu, this menu’s contents vary depending on 
which cell type is highlighted. Items available break down into five 
main types:

■ Font attributes,

■ Display formats,

■ Standard calculations,

■ Column or row management items, and

■ Cell borders.

Font Attributes These items appear in the contextual menu when a cell, column or row 
is selected. Selecting a font attribute will apply it to the current 
selection (cell, row or column). The Font attribute items appear as 
follows:

■ Font
Selecting this item displays the list of fonts installed on your machine 
from which you can select the font that will be applied to the items 
selected in the report area.

Once an item in the list is selected, a check mark is displayed next to it.

Cell

Row

Column
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■ Size
Selecting this item displays the list of font sizes from which you can 
select the font that will be applied to the items selected in the report 
area.

Once an item in the list is selected, a check mark is displayed next to it.

■ Style
Selecting this item displays the list styles (Plain, Bold, Italic, and 
Underline) from which you can select the font that will be applied to 
the items selected in the report area.

Once an item in the list is selected, a check mark is displayed next to it.

■ Justification
Selecting this item displays the list of justification attributes (Default, 
Left justified, Centered and Right justified).

Note Default is the default justification for this data type (left for numbers 
or, otherwise, right).

Once an item in the list is selected, a check mark is displayed next to it.
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■ Font color
Selecting this item displays a palette of colors.

Display Formats These items appear in the contextual menu when either a cell or a 
column is highlighted. From the menu, you can select one of the 4D 
default formats that match the data type of the column. Once selected, 
the format applies to the entire column, regardless of whether the 
current selection is a cell or a column. 

Summary Calculations These commands appear in the contextual menu when the current 
highlighted cell belongs to either the Grand total row or to a Subtotal 
row.

Selecting an item will insert the corresponding calculation in the 
highlighted cell (cf.  “Adding Summary Calculations” paragraph, 
page 173). Once an item in the list is selected for a cell, a check mark is 
placed next to it. It is possible to select several calculations 
successively. 

Column and Row 
Management Items

There are several items that are dedicated to column or row 
management:

■ Hide
Selecting this item hides the current column or row. Once it is hidden, 
a check mark is displayed next to the item, and the row or column is 
crossed out.
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■ Add...
This item is displayed when a row is highlighted or nothing is high-
lighted. Selecting this item displays the formula editor to allow you to 
define the data source for the new column. Once this is done, the new 
column is added to the right of the right-most existing column.

■ Insert...
This item is displayed only when a column is highlighted in list mode. 
Selecting this item displays the formula editor to allow you to define 
the data source for the new column. Once this is done, the new col-
umn is added to the left of the current highlighted column.

■ Delete
This item is displayed only when a column is highlighted in list mode. 
Selecting this item deletes the current highlighted column.

■ Edit...
This item is displayed only when a column is highlighted in list mode 
or when a cell is highlighted in cross-table mode. Selecting this item 
displays the formula editor to allow you to edit the data source for the 
current column (list mode) or for the current cell (cross-table mode).

■ Automatic Width
This item is displayed only when a column is highlighted in list mode, 
or when any cell is highlighted in cross-table mode. You can use this 
item to select or deselect the automatic width. When Automatic Width 
is selected, 4D will try to match the column size to the data so that the 
data fits on one line.
1514th Dimension User Reference



Chapter 8  Quick Reports
Borders These items appear in the contextual menu when a cell, column or row 
is selected. Selecting Borders... displays the Borders dialog box:

For more information about this dialog box, refer to the  “Setting 
Borders” paragraph, page 163. 

Once defined, the border format is applied to the current selection 
(cell, row or column).

Selecting Rows, 
Columns, and Cells

When designing a List quick report, you need to select rows, columns, 
and cells in the quick report form. A cell is the intersection of a row 
and a column.

❿❿❿❿ To select a row:

■ Click on the Title, Detail, Subtotal, or Grand total cells in the row label 
area. 

❿❿❿❿ To select a column:

■ Click the Header row of a column. 

❿❿❿❿ To select a cell:

■ Click the cell.
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Adding and 
Modifying Text

You can add or modify text in the quick report form to label parts of the 
report. For example, if you requested summary calculations, you can 
label them by adding text to other cells in the Subtotal and Grand total 
rows.

You can add and modify text as follows:

■ Edit the text that 4th Dimension automatically adds to the Title row of 
the report,

■ Insert text in empty cells of the Subtotal and Totals rows,

■ Insert the value of a Subtotal field in the Subtotal rows,

■ Specify the font, font size, justification, and style for any text that 
appears in the report.

Adding Text

❿❿❿❿ To add text in a report cell:

1 Click twice on an empty cell in the quick report form.
A text insertion point appears in the cell.

If you are entering a label for a summary calculation, select a cell in the 
same row as the cell containing the calculation icons. You cannot enter 
text into the same cell that contains summary calculations.

2 Type the text in the cell. 

Modifying Text

❿❿❿❿ To modify text in a cell:

1 Double-click in a cell to get an insertion point and drag across the text 
in the cell you want to modify.
4th Dimension highlights the selected text.

2 Type the new text in the cell.
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Adding Columns In List mode, you create columns by dragging field names from the 
Fields list into the quick report area. If you want to add a field from a 
related table, expand the foreign key field in the hierarchical list of 
fields to display the fields in the related tables (if you have selected 
Related Tables or All Tables in the drop-down menu located just above 
the list). 
You can add fields from related tables, provided that the relationship is 
automatic. If you want to be able to use manual relations, check the All 
relations in automatic option: in this case, the editor changes all the 
relations of the database to automatic (cf.  “Interface” paragraph, 
page 142). 

Note You cannot add or edit a column in cross-table mode, since the report 
comes with all the needed columns.

❿❿❿❿ To add a field:

■ Drag the name of a field to the right of existing columns in the Quick 
Report area and release the mouse button.

OR
Double-click on the name of a field in the Fields list.

Note If you drag and drop a field onto an existing column, it will be replaced 
by the new column. 

4th Dimension creates a column for the field and places the field name 
in both the column header and the cell in the Header row. 

By default, 4th Dimension prints the field names as column heads at 
the top of each page in the quick report.

❿❿❿❿ To add a column using a menu command:

1 Select the Add... command in the Columns menu of the editor.
OR
Right-click (Windows) or Control+click (MacOS) over an unused area 
of the Quick Report area, then select the Add... command.

The standard 4th Dimension formula editor is displayed, allowing you 
to specify the data source of the new column (field or formula).
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Inserting Columns In List mode, you can insert an empty column into a quick report. 
After you insert the column, you can assign a field or a formula to it.

❿❿❿❿ To insert a column:

1 Select a column.

2 Choose Insert... from the Columns menu.

OR
Hold down the right mouse button (Windows) or Control+click 
(MacOS) to display the Quick Report contextual menu and choose 
Insert.

The standard 4th Dimension formula editor is displayed, allowing you 
to specify the data source of the new column (field or formula).
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Deleting Columns In List mode, as you specify fields for your quick report, you may want 
to remove some columns to place them elsewhere. Or, you might want 
to delete the column from the report.

❿❿❿❿ To delete a column using the Quick Report menu bar.

1 Select the column you want to delete. 

2 Choose Delete from the Columns menu.

OR

Right-click (Windows) or Control+click (MacOS) on the header of the 
column to be deleted, then select the Delete command from the 
contextual menu.

4th Dimension removes the selected column of the report. 

Replacing Columns In List mode, you can replace a column in the quick report by dragging 
another field over it. You can also replace a field with a formula and 
vice versa.

❿❿❿❿ To replace a column by a field:

1 Drag a field from the Fields list to the column you want to replace.
The replacement is instantaneous. If the previous field was designated 
as the sort level, the field that replaces it will also be substituted in the 
sort order list.
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❿❿❿❿ To replace a column using the formula editor:

1 Select the column you want to replace and choose Edit... from the 
Columns menu.
OR
Hold down the right mouse button (Windows) or Control+click 
(MacOS) on the header of the column to be replaced, then select the 
Edit... command in the contextual menu.
The standard Formula editor of 4th Dimension appears, allowing you 
to designate the new data source of the column (field or formula).

When you print the quick report, 4th Dimension will print the results 
of the formula for each record that appears in the Detail row. See the 
section “Associating Formulas to a Quick Report” on page 158 for 
information about adding a formula to a quick report.

Sizing Columns By default, the Quick Report editor sizes columns automatically, as 
reflected in the Automatic Width button. It sizes each column based on 
the maximum length of data displayed in the column and any labels 
typed into the column. The Quick Report editor sizes the columns at 
the time the report is printed. 
This operation is enabled for a column when the Automatic Width 
attribute has been associated with it. You can set and view the 
activation of this option in the Columns menu, in the contextual 
menu of the columns or using the corresponding button in the 
Columns toolbar:

To view the widths of each column, preview the report on the screen. 
See “Generating a Quick Report” on page 184 for more information 
about previewing the report. 

Because selecting the Automatic Width button or contextual menu 
item changes the width of a column based on the maximum width of 
data in the records being printed, selecting different records can 
change the size of the columns. 

You can resize a column manually, which automatically causes the 
deselection of the Automatic Width option (where applicable). 
When a column is set manually, text in the column wraps within the 
specified area.
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❿❿❿❿ To manually resize a column:

1 Select the column you want to resize.

2 Move the pointer over the column divider in the quick report to 
change the pointer into a column width cursor . 

3 Drag the column divider to the left or right to resize the column. 

Moving Columns In List mode, as you specify fields for your quick report, you may want 
to move some columns to place them elsewhere.

❿❿❿❿ To move a column using the Quick Report tool bar:

1 Select the column you want to move. 

2 Click the move icon to move it to the right or to the left: 

OR

3 Select Move right or Move left from the Columns menu to move the 
column as desired.
4th Dimension moves the selected column.

Associating 
Formulas to a Quick 
Report

You can add a formula to a column in a quick report. For example, you 
can add a formula that computes employees’ monthly salaries from an 
Annual Salary field.

❿❿❿❿ To associate a formula with a column:

1 Insert an empty column 
OR
Click an existing column and choose Edit... from the Columns menu.
OR
Double-click an existing column’s header. 
OR
Hold down the right mouse button (Windows) or Control+click 
(MacOS) on an existing column header to display the Quick Report 
contextual menu and choose Edit.
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4th Dimension displays the Formula editor, which you can use to build 
a formula. If you selected an existing column, the formula you create 
will replace the previous contents of the column.

Note Make sure that the formula you create does not change the current 
selection. Changing the current selection will cause problems when 
you print the quick report since the report is based on the current 
selection. For information about commands and functions that change 
the current selection, refer to the 4th Dimension Language Reference.

2 Build the formula by clicking on the fields, operators and commands, 
then enter the desired values in the editing area. 
OR
Click the Load... button to retrieve an existing formula from disk.
For more information about the formula editor, refer to the User Refer-
ence manual.

If you click the Load... button, 4th Dimension displays an open-file dia-
log box and asks you to select a file. When you load a file, it replaces 
any formula that currently appears in the Formula editor. After you 
load a formula, you can modify it in the editing area.

To save the formula as a file that you can retrieve and use in another 
column or in another report, click the Save... button and enter a file-
name in the dialog box.

3 Click OK to assign the formula to the column.
4th Dimension adds a new label to the column that identifies it as a 
formula. You can relabel the column by typing a label into the header 
cell for that column. The formulas are labelled C1 to Cn. These labels 
are the name of the variables containing the current value of the col-
umn. You can use these variables in other formulas.

Modifying the graphic attributes of a report
You can modify the graphic appearance of a quick report. The Quick 
Report editor lets you set the following attributes:

■ the character font, as well as its size, justification, style and color,

■ the background color of the cells,

■ the cell borders.
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In addition, 4th Dimension provides a set of predefined report 
templates that you can modify as desired. 

Note Appearance specifications are only taken into account for the “Printer” 
and “HTML File” output destinations (colors only). With other types of 
output, the formatting of reports must be carried out after the report is 
generated, using the receiving applications (4D View, 4D Chart or a 
text editor). For more information about report destinations, refer to 
the  “Generating a Quick Report” paragraph, page 184. 

Specifying 
Character Font, Size, 
Justification, Style 
and Color Attributes

While designing your quick report, you can specify different fonts, 
font sizes, justification, styles and colors. You can then apply these 
specifications to text, data, and summary calculations within rows, col-
umns, or cells in the quick report.

If you assign specifications to the Detail row of the report, you will not 
see the results until you preview or print the report.

You can specify font attributes using either the Quick Report menu 
commands or the Quick Report contextual menu.

❿❿❿❿ To specify a character font, font size, style, justification or color:

1 Hold down the right mouse button (Windows) or Control+click 
(MacOS) on the row label, column header, or cell to which you want 
to apply the font attributes.
A contextual menu appears.

2 Use the Font, Size, Style, Justification or Font Color submenus to 
change the font attributes as desired.
OR
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1 In the report, select the column, row or cell that you want to 
configure.

2 Choose a font in the drop-down font list and a size in the drop-down 
size list; then choose a style, justification and color in the Style toolbar:

Note You can also assign a style and justification using the Style menu. 

4th Dimension applies the parameters to the text, data or calculations 
included in the selected area.

Specifying the 
background color of 
cells

The Quick Report editor allows you to set a background color for each 
cell. You can set either a single color or two alternating colors, which 
provides better readability for tables. 

It is possible to set background colors for both List and Cross-table 
reports. 

Background colors are used with the “Print” and “HTML File” output 
destinations. 

❿❿❿❿ To set a background color:

1 Select a cell, column or row, then choose the main color in the 
“Background Color” palette of the toolbar:

You can assign any color combination that you want to the rows, cells 
and columns. 

Background 
Color palette
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2 (Optional) If you want to use an alternating background color, choose 
it using the “Alt. Background Color” palette:

The cells which have been assigned two alternating background colors 
will display both of them in the Quick Report editor. 

Here is an example of a generated report in List mode (preview) that 
has alternating background colors:

Alt. Background 
Color palette

Cell with an 
alternating back-
ground color
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Background colors are also taken into account in reports generated in 
HTML format:

Setting Borders You can set the borders for cells in both cross-table and list reports.

❿❿❿❿ To set the borders for a cell, a column or a row:

1 Highlight a cell, column or row, and either select Borders... in the 
contextual menu or from the Style menu.
The “Borders” dialog box is displayed:

Preview area

Shortcut buttons

Line thickness
selection area
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The preview area varies dynamically depending on the type of the 
selection: cell, column or row, but also whether a cell is in a list or 
cross table type report. For example, the behavior of the center cell in a 
cross-table report is different from the behavior of a detail cell in a list 
report. The center cell is repeated both horizontally and vertically for a 
cross-table report, whereas the detail cell in a list report is going to be 
repeated only vertically. Also, other cells may not be repeated at all 
(titles, for instance).

■ If the selected cell is a title cell (which is not repeated), the outer 
lines represent the outer lines of the cell:

■ If the selected cell is a detail cell in a List report (which is repeated 
vertically), the outer lines represent the outer lines of the cell repeti-
tion, and the inner horizontal line represents the border between 
two cells in the sequence:
164 4th Dimension User Reference



Modifying the graphic attributes of a report
■ If the selected cell is the center cell in a Cross-table report (which is 
therefore repeated both horizontally and vertically), the outer lines 
represent the outer lines of the repetition of cells, and the inner 
lines represent the borders between each cell generated from the 
center cell:

2 Select the line thickness and color to use:

You can use different colors for different borders.

3 Select the borders using either the arrows or the shortcut buttons.
You will notice that some shortcut buttons are disabled to match the 
type of the cell you are editing.

4 Repeat steps 2 and 3 for each border to be configured. 

5 Click OK to validate the changes.
OR
Click Revert to revert to the original border settings.
OR
Click Cancel to discard the changes and close the dialog box.
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Using a predefined 
report template

The Quick Report editor contains a set of predefined templates 
providing various graphic approaches for the production of printed or 
HTML reports. You can use all of the template as is or you can use it as 
a basis for constructing your own reports. A template can be applied at 
any time. 

A report template combines a set of graphic characters: font, colors, 
style, borders and justification. You can use either all or part of the 
template characteristics.

❿❿❿❿ To use a predefined template:

1 Choose the Presentation... command in the Style menu. 

The template selection dialog box appears:

2 In the list of predefined templates, click on the one that you want to 
use. 

List of predefined 
templates

Preview area for the 
selected template

Graphic options to be 
used or excluded
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You can preview each template in the right-hand area of the dialog 
box. Choose the template that best corresponds to your needs, keeping 
in mind that you can always modify your report subsequently. 

3 If you do not want to use all the graphic options set by the template, 
you can uncheck each option that you do not want to be taken into 
account. 
By default, all the options are selected. If, for example, you uncheck 
the “Border” option, the borders defined by the template will not be 
applied to your report. 

Note Only the “Color” option will be taken into account for reports whose 
output destination is an HTML file. 

4 Click on Apply. 
The selected characteristics are immediately applied to your report. If 
any graphic attributes were set previously, they will be replaced. 

Keep in mind that certain characteristics will be only visible once the 
report has been generated. 

Sorting Records
An important feature of the Quick Report editor is the ability to sort 
the records in your report. You sort records for two reasons:

■ To view records in a particular order,

■ To create groups of records and subtotal areas in the report for the pur-
pose of reporting summary calculations for groups.

Specifying a Sort 
Order for a List 
Report

You can specify a sort order at any time; simply drag and drop a column 
into the Sort order list. 
For example, if you wanted to sort the records of salespeople by the 
Sales Region field, you would drag and drop the Sales Region column 
into the Sort order area.

You can also sort on a formula by selecting the column that contains 
the formula and placing it in the Sort order list. See the section 
“Associating Formulas to a Quick Report” on page 158 for more 
information about adding formulas to quick reports.

You can sort a report on several levels. The order in which the fields 
and formulas appear in the Sort order list indicates the sort level. 
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❿❿❿❿ To specify the sort order using the field list:

1 Drag the Field you want to set as the sort level from the Fields list to 
the Sort order list.
OR
Highlight the field from the Field lists and click on the field insertion 
button:

The field is then added to the Sort order list.

By default, sorts are carried out in increasing order (a -> z). You can 
reverse the direction of the sort by clicking on the triangle next to the 
field in the Sort order list. 

Note If the sorted field has not already been inserted into a report column, 
an additional column is automatically created in the Quick Report 
area. 

❿❿❿❿ To specify a sort for a column (field or formula):

1 Select Report Columns from the table selection drop-down list.
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The list then displays the headers of the columns present in the report:

2 Drag the column that you want to set as the sort level and drop it in 
the “Sort order” list.
OR
Highlight the field from the Field lists and click on the field insertion 
button:

4th Dimension then displays the name of the column in the Sort order 
list:
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Changing the sort level

❿❿❿❿ To change the level of a sort:

1 Right-click (Windows) or Control+click (MacOS) on the field in the 
Sort order list in order to display the contextual menu:

2 Select Up or Down to move the field up or down (respectively) in the 
sort levels.

Deleting a Field or 
Formula from the Sort 
List

You can delete any field or formula from the Sort list.

❿❿❿❿ To remove a field or formula from the Sort order:

1 Select the field or formula to be deleted in the sort list and display the 
contextual menu using a right-click (Windows) or Control+click 
(MacOS):

2 Select Delete.
The level is then removed.
Note that the associated column is not removed from the report. On 
the other hand, the associated subtotal row disappears.
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Sorting the Cross-
Table Values

In a Cross-table report, the only values that can be sorted are the 
horizontal and vertical data sources (the two data sources that are used 
as categories in the final table).

❿❿❿❿ To sort the categories in a cross-table report:

1 Click the sort indicators in the Sort order area.
An arrow indicates the sort order specified:

To modify or delete the sort order of a data source, click on it again. 
The different possible reports appear successively. 

When no arrow is displayed, no sort order is selected. In this case, 
values will be displayed in the order they appear in the selection. 

Subtotal Levels In a quick report, you set break levels to separate or “break” records 
into groups according to values in one or more sort fields. A break area 
is printed at each break level. You can print summary calculations in 
the break area. The summary calculations — sum, average, minimum, 
maximum, and count — are calculated for each group of records. 

Break levels are determined by the sort levels and Break rows. For 
example, if you sort records by Sales Region, 4th Dimension inserts a 
break between each group of records that have the same sales region. 
These rows are automatically inserted when a sort is defined:
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After you add a subtotal row to the quick report, you can request sum-
mary calculations on each break. For example, you can insert a sum-
mary calculation in a subtotal row to display subtotals for sales from 
each state in a marketing region. Refer to the section “Adding Sum-
mary Calculations” on page 173 for more information about adding 
summary calculations to Subtotal and Total rows.

The label of a subtotal row indicates which change in value triggers the 
break.

Using the Values of 
Break Fields in 
Labels

You can improve the appearance and comprehensibility of your 
reports by labeling each Subtotal row using the value of the Break field.

To request that the value of a Break field be printed in a label placed in 
the Break area, use the number sign (#) in the label. For example, the 
text “Total salaries for department #” will insert the department name 
(in this case, the value of the Department field) in place of the number 
sign when the report is printed.

The number sign does not need to be placed in the same column as the 
Break field. It will display the value of the Break field in any cell in the 
Subtotal row.

The following figure illustrates the use of the number sign in a label in 
the Subtotal row.

Subtotal rows

Number sign 
used in label
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Adding Summary Calculations
You can add summary calculations on the contents of fields and 
formulas to each Subtotal row and to the Totals row. In a cross-table 
report calculations can be inserted in the center row.

The calculation buttons in the toolbars of the Quick Report editor 
identify the summary calculation options available for quick reports.

The following summary calculations are available.

■ Sum  totals the values in the report or break.

■ Minimum  displays the lowest value in the report or break.

■ Maximum  displays the highest value in the report or break.

■ Average  calculates the average of the values in the report or break.

■ Count  calculates the number of records in the report or break.

These options also appear in the Quick Report contextual menu for 
cells in the Subtotal and Total rows or, for a Cross-table report, in the 
total cells and the center cell.

■ List Reports
When you place a summary calculation in the Totals row, the calcu-
lation is done for all records in the report. If you place the summary 
calculation in a subtotal row, separate calculations are done for the 
records in each break.
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■ Cross-table reports
Summary calculations will apply as follows

❿❿❿❿ To add a summary calculation:

1 Select a cell where you want to insert the summary calculation.
The Sum, Minimum, Maximum, and Average calculations work only 
on a numeric field or formula. 

2 Click as many summary calculation buttons as you like. 
OR
From the contextual menu, choose the desired summary calculations.
4th Dimension displays a calculation icon in the selected cell for each 
type of summary calculation you request. The following figure shows 
calculation icons in the Subtotal and Total rows.

If you add more than one summary calculation to a cell, 
4th Dimension stacks the calculation icons on top of each other, as 
shown above.

Applies to values 

Applies to values

in each column

in both the last column
and last row

Applies to values 
in each row

Applies to each 
cell of the table

Calculation icon
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Adding Summary Calculations
Using Calculations 
and Column Values 
in Labels

You can insert summary calculations using the following codes. 

■ #S will be replaced by the sum in the sub-total or total row.

■ ##A will be replaced by the average.

■ ##C will be replaced by the count.

■ ##X will be replaced by the max.

■ ##N will be replaced by the min.

■ ##xx, where xx is a column number. This will be replaced by that 
column’s value, using its formatting. If this column does not exist, 
then it will not be replaced

These codes can be useful when you want to mix labels and data in a 
cell.

Displaying Repeated 
Values for Break 
Columns

In a report with subtotals, the columns which are used to group 
records so that summary calculations can be done are called Break 
columns. In the report shown above, the Department field is a Break 
column since the records in the report are grouped by department.

When a report like this is printed, the values for the Break column are 
printed only once per break. In other words, a department name is 
printed only for the first record in the group and is not repeated until 
the department changes.

In some cases, you may want to repeat the values for the Break col-
umns so that they appear for every record in the Break area. You do so 
by selecting the Repeated Values column property. This can be done 
either by clicking the Repeated Values button in the toolbars , by 
choosing the Repeated Values menu command in the Quick Reports 
contextual menu for that column, or by selecting Repeated Values 
from the Columns menu.

Non-repeating 
break values
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❿❿❿❿ To display repeated values for fields in a column:

1 Select the column by clicking the header row for that column and 
choosing the Repeated Values command in the Columns menu or 
clicking the Repeated Values button  in the “Columns” toolbar.
OR
From the contextual menu for that column, choose Repeated Values.

The following figure shows the report at the top of this page after the 
Repeated Values check box has been checked for the Department 
Name column.

Setting Display Formats
You can specify display formats for columns that contain numeric 
(integer, longint, real), alphanumeric (Alpha), date, time and picture 
data. 

For example, if you are displaying salaries in a column, you can add a 
numeric format to the Detail cell for the Salary field. The $###,##0.00;-
$###,##0.00 format places a dollar sign ($) to the left of the number 
and can display dollar amounts from -$999,999.99 to $999,999.99:

Break values 
(repeated)

Numeric format
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If your report includes Alpha fields such as a telephone number or 
Social Security number, you can use an Alpha format. If your report 
displays dates, times or pictures, you can also assign display formats to 
them.

4th Dimension provides different default display formats. However, 
you can create your own display styles for numeric and alphanumeric 
formats. For more information about this point, refer to the 
4th Dimension Design Reference manual.

Assigning the 
display format

You can associate a display format with a cell by selecting it in the 
contextual menu or by entering it directly in the cell. 

❿❿❿❿ To assign a display format to a numeric, Alpha, date, time or picture 
field:

1 Right-click (Windows) or Control+click (MacOS) on a cell of the 
column with which you want to associate a style.

The contextual menu of the editor appears.

2 Select the desired display format from the Format submenu:
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The contents of the submenu vary according to the type of data 
contained in the column: numeric, Alphanumeric, date, time or 
picture. If the report column contains data that cannot be formatted, 
the Format command does not appear in the contextual menu.

Note For more information about display formats, refer to the User 
Reference manual of 4th Dimension. 

The format is entered in the Detail cell. If you have also requested sum-
mary calculations for the column, the format specified in the Detail 
cell will automatically be applied to the summary calculations. The 
only exception is the “Count” calculation which is always displayed as 
an integer and does not accept any formatting symbols such as the dol-
lar sign.

You can also enter the formats to be applied manually by clicking 
twice in the cell and entering the elements of the format using the 
keyboard. 

Different formats can be applied to different columns in the report.

Hiding and Showing Rows and Columns
4th Dimension lets you hide rows or columns in a quick report in List 
mode. If desired, you can show a hidden column or row.

Hiding rows is useful when you want the report to include only sum-
mary calculations. For example, hide the Detail row if you want to dis-
play only the summary calculations that appear in the Totals and 
Subtotal rows. You can also use this feature to hide a Subtotal row or the 
Totals row.

You can hide a column if you need to use the column as a sort column, 
but do not want the report to display the column. 

You can hide/display a row or column using either a the Quick Report 
contextual menu, the Columns menu or the “Columns” toolbar.

Note You cannot hide a row or column in a cross-table report.
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Hiding and Showing Rows and Columns
❿❿❿❿ To hide a row or column:

1 Select the row or column you want to hide by clicking on its header.

2 Right-click (Windows) or Control+click (MacOS) on the header of the 
row or column to be hidden, then choose Hide in the contextual 
menu:

OR
Choose the Hide command in the Columns menu of the Quick Report 
editor. 

OR
Click on the button  of the “Columns” toolbar. 
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4th Dimension displays the column in gray to remind you that the row 
will not appear when you print or preview the quick report.

Showing a Hidden 
Row or Column

When a row or column is hidden, a check mark (√) is displayed next to 
the Hide menu command in the Columns or contextual menu. In 
addition, the corresponding button of the “Columns” toolbar is 
pressed in.

You can display a hidden row or column by choosing Hide again from 
either the Columns or contextual menu or by pressing the 
corresponding button in the “Columns” toolbar again. When you do 
so, the row or column is displayed normally in the Quick Report area.

Adding Page Headers and Footers
Before printing a quick report, you can add page headers and footers. 
You specify page headers and footers in the Headers and Footers dialog 
box. Use this dialog box to do the following:

■ Add page header and footer text or picture,

■ Specify the size of the page header and footer areas,

■ Use separate text for left, center and right parts of the header and 
footer. 

■ Specify fonts, font sizes, and font styles for page header and footer text,

■ Insert codes that add page numbers and the date and time to your 
reports.

Hidden row

Hidden column
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You can only specify page headers and footers when printing to a 
printer. However, once they are defined, they are kept with the report, 
even if the destination is modified. See the section “Generating a 
Quick Report” on page 184 for more information about alternate 
output destinations.

❿❿❿❿ To add page headers and footers:

1 Choose Header and Footer... from the File menu.
The Headers and Footers dialog box appears.

Note The preview area takes the print format configuration into account. 

The Headers and Footers dialog box lets you specify both headers and 
footers using the same screen. Use the Headers/Footers drop-down list 
to indicate the one you currently want to define.

2 Choose Headers or Footers from the selection menu.

Picture 
insertion 
area

Headers/Footers
 drop-down list

Text insertion 
area

Page preview 
area
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3 Enter the header or footer height in the Height area. 
When you first enter the dialog box, the header and footer heights are 
set to 25 points each. You can not only change these values, but can 
change the measurement scale to enter values in inches or centimeters 
as well.

As you enter the header and footer height, the lines on the page 
preview area change to indicate the size of the header and footer as 
they will appear in the printed report.

4 If you want to use a picture, paste it in the picture area (using 
standard copy-paste commands):

5 Select its alignment by clicking on the alignment icons:

6 If you want the height of the picture to become the height of the 
header/footer, click the Apply button:
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Adding Page Headers and Footers
7 Select an entry area and type the header or footer text.

To the right of each entry area, there are three buttons that let you 
enter variables into the entry area. 

You can insert the current page number, time of execution, or date of 
execution.

You can also use the code for the variables directly: #H for the time, #D 
for the date and #P for the page number.

8 Assign the font attributes for the header/footer.

9 Click OK to validate the changes.

Inserts the current time

Inserts the current date

Inserts the current page
number
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Generating a Quick Report
After you have completed your report design, you can “print” the 
quick report. You can print a quick report to a variety of output types:

■ On the standard printer selected,

■ To disk, in a Text file,

■ To a graph,

■ To a 4D View document,

■ To an HTML document.

❿❿❿❿ To select an output destination:

■ Choose Destination from the File menu. 

The Destination submenu contains five items.

Printer This option uses the printer you have chosen in your current print set-
tings. If you are printing to a printer, you can preview the report before 
printing it. 

❿❿❿❿ To print to a printer:

1 In the File menu, choose Printer from the Destination submenu.
This option is selected by default.

2 If necessary, select Page Setup from the File menu and specify your 
print parameters. 

Note This command is only available when the Printer destination is 
selected. 
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3 If you want to preview your report, select Print Preview... in the File 
menu. 

Note This command is only available when the Printer destination is 
selected. 

The print preview dialog box appears, containing the report that you 
have defined with the current data of the database. 

4 Select Generate... in the File menu. 

5 Choose the settings that are appropriate for your report and click the 
OK button. 

Disk File This option sends your quick report to a disk file that you can open 
and modify with other applications, including text editors and spread-
sheets. This option exports the records in the quick report to a text file.

When you use this option, 4th Dimension automatically uses the 
column headings as the first “record” that is exported.

❿❿❿❿ To generate the report in a Text file:

1 In the File menu, choose Disk File from the Destination submenu.

2 Choose Generate... from the File menu. 
4th Dimension displays a standard create-file dialog box and asks you 
to enter a filename. 

3 Enter a filename and click OK.
4th Dimension displays a dialog box that keeps you informed of the 
progress of the operation.

After the report is printed to a file, 4th Dimension returns you to the 
Quick Report editor. Remember to change the output device if you 
want to resume sending a quick report to a standard printer.

Print to Graph This option directs the report to 4D Chart, 4th Dimension’s plug-in for 
plotting data. When you choose the Graph item in the Destination 
submenu, your report is presented as a graph rather than in table form. 
Your graph can then be printed using 4D Chart.
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■ In list mode, 4D Chart uses only the summary calculations and labels 
in the Subtotal row. It uses the leftmost non-numeric column for the 
Categories axis (the horizontal axis). To use the Graph feature, your 
report should:

■ Include from one to five numeric fields or formulas. These columns 
will be assigned to the values axis in the graph.

■ Use one type of summary calculation per numeric field.

For example, if you want to graph the average salary by department, 
you should create a quick report with two columns, Department Name 
and Salary as well as a Subtotal row consisting of the Average summary 
calculation for Salary:

■ In cross table mode, 4D Chart uses two data sources and the value cell. 
The last row and column are ignored.
For example, if you want to show the amount of sales per country for a 
set of products, you can define the following report:

❿❿❿❿ To print to a graph:

1 In the File menu, choose Graph from the Destination submenu.

2 Choose Generate... from the File menu. 

Value to be
represented graphically

Value to be represented 
graphically (Z axis)

Series (Y axis)

Elements (X axis)
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■ For list reports, 4th Dimension graphs your data as a 2D column 
graph.

■ For cross-table reports, 4th Dimension graphs the data as a 3D 
column graph:

You can use 4D Chart to select another graph type or print the graph. 
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Printing to a 4D 
View Document

This option directs the report to 4D View, 4th Dimension’s plug-in for 
displaying data. When you choose the 4D View item in the 
Destination submenu, your report is presented as a 4D View window 
rather than in table form. 4D View uses all the data in the report.

Note The 4D View destination is only available if this plug-in is installed in 
your 4th Dimension environment and if you have the appropriate 
licenses. 

❿❿❿❿ To generate a report in a 4D View document:

1 In the File menu, choose 4D View from the Destination submenu.

2 Choose Generate... from the File menu. 
4th Dimension creates a 4D View window containing the data. You can 
modify its contents, print it or save it using the 4D View menu com-
mands. 

Printing to an HTML 
Document

This option sends your quick report to an HTML file. When you 
choose this option, it uses the default HTML template unless it was 
changed programmatically.

When you use this option, 4th Dimension automatically uses the 
column headings as the first “record” that is exported.

❿❿❿❿ To print to an HTML file:

1 In the File menu, choose HTML File from the Destination submenu.

2 Choose Generate... from the File menu. 
4th Dimension displays a standard create-file dialog box and asks you 
to enter a filename. 

3 Enter a filename and click OK.
4th Dimension displays a dialog box that keeps you informed of the 
progress of the operation.

After the report is printed to an HTML file, 4th Dimension returns you 
to the Quick Report editor. Remember to change the output device if 
you want to resume sending a quick report to a standard printer.
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9 Labels

4th Dimension’s Label editor provides a convenient way to print a wide 
variety of labels. 

With the Label editor, you can do the following:

■ Design labels for mailings, file folders and file cards, and for many 
other needs

■ Specify the font, font size, and style to be used for the labels

■ Specify the number of labels across and down on each page

■ Specify the label page margins

■ Load and save label designs

■ Print labels

Labels can also be created using the Form editor in the Design 
environment. Use the Form editor to design specialized labels that 
include variables or take advantage of the drawing tools available in 
the Form editor. For more information about using the Form editor to 
create labels, refer to the 4th Dimension Design Reference manual.

The Label Wizard
You use the Label Wizard to create, format, and print labels in the User 
environment. The Label Wizard contains settings for designing labels 
and positioning the labels on label paper. For example, when produc-
ing mailing labels, you might want a label design that includes the per-
son’s first and last name on the first line, the street address on the 
second line, and so on.
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As part of the design, the Label Wizard enables you to specify the num-
ber of labels on the page and the margins of the label paper so that the 
label text is centered within the labels.

The Label Wizard consists of two pages, the Label page and the Layout 
page, each identified by a tab at the top of the dialog box. You use the 
Label page to specify the content of the label and the Layout page to 
define the size and position of the labels on the page. When you create a 
satisfactory label design, you can save it to disk so that you can reuse it.

Opening the 
Label Wizard

To open the Label Wizard:
Choose Labels from the Report menu.
4th Dimension displays the Label page of the Label Wizard. 

Label Page The Label page contains settings for designing and formatting labels.

The Label page contains the following elements:

■ Fields list  This area displays the names of the fields in the current table 
in a hierarchical list. If this table is related to other tables, the foreign 
key fields have a plus sign (on Windows) or an arrow (on Macintosh). 
You can display fields from the related table by expanding the relating 
fields. The fields in the related table are indented. 

Toolbar

Text attributes 
areas

Label preview 
area

Fields list

Object Look 
area

Form to Use 
drop-down list

Static text 
entry area

Default Look button
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The Label Wizard
Note Only tables and fields which are visible appear in the Label Wizard. For 
information about making tables and fields invisible, refer to the 
4th Dimension Design Reference manual.

■ Label preview area  You use this area to design your label.

■ Toolbar  The Label Wizard toolbar contains tools for drawing, select-
ing, aligning, distributing, layering, and duplicating objects. For com-
plete information on the toolbar, see the section “The Label Wizard 
Toolbar” on page 192.

■ Object Look area  These controls let you specify foreground and 
background colors, fill patterns, and borders for individual objects on 
the label.

■ Default Look button  This button applies the default set of Object Look 
attributes to the selected object.

■ Static Text entry area  This area allows you to add static text objects to 
the label.

■ Text attributes areas  These controls allow you to specify the font, font 
size, display format, and style of the text. 

■ Form to Use drop-down list  This drop-down list lets you bypass the 
Label Wizard and use a form to print the labels. If you are using the 
Label Wizard to create the label, choose No Form (the default) from 
this list. If you want to use a form, choose it from this list. 
4th Dimension will then ignore any other label specifications in the 
Label Wizard and print the labels according to the design or the 
specified form. As with any print job, it executes any form or object 
methods associated with the form. See the 4th Dimension Design 
Reference manual for more information about designing forms for 
labels.

Layout Page The Layout page contains controls for printing labels based on the 
requirements of the printer you selected in the Print Manager (Chooser 
on Macintosh), so that it can format the page accurately.

For complete information on the Layout page, see the section 
“Specifying the Label Layout” on page 203.
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The Label Wizard 
Toolbar

The Label Wizard toolbar contains the following tools.

Creating a Label Design
You create a label by dragging field names to the Label Preview area, 
adding static text, drawing graphic objects using the graphics tools in 
the toolbar, and pasting graphics from the Clipboard. You can edit the 
label by distributing, moving, resizing, layering, and aligning objects. 
With the Object Look and Text attribute areas, you can control the 
font attributes, foreground and background colors, fill patterns, and 
borders of individual objects.

The Label Preview area shows the approximate size and shape of the 
selected label. Before adding elements to the label, you may want to 
specify your label paper and label dimensions using the Layout page. 
For information, see the section “Specifying the Label Layout” on 
page 203.

Note You cannot add a formula (a variable) to a label with the Label Wizard. 
If you need to use a variable on a label, use the Form editor.

❿❿❿❿ To create a label:

1 Drag the first field you want to display in the label from the Fields list 
to the Label Preview area.
If the field is in a related table, expand the relating field to display the 
fields in the related table.

Drawing tools

Rectangle
Rounded Rectangle
Oval
LIne

Alignment Tools

Move to Front
Move to Back

DuplicateArrow tool

Align Right
Align Left
Align Bottom
Align Top
Align Horizontal Center
Align Vertical Center

Distribute Vertically
Distribute Horizontally
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Creating a Label Design
Your field is added to the Label Preview area. Selection handles indicate 
that it is selected. 

2 If you want to concatenate a field to this field, drag the new field from 
the Field list to the existing field.
OR
If you want to concatenate two fields using the Carriage return as the 
separator, drag the new field by holding down the Shift key.
OR
Otherwise, continue dragging fields to the Label Preview area.

■ When you concatenate two fields by simply dragging and dropping 
them, the separator used is the one defined in 4th Dimension’s 
resources. By default, the Space character is used. A “+” between 
field names in a field object indicates that the fields are concatenated on 
a single line. When 4th Dimension prints the label, it will insert a space 
between the fields on the same line. The following illustration shows the 
concatenation of the First Name and Last Name fields.

■ If you concatenate two fields by dragging and dropping the second 
field while holding down the Shift key, the Carriage return is used 
as the separator. When the labels are being printed, if the second 
field is empty, its position is deleted and is replaced by the next 
field. If a field contains some text with Carriage returns, they are 
taken into account. 
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For example, this feature allows you to create address labels by 
using many concatenated fields ([Clients]Address1, [Cli-
ents]Address2, etc.) without generating an empty line when a field 
is blank.
You can automatically resize a group of concatenated fields so that 
it corresponds to the number of lines that it contains. To do so, 
Ctrl+click (Windows) or Command+click (MacOS) on the lower right 
handle of the group.

As you add fields, you can reposition them by dragging or using the 
alignment tools in the toolbar. 

3 To add a text element to the label, enter the text in the Static Text 
area and click the arrow . 
The static text object is added to the Label Preview area. The following 
illustration shows a static text element being added to the label. 

After you add the element to the label, you can reposition it by drag-
ging and aligning it with other objects.

4 (Optional) Using a drawing tool, draw any graphic objects that you 
want to add to the label.
For example, you could add different backgrounds to the “TO:” and 
“FROM:” sections of the label.

5 (Optional) Paste a graphic from the Clipboard into the Label Preview 
area.
For information on adding a graphic to the label, see the section 
“Adding a Graphic to the Label” on page 202.

After you add all required elements to the Label Preview area, you can 
use any of the editing tools to modify the label design. For complete 
information, see the section “Working with Label Wizard Objects” on 
page 195.

How the Label Wizard 
Handles Blank Fields

Some records in your database may not contain entries for every field. 
When printing labels, the Label Wizard handles blank fields intelli-
gently. Instead of leaving gaps where the data should be, the Label 
Wizard concatenates the data.

If a field in a line contains no data for a particular record, 4th Dimension 
concatenates the remaining fields in the line without leaving a blank 
space for the missing data.
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If an entire line contains no data for a particular record, 4th Dimension 
vertically concatenates the remaining lines in the label without leaving 
a blank line.

4th Dimension automatically centers the text of the label inside the 
label area.

Clearing Fields If you make a mistake, you can remove one or more fields from the 
label. 

❿❿❿❿ To remove an object:

1 Select the object and press Backspace (Delete on Macintosh).

The selected object is removed. If the object is a row of concatenated 
fields, pressing Backspace removes only the last field in the row. Con-
tinue pressing Backspace to remove more fields from the row.

Working with Label Wizard Objects
This section discusses the techniques for editing objects placed on the 
label. It includes:

■ Creating graphic objects,

■ Aligning objects,

■ Distributing objects,

■ Layering objects,

■ Duplicating objects,

■ Moving objects,

■ Resizing objects,

■ Adding a border to an object,

■ Adding foreground or background fill colors, patterns, and borders,

■ Pasting a graphic into the label,

■ Deleting objects.
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Creating Graphic 
Objects 

You can create a graphic object by drawing.

❿❿❿❿ To create an object:

1 Select the type of object you want to draw by clicking its tool in the 
toolbar.
The pointer becomes a crosshair when it is over the Label Preview area. 

2 Drag to create an area for the object.
For two-dimensional objects (ovals, rectangles, and rounded rectan-
gles), drag diagonally. 

Note Hold down the Shift key as you draw to constrain the object to a regu-
lar shape. Lines are constrained to horizontal or vertical, rectangles are 
constrained to squares, and ovals are constrained to circles.

3 When you have finished drawing the object, release the mouse 
button.
4th Dimension creates the object and makes it the currently selected 
object. The Arrow tool is automatically selected and the pointer 
becomes an arrow.

Aligning Objects The alignment tools let you align objects to each other. When you 
align one object to another, you can align it to the top, bottom, side, 
or horizontal or vertical center of the other object. 

The following illustration shows the Label Wizard’s alignment tools.

1) Select that 
drawing tool 
you want to use

2) Drag to draw 
the objects

Align Right

Align Bottom

Align Left

Align Top

Align Center Vertical

Align Center Horizontal
196 4th Dimension User Reference



Working with Label Wizard Objects
The arrangement of lines represents the function of each tool. For 
example, the Align Right icon shows the lines aligned vertically on the 
right side of the box. The Align Center Vertical icon shows the lines 
aligned vertically in the middle.

❿❿❿❿ To align a set of objects:

1 Select the objects that you want to align.
Shift-click to select several objects.

2 Click the alignment tool that corresponds to the alignment you want.
4th Dimension aligns the selected objects according to the alignment 
you selected.

Distributing Objects The toolbar includes two tools that let you distribute three or more 
objects evenly.

When you use either tool, you can modify its action by holding down 
the Shift or Alt keys when you click either tool. 

■ Clicking  Distributes the objects from their adjacent sides,

■ Shift+Clicking  Distributes the objects from their left sides (horizontal) 
or tops (vertical),

■ Alt+Clicking  Distributes the objects from their right sides (horizontal) 
or bottoms (vertical),

■ Shift+Alt Clicking  Distributes the objects from their centers.

Distribute vertically Distribute horizontally
1974th Dimension User Reference



Chapter 9  Labels
These rules are illustrated in the following diagram. 

❿❿❿❿ To distribute a set of objects:

1 Select the objects that you want to distribute.
You must select at least three objects. Hold down Shift and click to 
select several objects.

2 If desired, hold down a modification key or key combination and click 
the Distribute Horizontally or Distribute Vertically tool.
4th Dimension distributes the selected objects according to the rules 
you selected.

Layering Objects You may want to create a design that uses objects in different layers. 
For example, you may want to place a shaded rectangle behind the 
fields on a label. The Label Wizard provides the Move to Back and 
Move to Front, tools that let you layer objects on the label. 

Click Shift+Click Alt+Click (Windows)
Option+Click (MacOS)

Shift+Alt+Click (Windows)
Shift+Option+Click (MacOS)

Distribute 
Vertically

Standard Tops Bottoms Centers

Action 

Standard Left Sides Right Sides CentersDistribute 
Horizontally 
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The following illustration shows objects in front of other objects.

Clicking the Move to Front or Move to Back tools moves the selected 
objects to the top or bottom layer. If you want to move the object only 
one layer toward the front or back, hold down the Shift key when you 
click Move to Front or Move to Back.

❿❿❿❿ To move an object to the front or back:

1 Select the object or objects that you want to move to the back.
Hold down Shift and click to select several objects.

2 Click the Move to Front or Move to Back tool in the toolbar.
4th Dimension moves the selected object or objects to the front of or 
behind all the other objects.

Note When you move an object to the back, it may be hidden by objects in 
front of it. To see the object, select the object in front and send it to the 
back.

Duplicating Objects You can duplicate any object in the label. Copies of active objects 
retain all the properties of the original, including foreground and back-
ground colors and fill patterns, text attributes, and display format.

❿❿❿❿ To duplicate an object:

1 Select one or more objects.
Hold down Shift and click to select several objects.

2 Click the Duplicate tool in the toolbar.
4th Dimension duplicates the selected object or objects.

Moving Objects You can move objects by selecting them and dragging with the mouse. 
You can also use the arrow keys to move the object one or ten pixels at 
a time.

■ To move an object one pixel at a time, select the object and press an 
arrow key.

Fields in front of 
shaded rectangle
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■ To move an object ten pixels at a time, select the object, hold down the 
Ctrl key (on Windows) or Command key (on Macintosh), and press an 
arrow key.

Resizing Objects You can resize any object on the label by selecting it and dragging a 
selection handle. 

❿❿❿❿ To resize an object by dragging:

1 Select the object you want to resize.

2 Move the pointer over one of the four handles that appear on the 
selected object.
The pointer changes into a multi-directional arrow  and the handles 
disappear.

3 Drag the handle toward the center of the object to shrink it. 
OR
Drag the handle away from the object’s center to enlarge it.
4th Dimension resizes the object.

Adding a Border to 
an Object 

You can add a one-pixel border to an object. The border can be from 
one to nine pixels from the object.

❿❿❿❿ To add a border:

1 Select the object.
The selected object is indicated by selection handles.

2 Hold down the Ctrl key (Command key on Macintosh) and press a 
number from 1 to 9 on the numeric keypad.
A border is added to the object. The distance from the object (in pixels) 
is controlled by the number you pressed. The following illustration 
shows the results of pressing Ctrl+1.
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Adding Foreground 
or Background 
Colors

4th Dimension lets you add colors to objects for display on a color 
monitor or (if your printer supports color) for color printing. By com-
bining selected colors with fill patterns, you can display thousands of 
different color shadings.

Note Colors appear black and white on a black and white monitor. They 
appear as shades of gray on a gray-scale monitor. The color palettes 
display shades on a gray scale monitor.

You can specify different colors for foreground pixels (pixels that appear 
black on a black-and-white monitor) and background pixels (pixels that 
appear white on a black-and-white monitor). If the object is a field or 
static text, the foreground color controls the color of the text and the 
background color controls the color of the object’s rectangle.

You set foreground and background colors using the Background and 
Foreground picture menus in the Object Look area of the Label Wizard.

If your monitor supports 16 colors, choose the colors from the first 16 
colors on each palette. If your monitor supports 256 colors (or more), 
any colors you choose will display properly.

Setting Fill Patterns You can apply a fill pattern to any two-dimensional graphic object in 
the form such as an oval, a rectangle, a line, the enclosed area of a field 
or static text object, and a two-dimensional object’s border. 

The Fill picture menu controls the fill pattern for the selected object. 
The Border picture menu controls the fill pattern for the border.

Setting Border 
Patterns

You can set patterns for the borders of any object in the form that has a 
border such as an oval, a rectangle, and a grid object. The border 
patterns available are the same as the fill patterns. The appearance of 
the border also depends on the line width you have specified for the 
border.

The following illustration shows a fill pattern applied to the upper 
rectangle and a border fill pattern applied to the bottom rectangle.
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Setting Line Width The Line Width pop-up menu controls the width of a line or the width 
of the border of a two-dimensional object.

To set a line width, select the object and choose a line width from the 
Line Width pop-up menu.

Restoring the 
Default Look

When you add an object to the label, it takes on the Object Look 
attributes of the most recently created object. If you want to assign the 
default Object Look attributes to this object (or any object), select the 
object and click Default Look. The foreground and background colors, 
fill patterns, and border width are reset to the default settings.

Adding a Graphic to 
the Label

In addition to the drawing tools in the toolbar, you can paste a graphic 
from the Clipboard into the label. 

❿❿❿❿ To paste a graphic into the label:

1 Place the graphic on the Clipboard.

2 Choose Paste from the 4th Dimension Edit menu or press Ctrl+V 
(Command–V on Macintosh).
The graphic appears in the Label Preview area with selection handles. 

You can then move, align, distribute, or resize the object like any other 
object.

Deleting Objects You can delete the selected object by pressing the Backspace key 
(Delete key on Macintosh). If the selected object contains concate-
nated fields, the last field is removed is removed from the object. If you 
want to delete the entire object, continue pressing the Backspace or 
Delete key.
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Specifying the Label Layout
You specify the label layout with the Layout page of the Label Wizard. 
You can display the Layout page at any time by clicking its tab.

The Layout page contains the following elements:

■ Orientation and Labels Order buttons  These buttons enable you to 
specify the page orientation and the order in which information is 
assigned to labels. Keep in mind that the orientation of the sheet is 
independent from that of the page. If you modify this parameter, be 
sure to change the configuration of the page accordingly in the 
standard print setup dialog box.

■ Labels across and down boxes  These boxes are used to control the size 
of labels by specifying the number of labels that appear on your label 
paper.
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■ Layout preview area  This area provides a reduced view of how an 
entire page of labels will look, based on the dimensions you enter in 
the Label Wizard. The page preview also reflects the paper size selected 
in the Print Setup dialog box. You can also select the first label on the 
page to be printed. The red border indicates the size of the physical 
page and the blue border indicates the size of the printable area.

■ Label Size and Page Size radio buttons  These buttons are used to 
select the label or the page for setting label and page dimensions. If 
you click Label Size, you can enter the label width and label height in 
the appropriate areas. If you click Page Size, you can enter values for 
right margin and bottom margin, as shown below.

■ Margin boxes  These boxes are used to specify the dimensions of the 
label and the page size, depending on the radio button you select. After 
you have entered the margins of your label paper, you may need to 
make some additional adjustments so that the label text is centered in 
the labels. You can use both positive and negative numbers in the 
Margin boxes to increase and decrease the margins.

■ Automatic Resizing  If Automatic Resizing is checked, the values in the 
Label Width and Label Height entry areas are set automatically.

■ Horizontal Gap  This area controls the amount of space between label 
columns.

■ Vertical Gap  This area controls the amount of space between label 
rows.

■ Unit drop-down list  This drop-down list allows you to change the 
units in which you specify your label and label page measurements. 
You can use pixels, millimeters, centimeters, or inches. 
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■ Labels per record drop-down list  This control lets you print more 
than one copy of each label. If you print more than one copy, 
4th Dimension prints the copies consecutively rather than making 
copies of the label pages.

■ Standard Code drop-down list  This control lets you specify the label, 
page dimensions, and margins by choosing a standard commercial 
label paper from the drop-down list.

■ Method to apply  This control lets you choose a method that will be 
run at print time. For example, you can execute a method that posts 
the date and time that each label was printed.

■ Apply Once radio buttons  These radio buttons are used to specify 
whether to run the method once per label or once per record. this 
control has meaning only if you are printing more than one copy of 
each label and you are also executing a method at print time.

■ File buttons  These buttons provide options for page setup, printing, 
saving, and loading label designs.

❿❿❿❿ To specify the layout of the label sheet you are using:

1 Click the Layout page tab.
The Layout page of the Label Wizard appears.
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You can specify the design of the label sheet using the entry areas on 
the Layout page or choose a standard design from the Standard Code 
drop-down list. This drop-down list contains specifications for a wide 
variety of standard commercial label sheets.

2 Click the Print Setup button.
The Print Setup dialog box for your operating system appears. 

3 Choose the desired printer and click OK.
If necessary, the Label Preview area changes to reflect your selection.

4 If appropriate, choose the type of label paper you are using from the 
Standard Code drop-down list.
The remaining entry areas on the page change to reflect the selected 
label paper’s characteristics. If necessary, you can modify these specifi-
cations.

5 Click the appropriate Orientation and Labels Order radio pictures.
You can choose between portrait and landscape orientation and 
horizontal or vertical order. Remember that the orientation of the sheet 
is independent from that of the page. If you modify this parameter, be 
sure to change the configuration of the page in the standard print 
setup dialog box.

6 Enter the number of labels in each row of your label sheet in the 
Labels Across box and the number of labels in each column in the 
Labels Down box.
The Label Preview area adjusts to display the appearance of the labels 
on a printed page.

7 If the first sheet of label paper is partially used, click on the first blank 
label in the Label Preview area.
206 4th Dimension User Reference



Specifying the Label Layout
4th Dimension will begin printing labels on the label you indicated. 
The following illustration shows the Preview area after clicking on the 
second label area.

8 If desired, choose a unit of measurement from the Unit drop-down list 
to use for entering margin sizes.

9 Enter values to reflect the margins on your label paper.

Use the Label Size and Page Size radio buttons to control whether you 
use the entry area for the size of the label or the size of the page.

The size of the individual labels in the label page preview will adjust to 
accommodate the margins. For example, if you increase the size of 
your margins to two inches, top and bottom, the size of the individual 
labels will shrink to maintain the same number of labels that you 
specified earlier.

Because some printers use portions of the margin to hold the label 
sheet in place, the printer may not take the full margins into account 
when printing your labels. In this case, you may need to adjust the 
margin settings so the label text is properly centered in each label. 
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Since the printer uses part of the margins, the printer begins measuring 
the margins from a point that is not precisely at the edge of the label 
paper. When the labels are printed, the label text may appear skewed 
to the right or to the bottom of the label paper.

To compensate for this lost margin space, you can use negative num-
bers in some of the margin boxes. When placed in the Right margin 
box, negative numbers pull the label text to the right. When entered in 
the Top margin box, negative numbers pull the label text toward the 
top of the page. 

Note As a rule, using a negative number in a margin box moves the label 
text toward the margin you are setting.

10 (Optional) If you want to print more than one copy of each label, use 
the Labels per Record drop-down list to choose the number of copies 
to print.
The copies are printed consecutively on the label paper. 4th Dimension 
does not duplicate the entire label page.

11 (Optional) If you want to run a method when the labels are printed, 
choose the method from the Method to Apply drop-down list.

12 (Optional) If you are running a method and printing more than one 
copy of each label, click either the Once Per Record or Once Per Label 
radio button in the Apply Once area.
This control has no meaning unless you are using both the multiple 
copies and method features.

Saving and Loading Label Designs
4th Dimension lets you save each label design as a file that you can 
open from the Label Wizard. By saving label designs, you can maintain 
a library of labels that you can use according to your needs. 
Label designs store the parameters set on the Label and Layout pages. 

Saving a Label Design To save a label design:

1 Click the Save button. 
4th Dimension displays a dialog box where you can enter a file name 
for the label design. 

Note Label files on Windows are denoted by the file extension .4LB. 
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2 Enter a filename for the label design and click the Save button.

Loading a Label Design You can load the label design whenever the Label Wizard is active.

❿❿❿❿ To load a label design:

1 Click the Load button.
4th Dimension displays an open-file dialog box where you can select 
the filename of a label design. Double-click the filename or select the 
filename and click Open. 

4th Dimension replaces the current label design with the design you 
selected.

Printing Labels
After you have completed your label design, you can preview or print 
the labels. You may want to print first on regular paper so that you can 
check the placement of text before you use the more expensive label 
paper.

❿❿❿❿ To print your labels:

1 Click the Print button.
The Print dialog box appears for the printer you selected in the Print 
Manager. If you check the Print Preview check box before clicking OK, 
the labels are previewed to screen.

If you are printing using a form, 4th Dimension will use the selected 
form to print the labels. 4th Dimension assumes that the form was 
designed to print labels.

After the labels are printed, 4th Dimension closes the Label Wizard and 
returns you to the form you were using when you opened the Label 
Wizard.
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4th Dimension allows you to create a wide variety of two- and three-
dimensional plots without having to export the data to a graphics 
package. You can create graphs from the data in your database or from 
data that has been copied to the Clipboard from another application. 
You can graph data directly from fields or you can graph the results of 
calculations on data. You create graphs in 4th Dimension using the 
built-in 4D Chart plug-in. 

Because graphing capability is fully integrated into 4th Dimension, you 
can graph data in your database and update your graphs when the 
information in the database changes. You can print your graphs or 
copy them to the Clipboard and paste them into other applications.

Finally, 4D Chart adds over 100 commands to the 4th Dimension 
language which enable you to control tasks that you normally perform 
manually. For example, you can use 4D Chart commands to create new 
graphs, modify graph features, open and save documents, and execute 
any 4D Chart menu command. For information on these commands, 
please refer to the 4D Chart Language Reference manual.

Managing 4D Chart Documents and Windows
4D Chart documents can be created in plug-in areas on forms or in 
separate plug-in windows. This section explains how to create, open, 
and save 4D Chart documents in both types of areas.

This section explains the basics of managing 4D Chart documents, 
including:

■ Using 4D Chart in a plug-in window

■ Using 4D Chart in a 4th Dimension form
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■ Hiding and showing 4D Chart features

■ Creating a new document

■ Opening an existing document

■ Saving a document

■ Setting the document size.

Using 4D Chart in a 
Plug-in Window

You can use 4D Chart in its own window. When used in its own win-
dow, 4D Chart operates as if it were a separate application.

When you open 4D Chart in a plug-in window, the window has its own 
menu bar. 4th Dimension’s menu bar remains at the top of the screen.

When you expand the window to full screen size by clicking the win-
dow’s zoom box, 4th Dimension’s menu bar remains at the top of the 
screen and 4D Chart’s menu bar remains within the 4D Chart window.

Opening 4D Chart in a 
Plug-in Window

The 4D Chart command appears automatically as an item in the Plug-
ins menu. If you have installed additional plug-ins that can be accessed 
in their own windows, they appear in the same menu. 

❿❿❿❿ To open 4D Chart in its own window:

1 In the User environment, choose 4D Chart from the Plug-ins menu.

A new 4D Chart document opens in its own window. 

You can open additional 4D Chart windows by choosing 4D Chart 
again from the Plug-ins menu. Opening several 4D Chart documents at 
the same time allows you to compare documents, copy and paste 
between documents, and move from one document to another simply 
by clicking in the appropriate window.

Title bar

Document area

Zoom box

4th Dimension 
menu bar

4D  Chart menu bar
Close box

Object Tool palette
Graph Tool palette
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The titles of all 4D Chart windows appear at the bottom of the Plug-ins 
menu. You can bring any document to the front by choosing it from 
the Plug-ins menu.

When you save a document, its title bar displays the document name, 
plus the suffix “(CT)”, which distinguishes 4D Chart

 

 

 

documents from 
documents created by other plug-ins. 

You can close a plug-in window at any time by clicking the window’s 
control-menu box (on Windows) or the close box (on Macintosh).

 

Using 4D Chart in a 
Form

 

You can place a 4D Chart area in any form. When you use 4D Chart in 
an input form, you can display a graph for each record in the table. 
You can also use a 4D Chart area in an output form.

When 4D Chart is used in a form, the 4D Chart menu bar appears at 
the top of the 4D Chart area. You can choose menu commands from 
either the 4

 
th

 
 Dimension menu bar or the 4D Chart menu bar. 

����

❿❿❿❿

 

To expand a 4D Chart area: 

 

1 Choose Go to Full Window from the 4D Chart File menu. 
OR
Click the 4D Chart area’s zoom box. 

 

The document expands to fill the entire screen, and 4D Chart’s menu 
bar temporarily replaces 4

 

th

 

 Dimension’s menu bar.

4D Chart area

4D  Chart menu bar
4D  Chart zoom box
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The expanded window has a size box and close box. 

When the document window is expanded, the 

 

Go to Full Window

 

 
menu item in the File menu changes to 

 

Return to Form

 

.

����

❿❿❿❿

 

To reduce the window and return to the form:

 

1 Choose Return to Form from the File menu.
OR
Click the close box.

Creating a 4D Chart 
Area in a Form

 

You can add a chart area on an input form and save a chart with each 
record in the table.

For more information about inserting a plug-in area into a form, refer 
to the 

 

4th Dimension

 

 

 

Design Reference 

 

manual.

 

Hiding and 
Displaying 4D Chart 
Features

 

You can choose to hide or display several of 4D Chart’s features, 
including:

 

■

 

The 4D Chart menu bar

 

■

 

The Object Tool palette

 

■

 

The Chart Tool palette

 

■

 
Scroll bars

 

■

 
Rulers
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            ����   
    

Use the 

 

Display submenu of the Edit menu of the plug-in area to hide 
or display these items. Items that are checked in the Display submenu 
are displayed in 4D Chart.

Note If you have hidden the 4D Chart menu bar, you can display it by 
pressing Ctrl-Shift-M on Windows or Command-Shift-M on Macintosh.

Creating a New 
4D Chart Document

You can create a new, blank 4D Chart document at any time. The new 
document replaces the current document. If you have made changes to 
the current document, you will be prompted to save them before open-
ing a new document.

❿❿❿❿ To create a new document:

1 Choose New from the 4D Chart File menu.

An empty document appears in which you can create a new graph.
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Opening a 4D Chart 
Document

You can open any previously saved 4D Chart document in a 4D Chart 
area. The newly opened document replaces any current document. 

❿❿❿❿ To open a 4D Chart document:

1 Choose Open from the 4D Chart File menu.

A standard open-file dialog box appears. 

2 Select a document.

3 Click Open.
The document opens in the current 4D Chart window.

Note You can also open a PICT file in your chart. This point is covered in the 
paragraph “Importing a PICT document in a 4D Chart window,” 
page 219.

Saving a 4D Chart 
Document

You can save the contents of a 4D Chart document regardless of 
whether the document was created in a plug-in window or in a form. 
4D Chart offers several ways to save documents:

■ As a file

■ As part of a record

■ As a template for a 4D Chart area

You can also save a selection of objects, for instance a graph, as a PICT 
document (Macintosh format). In this case, the document saved is a 
picture that can no longer be modified. This point is covered in the 
paragraph “Exporting a 4D Chart document in PICT form,” page 220.
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Saving a 4D Chart 
Document as a File

Any document that you create using 4D Chart can be saved as a sepa-
rate document for use in another place — either in the same database, 
in another database that uses 4D Chart, or in an entirely different 
application. You use the standard Save and Save As menu items in the 
4D Chart File menu to save and update individual documents. 

Documents you save can be opened with the Open menu item in the 
4D Chart File menu. It makes no difference whether a document is 
created in a plug-in window or in a form; a document can be saved and 
opened in either place.

If you save a 4D Chart document as a file, when you reload the file, the 
document appears exactly as it was when you saved it. To update the 
information in any graphs in the document, you must use the Update 
menu item in the Chart menu, which is described in more detail in the 
section “Updating the Data in a Graph from the Database” on 
page 241.

❿❿❿❿ To save a 4D Chart document:

1 Choose Save As from the 4D Chart File menu.
Notice that you choose Save As from the 4D Chart File menu, not the 
4th Dimension File menu. 4D Chart displays a save-file dialog box.

2 Enter a filename for the document.

3 Click Save.
4D Chart saves the document with the filename you entered.

Saving a 4D Chart 
Document as Part of a 
Record

If you have created a 4D Chart area on a form and want its contents to 
be saved with each record, you need to create a BLOB or Picture field in 
the table to which the form belongs in order to store the contents of 
the area. The contents of the area are then saved automatically with 
each record when it is validated.
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For more information about creating 4D Chart areas on forms, refer to 
the 4th Dimension Design Reference manual.

❿❿❿❿ To save a 4D Chart document as part of a record:

1 Add a BLOB or Picture field to the table whose form contains the 
4D Chart area.
For more information about creating a field, refer to the 4th Dimension 
Design Reference manual.

2 Give the field the same name as the external area that you have 
created on the form and add an underline (_) to it.
For example, if your external area is named MyArea, the field must be 
named MyArea_.
Each chart is thus saved as a part of the record. 

If you save a 4D Chart document as part of a record, when you reload 
the record, the document appears exactly as it was when you saved it. 
To update the information in any graphs in the document, you must 
use the Update menu item, which is described in more detail in the 
section “Updating the Data in a Graph from the Database” on 
page 241.

Saving a 4D Chart 
Document as a Template

If you have inserted a 4D Chart area into a form, you can create a 
standard document that is the same for every record by saving the 
document as a template. You can create templates for 4D Chart only 
on forms. 

When you save a document as a template, the template is used for 
every new record that is opened in the form. 

Each document starts with the same template, but any unique modifi-
cations you make to it are saved with the record. There can be only one 
template for each 4D Chart area on a form.

If there is a graph in the document that is saved as a template, the 
graph is updated automatically for each record, if possible. 4D Chart 
can update a graph only if it was created from data stored in records in 
the database. 

❿❿❿❿ To save a document as a template:

1 Choose Save as Template from the 4D Chart File menu.
4D Chart saves the document with a special filename. The filename is 
the name of the 4D Chart area on the form, plus an underscore. 
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For example, an area named “Document” will have a template file 
named “Document_”.

Because 4D Chart automatically names the file and places it in the 
database directory; no save-file dialog box is displayed.

4D Server By default, 4D Chart templates are read from and saved to the client 
machines. You can use the 4D Chart language to specify that templates 
are read from and saved to the server machine. 

If you make changes to the document and want to incorporate those 
changes in the template, choose Save as Template again.

You can create a template for a 4D Chart area without using the 
Save as Template menu item simply by saving the document with a 
filename that is the same as the name of the 4D Chart area, plus an 
underscore, and placing the file in the database directory. This feature 
allows you, for example, to create a document in one database and use 
it as a template in another database. You can also create a document in 
one document area and use it as a template in another document area.

You can temporarily disable the use of a particular template file by 
changing the template filename or moving the file out of the database 
directory.

Importing a PICT 
document in a 
4D Chart window

You can open documents of the PICT type in a 4D Chart window. 
These documents can come from different sources (export of a 
4D Chart graph in PICT form, design software, etc.). The imported 
document behaves like a simple object; you cannot modify its 
attributes.

❿❿❿❿ To import a PICT document:

1 Choose the Import... command in the File menu of 4D Chart.
A standard open file dialog box appears. 

2 Select the PICT file you want to open (*.PCT extension under 
Windows) and click Open.
If the imported file is valid, its contents are displayed in the 4D Chart 
window.
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Exporting a 4D 
Chart document in 
PICT form

You can export a 4D Chart document or a selection of objects in it as a 
PICT file. In both cases, the objects do not keep their unique 4D Chart 
properties; the exported document is a static picture of the objects in 
the 4D Chart area or in the external window. You can import it as a 
PICT in 4D Chart or any other application that opens PICT files.

❿❿❿❿ To export a 4D Chart document in PICT form:

1 Choose the Export as... command in the File menu of 4D Chart.

2 Select a name and location for your file in the standard dialog box 
then click Save.

❿❿❿❿ To export a selection of 4D Chart objects in PICT form:

1 Select the object(s) that you want to export in PICT form.

2 Choose the Export Selection as... command in the File menu of 
4D Chart.
A standard save file dialog box appears. 

3 Select a name and location for the file and click Save. 
Whether you export a 4D Chart document or a selection of objects, a 
PICT file (*.PCT extension under Windows) is created on the disk.

Setting the 
Document Size

You can change the document size by changing the number of pages 
in the document or by specifying a new document size in points. The 
maximum drawing size is 3500 x 3500 points. You can add pages to the 
right of the first page, below it, or both.

❿❿❿❿ To change the document size:

1 Choose Properties from the 4D Chart Edit menu.
The Properties dialog box appears. The default document size is one 
page.

Click here to add or 
remove pages

Enter values here to 
set the drawing area 
to a specific size
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The document size is indicated by the point values to the right of the 
model document area and by the white rectangles in the model docu-
ment area. 

2 Click in the Document size area to adjust the number of pages in the 
drawing.
OR
Enter the exact size of the document (in points) in the Width and 
Height text areas.

Choosing a Graph Type
4D Chart allows you to create two-dimensional and three-dimensional 
graphs from within your database. Once you decide what data you 
want to graph, you should think about what type of graph will best 
display that data.

The nature of the data that you are graphing will help indicate the type 
of graph you should choose. For example, a line graph is best suited for 
showing how values (such as “number of units sold”) change over time. 

Don’t be afraid to experiment with different graph types. Once you 
have created a graph, you can easily convert it to another graph type. 
Creating graphs and changing their types are discussed in section 
“Creating a Graph” on page 234.

This section discusses the types of two- and three-dimensional graphs 
that you can create using 4D Chart. The features of each type of graph 
are described, along with the type of data that the graph is best suited 
to show.

Choosing a Two-
dimensional Graph 
Type

This section briefly describes the parts of a two-dimensional graph and 
then presents each two-dimensional graph type. 
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The following diagram shows a two-dimensional (two-axis) graph:

The X-axis is also called the Category axis. The X-axis displays the 
categories into which the information is divided. For instance, if you 
are graphing the number of computers sold per year, you would place 
the years on the X-axis.

The Z-axis is also called the Values axis. You use the Z-axis to display the 
values calculated for each category. In the computer sales example, the 
Z-axis would contain the values for the numbers of computers sold per 
year. For instance, if there were 500 computers sold in 1991, the Z-axis 
value corresponding to the X-axis category “1991” would be 500.

Another concept in graphing is the data series (or simply, series). Each 
category is composed of one or more series that further break down the 
information displayed in the graph. In this example, there was only 
one series, “computers sold.” Therefore, the series is not represented by 
a separate field or formula.

Sales History: Widget Computers

Graph values
on the Z-axis

Graph categories
on the X-axis
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However, suppose you want to compare the sales volumes from 1989 
to 1992 for three models of computers. In this case, each computer 
model becomes a distinct series on the graph. All series share the same 
categories (in this case, the years 1989 through 1992), but have their 
own values.

Another way to graph this data would be to create a three-dimensional 
graph of the data. This type of graph is discussed in the section 
“Choosing a Three-dimensional Graph Type” on page 229.

Area Graphs Area graphs are commonly used to show the magnitude of values over 
time, but can show values over any continuous category. 

Widget 100

Widget 350

Widget Pro

Sales History: Widget Computers (by model)
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The categories on the X-axis should be continuous, such as times or 
temperatures. Discrete categories, such as salespeople or products, are 
better suited to column graphs.

Options
The following options are available for Area graphs:

■ Stacked  When graphing multiple series, stack the areas for the series.

■ Stacked, proportional  When graphing multiple, stacked series, show 
the series as proportions of a 100% whole.

■ Horizontal  Make the X-axis the vertical axis and the Z-axis the 
horizontal axis.

Column Graphs Column and bar graphs are the most frequently used graph types for 
business data. They are most frequently used to compare one item to 
another, or one or more items over a period of time.

The following column graph uses the Depth feature, which makes each 
column look three-dimensional. 

Note The Depth feature is discussed in more detail in the section “Modifying 
Depth in a Two-dimensional Graph” on page 264.

Stacked Stacked, proportional Horizontal

Ticket Sale Profits in 2003
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$1600

King LearMacbeth
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Options
The following options are available for Column graphs:

■ Stacked  When graphing multiple series, stack the columns for the 
series in each category.

■ Stacked, proportional  When graphing multiple, stacked series, show 
the series as proportions of a 100% whole.

■ Horizontal  Make the X-axis the vertical axis and the Z-axis the 
horizontal axis. This option creates a bar graph. Bar graphs show the 
categories on the vertical axis, with the values expressed by the length 
of the bars. Bar graphs are often a useful alternative to column graphs, 
especially when the category labels are long.

■ Overlap  When graphing multiple series, use this option to specify the 
percentage by which the series columns within each category overlap 
each other.

■ Gap Width  Use this option to specify the spacial gap between the 
columns from one category to the next. The larger the gap, the 
narrower the columns for each category.

Line and/or Scatter 
Graphs

Line graphs are often used to show the rate of change of values over 
time. Scatter graphs can show relationships and trends in your data. 
Such graphs are most often used when there are a large number of 
different values of the X-axis field, as in a scientific study. 
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The values on the X-axis should be continuous or ordered, such as 
times or temperatures. Discrete categories or categories that do not 
have an order — such as salespeople or products — are better suited to 
column graphs.

Options
The following options are available for Line and/or Scatter graphs:

■ Stacked  When graphing multiple series, stack the lines for the series in 
each category.

■ Horizontal  Make the X-axis the vertical axis and the Z-axis the 
horizontal axis. 

■ Displaying lines and/or points
You can:

■ Show Points  Each value appears as a dot in the graph.

■ Show Lines  Only lines appear in the graph.

■ Show Both  Lines and Points appear in the graph.

Pie Charts Pie charts show data as a percentage of a whole. Your data does not 
need to be expressed as percentages; 4D Chart automatically converts 
the data into percentages when it creates the pie chart.

Each pie chart can have only one series. Categories are displayed in the 
legend.

France Leads Widget Market

France

England

USA40.0%

30.9%

29.1%
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Options
The following option is available for pie charts: 

■ Start Angle  Use this option to specify the rotation of the chart. The 
specified angle determines the placement of the first edge of the first 
category in the chart.

Picture Graphs Picture graphs are similar to column graphs, except that you can 
substitute a picture for the column.

Options
The following options are available for Picture graphs in 4D Chart: 

■ Stacked  When graphing multiple series, stack the pictures for the 
series in each category.

■ Stacked, proportional  When graphing multiple, stacked series, show 
the series as proportions of a 100% whole.

■ Horizontal  Make the X-axis the vertical axis and the Z-axis the 
horizontal axis. This option creates a bar picture graph.
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■ Overlap  When graphing multiple series, use this option to specify the 
percentage by which the series within each category overlap.

■ Gap Width  Use this option to specify the spacial gap between the 
picture columns from one category to the next. The larger the gap, the 
narrower the picture columns.

Additional options for aligning and adjusting the pictures are discussed 
in the section “Adding Pictures to a Picture Chart” on page 273.

2D XY Graphs 
(Scatterplots

Each data point in a scatterplot represents a pair of values. The X-axis 
is also a value axis.

When the 2D XY type is selected, the option Category is replaced with 
Values (X) in the Chart>Axis, Chart>Grid Lines and Chart>Titles 
menus. 

Options
The following options are available for 2D XY graphs in 4D Chart: 

■ Plots shapes  You can display None, Circles, Squares, or Star plots.

■ Lines appearance  You can display None, Straight, or Arrows lines.

■ Show Regression Line  (y = ax+b)  Allows to view the predictive 
relation between the X- and Y-axis values (if appropriate). 
There is one regression line for each series of points. Using Ctrl+click 
(Windows) or Command+click (MacOS), you can select the points 
associated with the regression line.

■ 2D XY variant: Polar charts
Polar charts are used to show the distribution of data around a central 
point. In a polar chart, each point is plotted in terms of degrees from 
the zero point and distance from the center. 
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Each data point on a polar chart is plotted using one Z-axis field to 
specify the angle in degrees and a second Z-axis field to specify the 
distance from the center.

Choosing a Three-
dimensional Graph 
Type

This section briefly describes the parts of a three-dimensional graph 
and then presents each three-dimensional graph type. 

The following diagram shows a three-dimensional (three-axis) graph:

Distribution of Dairies Around 

Distance in Miles

Acme Milk Processing Plant

Graph values
on the Z- axis

Graph categories
on the X-axis

Graph series
on the Y-axis

 

Widget Pro
Widget 350

Widget 100

 

Sales History: Widget Computers (by model)
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As with a two-dimensional graph, the X-axis (or, Category axis) dis-
plays the categories into which the information is divided. For 
instance, if you are graphing the number of computers sold per year, 
you would place the years on the X-axis.

In a three-dimensional graph, the Y-axis is also called the Series axis. 
Each category is composed of one or more series that further break 
down the information for each value of the X-axis field. Each data 
point in the graph is the intersection of one category and one series. In 
the example illustrated above, each computer model is a series. 

In a two-dimensional graph, the series remain on the X-axis. The col-
umns representing each series are distinguished by their patterns. In a 
three-dimensional graph, the series are displayed on their own axis. 
Each series still has its own pattern, but now the series are also sepa-
rated from each other in space.

The Z-axis displays the values calculated for each combination of 
category and series. 

In the computer sales example, the Z-axis would contain the values for 
the numbers of each type of computer sold per year. For instance, if 
there were 725 Widget Pro computers sold in 1991, the Z-axis value 
corresponding to the X-axis category “1991” and the Y-axis series 
“Widget Pro” would be 725.

 

3D Column Graphs

 

3D Column graphs, like 2D Column graphs, compare one item to 
another, or one or more items over a period of time.

 

Improvement in Test Scores

 

Seniors
Juniors

1990
2000
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Options

 

The following options are available for 3D Column graphs:

 

■

 

Category Gap/Width

 

  The gap between or width of the categories in 
the graph. The larger the category gap, the smaller the category width.

 

■

 

Series Gap/Width

 

  The gap between or width of the series in the graph. 
The larger the series gap, the smaller the series width.

 

■

 

Tops only

 

  Show only the top side of each column.

 

3D Line Graphs

 

3D Line graphs show trends in your data. They should be used for 
continuous categories, such as time.

 

Option

 

The following option is available for 3D Line graphs:

 

■

 

Series Gap/Width

 

  The gap between or width of the series in the graph. 
The larger the series gap, the smaller the series width.

1990 1995 2000 2005
Imports

Exports

Trends in Widget Imports and Exports
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3D Area Graphs

 

3D Area graphs emphasize the volume or size of the series over a 
continuous category, such as time.

 

Option

 

The following option is available for 3D Area graphs:

 

■

 

Series Gap/Width

 

  The gap between or width of the series in the graph. 
The larger the series gap, the smaller the series width.

 

3D Surface Graphs

 

Surface graphs show three-dimensional data where the Z-axis value 
varies depending on the X- and Y-axis values. Surface graphs are 
commonly used to graph the results of mathematical formulas.

The following graph was created using a mathematical formula.
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z = (1 - x)

 

2  + y 2   
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Option

 

The following option is available for 3D Surface graphs:

 

■

 

Tops only

 

  Show only the top side of the surface, not the sides. This 
option is used in the previous example graph.

Here is an example of a surface graph with sides.

 

3D Triangle Graphs

 

3D Triangle graphs compare one item to another, or one or more items 
over a period of time. 3D Triangle graphs are an alternative to 
3D Column graphs.

 

Options

 

The following options are available for 3D Triangle graphs:

 

■

 

Series Gap/Width

 

  The gap between or width of the series in the graph. 
The larger the series gap, the smaller the series width.

 

■

 

Flipped

 

  The triangles appear flipped vertically.

 

■

 

Plot Zero Values

 

  If this option is not selected, zero values will be 
omitted from the graph.

1980 1990 2000
Dolomites

Alps
Rockies

Annual Number of Visitors
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3D Spike Graphs

 

3D Spike graphs show the intersection of three values. Each data point 
is connected to the Category plane with a drop line.

 

Option

 

The following option is available for 3D Spike graphs:

 

■

 

Oval/Square Heads

 

  Use this option to specify whether the spike heads 
are oval or square.

 

Creating a Graph

 

This section includes the basic steps for creating a graph. After reading 
this section, you will be able to:

 

■

 

Create a two-dimensional or three-dimensional graph from data stored 
in the database or copied to the Clipboard

 

■

 

Update a graph created from data in the database

 

■

 

Change a graph’s type

 

■

 

Change the options specific to each graph type

4D Chart allows you to create two-dimensional and three-dimensional 
graphs based on the data in fields in your database. You can graph the 
values in the fields themselves, or you can graph the values that result 
from formulas that use the fields.
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Whatever the case, when you create a graph, you select the data that 
you want to graph on each axis. For each axis, there are certain restric-
tions on the data types that can be graphed. If a data type cannot be 
graphed on a certain axis, fields of that type cannot be selected in the 
Chart Wizard. The following table provides information on the types 
of data that can be assigned to the Categories or Series axis and the Val-
ues axes.

 

Creating a Selection 
of Records to Graph

 

Before you begin the process of creating a graph, you must create a 
selection of records to graph.

4D Chart can operate in its own window or in 4D Chart areas on forms. 
The following sections explain how to generate the selection of records 
to be graphed, depending on the 4D Chart location. 

 

Creating a Selection of 
Records in a Plug-in 
Window

 

4D Chart graphs the records in the current selection. Before you create 
a graph in a plug-in window, select the records you want to graph. 

4D Chart will not create a graph unless there is at least one record in 
the current selection of the table whose data you want to graph. 

 

Creating a Selection of 
Records in an Input 
Form

 

A 4D Chart area in an input form can be used to graph data in other 
tables. 

The table whose records you want to graph must have at least one record 
in its current selection. If the table that contains the form is automati-
cally related to the table you wish to graph, the current record in the 
input form determines the selection of records in the related table.

 

Data Type
Category or 
Series Axis?

Values
Axis?

Compatible Types
on Values Axis

 

Alphanumeric Yes No -------

Text Yes No -------

Real Yes Yes Integer, Long integer

Integer Yes Yes Real, Long integer

Long integer Yes Yes Real, Integer

Date Yes Yes -------

Time Yes No -------

Boolean Yes No -------

Picture No No -------

Blob No No -------
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Because you have a record loaded in an input form, you should avoid 
creating graphs from data in the current table. If you want to graph 
data from the same table as the input form, you must use 

 

PUSH RECORD

 

 and 

 

POP RECORD

 

 or create a new process with the 

 

New process

 

 function. For more information, see the descriptions of 
these commands in the 

 

4

 

th

 

 

 

Dimension Language Reference

 

.

For more information about adding a 4D Chart area to a form, see the 

 

4

 

th

 

 

 

Dimension Design Reference.

Creating a Graph 
From Data in the 
Database

For a two-dimensional graph, you specify a field for the horizontal axis 
(X-axis) and one or more fields or formulas for the vertical axis 
(referred to in 4D Chart as the Z-axis). 

For a three-dimensional graph, you will specify one field (or formula) 
each for the X-, Y-, and Z-axes.

The following example graph shows how 4D Chart uses the informa-
tion in the database to create a 2D graph. The graph plots the scores on 
two tests for each of 11 students. The X-axis field is Student ID, and the 
Z-axis fields are AOC Score and TUC Score.

Name of 1st
Z-axis field

Name of 2nd
Z-axis field

Value stored in
AOC Score field
for Student #6

Categories stored 
in X-axis field

Scale values
generated by
4D  Chart from
Z-axis values

Test Scores for Fifth Grade
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The following example graph shows how 4D Chart uses the informa-
tion in the database to create a graph. The graph shows the average 
monthly stock value for two companies. The X-, Y-, and Z-axis fields 
are, respectively: Month, Company Name, and Average Price.

����

❿❿❿❿

 

To create a graph from data stored in the database:

 

1 Make sure that no graph is currently selected in the 4D Chart area.

 
To deselect a selected graph, click anywhere in the 4D Chart area 
outside the graph. 

2 Click the Graph icon  in the Chart Tool palette.
OR
Choose New Chart from the Chart menu.

Series stored in
the Y-axis field

Z-axis field 
for Ink, Inc. in

Categories stored 
in the X-axis field

Scale values
generated by
4D  Chart from
Z-axis values February

Value stored in
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The Chart Wizard appears. 

The Chart Wizard has three pages:

 

■

 

Chart Type

 

  displays the 12 chart types supported by 4D Chart and 
lets you choose a graph type.

 

■

 

Chart Style

 

  displays the variations on the type of graph that you 
selected in the Chart Type page. The Chart Style page changes 
depending on your choice of chart type.

 

■

 

Data Selection

 

  lets you select the table that contains the data you 
wish to graph and a field list. Use the Data Selection page to assign 
fields or formulas to the graph axes. The Data Selection page 
changes depending on the graph type you chose.

You must choose a chart type and use the Data Selection page to assign 
appropriate fields or formulas to each axis that the chart type requires. 
You do not need to choose a chart style.

 

Note

 

If you are creating a graph in a 4D Chart area in an input form, the 
current table is not listed in the Tables list because you cannot graph 

 

data from the current table.

 

3 Click a chart type.

 

When you click on a chart type, the Chart Style and Data Selection 
pages change to match the requirements of the selected type. For com-
plete information on the types of charts available in 4D Chart, see 
“Choosing a Graph Type” on page 221.
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4 Click the Chart Style tab (Optional).

 

The styles for the selected chart type appear. The following illustration 
shows the styles available for the 2D Column chart type.

 

5 Click the desired chart style.

6 Click the Data Selection tab.

 

The Data Selection page appears, displaying the appropriate options 
for the selected chart type.

Table drop-down list

2D graph

Fields list
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7 Choose the desired table from the Table drop-down list.

 

The Fields list changes to show the fields from the selected table.

 

8 Drag the field that you want to assign to the Category axis to the 
Category box or double-click the field.

 

Note

 

If you make a mistake when choosing the X-axis field, replace the field 

 

by dragging the desired to field to Category box.

 

■

 

If you want to create a three-dimensional graph, you must fill the 
“Second Category (Y Axis)” area. Go to the following step.

 

■

 

If you want to create a two-dimensional graph, you only need to fill 
the “Values (Z Axis)” area. Go to step 10.

 

9 If you are creating a 3D graph, drag the Series field to the Y-axis 
(Second Category) box or double-click the field.

 

The name of the field appears in the Y-axis box.

 

Note

 

If you make a mistake when choosing the Y-axis field, replace it by 

 

dragging the correct field to the Second Category box.

 

3D graph
240 4th Dimension User Reference



Creating a Graph
    

10 Drag the field containing the values to be graphed to the Values (Z-
axis) box or double-click the field

 

1

 

.
OR
Click the Formula button (2D graphs only).

 

The name of the field or the formula appears in the Z-axis (Values) box.
For instructions on creating a formula, see the section “Adding a 
Formula” on page 246.

 

11 If you want to have the Z-axis values summed for each X-axis category, 
click the Group check box.

 

This option is used when the X-axis categories are not unique and you 
want each category to appear only once, with the values for each 
instance summed. For more information about this option, see the 
section “Grouping Non-unique Categories and Series” on page 245. 

12 If you want to have the Z-axis values summed for each Y-axis series, 
click the Group check box (3D graphs only).

 

This option is used when the Y-axis series are not unique and you want 
each series to appear only once, with the values for each instance 
summed. For more information about this option, see the section 
“Grouping Non-unique Categories and Series” on page 245.

 

13 When you have finished designing your graph, click OK.

 

4D Chart creates the graph and displays it in the 4D Chart area.

 

Updating the Data in a 
Graph from the 
Database

 

When you create a graph from data stored in the database, the data in 
the graph is static. Although the data in the database may change, the 
data in the graph remains the same until you update it. 

You can tell 4D Chart to update a graph by choosing 

 

Update

 

 from the 

 

Chart

 

 menu. When you choose Update, 4D Chart regenerates the 
selected graph using the data in the current selection for the table 
whose fields you are graphing. 

You will want to update a graph in the following situations:

 

■

 

When you want to include more records in the selection

 

■

 

When you want to include fewer records in the selection

 

■

 

When you want to include different records in the selection

 

1. With 2D graphs, you can add more than one field or formula to the Z-axis. 
Each field or formula becomes a series. For more information, please refer to 
the section “Choosing a Graph Type” on page 221. 
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■

 

When the data in the selection has been modified.

When you use 

 

Update

 

, 4D Chart recreates the graph using the new 
current selection and the settings you chose for the original graph. 

 

Note

 

The 

 

Update

 

 menu item is available only for graphs created from data 

 

in the database.

 

Creating a Graph 
From Data on the 
Clipboard

 

You can graph data from any application if it is correctly formatted and 
then copied to the Clipboard. This section describes how to format 
data in order to use it in a graph, and how to create a 4D Chart graph 
from this information.

 Formatting Data and 
Copying It to the 
Clipboard

 You can graph data that is formatted in the Tab-Tab-Return (TTR) 
format. If you copy cells from any spreadsheet application, they will be 
in TTR format. You can also use data from a word-processing 
application if it is formatted with tabs between the fields and carriage 
returns between the records.

Following are examples of correctly formatted data:

 

Note

 

The and symbols represent the invisible symbols used by many 
word-processing applications to indicate tabs and carriage returns, 

 

respectively.

The first row of data is used as the field names. Each column contains 
the data for one field.

 

Note

 

If you want to use dates copied to the Clipboard, the dates must be in 

 

the same format as the System-level date format.

When you have prepared the data in your application, select the 
desired rows and columns and copy them to the Clipboard. 

TTR data (word-processing) Spreadsheet data

Names
Helen 25

Todd 27

Norm 22

Michele 23

Ages Names
Helen

Todd
Norm

Michele

25

27
22

23

Ages
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Creating the Graph from 
Data on the Clipboard

 

For a two-dimensional graph, you will specify a field for the X-axis and 
one or more fields or formulas for the Z-axis. The following illustration 
shows how 4D Chart interprets the information from the Clipboard.

For a three-dimensional graph, you specify one field each for the X-,
Y-, and Z-axes. The following illustration shows the spreadsheet data 
used for the example graph. The information details the total sales by 
two different stores to three types of customers. 

Names
Helen

Mike

Norm
Michele

25

27

22
23

AgesField names

Records

Clipboard

 

Name of the
Z-axis field

Norm’s age

Values stored in 
the X-axis field

Scale values
generated by
4D  Chart from
Z-axis values

 

2D Graph

Field names

Records

Categories
Series
Values

Clipboard
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❿❿❿❿

 

To create a graph from data stored on the Clipboard:

 1 Copy the data to be graphed to the Clipboard, using the format 
described in this section.

2 Follow the instructions provided in steps 1 to 6 in the section 
“Creating a Graph From Data in the Database” on page 236.

 

The Data Selection page appears, configured for the selected chart type.

 

3 Click the Use Data From Clipboard check box.

Series

Categories 

Total value of
sales to retail stores
at the Sunny Valley
store location

3D Graph
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Clicking Use Data From Clipboard disables the Source Table drop-
down list and populates the Fields list with the field names from the 
Clipboard, as shown below.

 

4 Assign fields to the axes by dragging to the appropriate areas or by 
double-clicking the fields.

 

When all areas have been assigned fields, the 

 

OK

 

 button is enabled.

 

Note

 

With 2D graphs, you can add as many fields and formulas to the Z-axis 
as you like. However, be sure to choose only numeric fields. Do not 
mix date fields and formulas with number fields and formulas. Each 

 

item in the Z-axis (Values) box becomes is plotted in the graph.

 

5 If you want to have the Z-axis values summed for each X-axis category, 
click the Group check box.

 

This option is used when the X-axis categories are not unique and you 
want each category to appear only once, with the values for each 
instance summed. For more information about this option, see the 
section “Grouping Non-unique Categories and Series” on page 245.

 

6 When you have finished designing your graph, click OK.

 

4D Chart creates your graph and displays it in the 4D Chart area.

 

Grouping Non-
unique Categories 
and Series

 

Some categories or series may appear more than once in your data. For 
instance, suppose that you want to graph the total purchases made by 
each of your customers. Each customer may have made several 
purchases.

 

Disabled Source Table 
drop-down list

Field list from 
Clipboard
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When you create a two-dimensional graph, you can choose to sum the 
values for non-unique categories, so that each category appears only 
once on the graph. When you create a three-dimensional graph, you 
can choose to sum the values for non-unique categories, non-unique 
series, or both.

To create the graph described in the example above, you might graph 
from the [Invoices] table, using [Invoices]Customer for the X-axis 
categories and [Invoices]SalesTotal for the Z-axis values. Because some 
customers may have more than one invoice, you would want 4D Chart 
to sum the values in the [Invoices]SalesTotal field so that there would 
be only one value (the total) for each customer.

The illustrations below show the same basic graph with and without 
the Group

 

 

 

option:

To group data on the Category or Series axis, check the corresponding 

 

Group

 

 

 

check box in the Data Selection page of the Chart Wizard.

 

Adding a Formula 

 

You can graph values that are not represented in your data but are 
obtained by performing calculations on the data or on other values in 
your database. For example, you can graph your profits by graphing the 
results of a formula that subtracts your unit cost from your retail price.

You can refer to any valid 4

 

th

 

 Dimension method and graph the result 
on the Values axis. The method must return a value to 4D Chart. If the 
categories are grouped, 4D Chart sums the values returned.

 

Graph without
Group option

Graph with
Group option
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If there are fields or other formulas also being graphed on the Values 
axis, the data types of all the values must be compatible. For instance, 
if you are graphing a Date field and a formula on the Values axis, the 
formula must return a date. 

 

Formulas are available only for two-dimensional graphs.

����

❿❿❿❿

 

To use a formula to calculate values for a graph:

 

1 When you are ready to specify the Values field in the Data Selection 
page, click the Formula button.

 

The 4D Formula dialog box appears.

 

2 Type the formula.

 

For more information about the Formula Editor dialog box, please refer 
to section “The Formula Editor” on page 113. Following are some 
examples of formulas: 

3 Click OK.

4 When you have finished designing the graph, click OK in the Chart 
Wizard to create the graph.

 

Changing the Graph 
Type

 

You can switch between graph types at any time. You can change from 
one two-dimensional graph type to another or from one 
three-dimensional graph type to another. When creating a graph, feel 
free to experiment with graph types to find the best way to present 
your data.

����

❿❿❿❿

 

To change the graph type:

 

1 Make sure that the graph is selected.

 

You select a graph by clicking it. When a graph is selected, selection 
handles appear around it.

 

Formula Syntax

 

Month of (Current date) 4D function (4D function)

Day of ([Invoices]Invoice date) 4D function (field)

Sin (vX) 4D function (variable)

NumVisits Method that returns a value in $0
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2 Choose another graph type from the Graph  drop-down list in 
the Chart Tool palette.
OR
Choose the Chart Type item in the Chart menu.

 

The “Choose a Chart Type” window is then displayed. You can select 
another chart type and click 

 

OK

 

. 

The graph is redrawn using the new graph type. Both the Graph drop-
down list and the Choose a Chart Type window display only the chart 
types that are appropriate for the selection of data. You cannot, for 
example, plot 3D data using a 2D graph type. For information on the 
graph types available in 4D Chart, see the section “Choosing a Graph 
Type” on page 221.

 

Setting the Graph Type 
Change Alert 

 

You can have 4D Chart display an alert dialog box when the user 
attempts to change the type of a graph. The user then has the option 
to cancel or continue with the change.����

❿❿❿❿

 

To display an alert dialog box when a new graph type is selected:

 

1 Choose Properties from the 4D Chart Edit menu.

 

The Properties dialog box appears. 

 

2 Check or uncheck the Chart Type Change Alert check box.

3 Click OK to close the Properties dialog box.

 

Changing the 
Options for a Graph 
Type

 

Each graph type has a particular set of options that you can change 
using the Options dialog box. By changing the graph options, you can, 
for example, change a column graph to a bar graph, or show the series 
in an area graph as proportions of a whole.

Chart type change 
alert check box
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❿❿❿❿

 

To open the Options dialog box for a graph:

 

■

 

Double-click the graph.
OR
Select the graph and choose Options from the Chart menu.

 

For more information about the options for each graph type, see section 
“Choosing a Graph Type” on page 221.

 

Modifying Graph Features

 

This section explains how to modify graph features. After reading this 
section, you will know how to:

 

■

 

Resize a graph

 

■

 
Customize graph axes

 

■

 
Show and hide grid lines

 

■

 

Display the series values

 

■

 

Customize legends

 

■

 

Add depth to a two-dimensional graph

 

■

 

Change the perspective of a three-dimensional graph

 

■

 

Customize the tips of a chart

 

■

 

Change the graphic attributes of chart objects

 

■

 

“Explode” a wedge from a pie chart

 

■

 

Add a picture to a picture chart

 

Resizing a Graph

 

You can resize a graph by dragging its selection handles. Selection 
handles are the black squares that appear around the object when it is 
selected. 

You can resize the height and width at the same time, maintaining the 
sizing proportion between the two. 

����

❿❿❿❿

 

To resize a graph:

 

1 Select the graph.

2 Hold down the mouse button on a selection handle and drag it up, 
down, or diagonally.
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If you drag a corner, the height and width change. If you drag a side, 
either the height or the width changes.

To resize the object so that the height and width retain the same 
proportion to each other, hold down the 

 

Shift

 

 key while you are 
resizing.

 

3 Release the mouse button when you have finished.

 

The graph is resized.

 

Customizing the 
Axes

 

You can customize many aspects of each axis of a graph. This section 
contains information about:

 

■

 

Customizing the axis labels

 

■

 

Customizing the tick marks

 

■

 

Changing the scale of the Values axis

 

■

 

Reversing the order of data points on an axis

 

■

 

Positioning the origin

 

■

 

Adding axis titles

The following table explains the axes available in two-dimensional 
(2D) and three-dimensional (3D) graphs:

 

Dragging a 
selection handle

 

Number of Axes Axis Name Axis 

 

Two (2D Graph) Category X
Series N/A
Values Z
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You can display the Axis dialog box for any axis by choosing the 
appropriate axis from the 

 

Axis

 

 submenu of the 

 

Chart

 

 menu.

Using the Axis dialog box, you can change the location of the axis 
labels, tick marks, and origin. You can also change the scale used for 
the Values axis and reverse the order of the items graphed on each axis.

This section presents the dialog boxes that you use to customize the 
axes of your graph. It then provides details about each of the options.

The Category Axis dialog box enables you to customize the Category and 
Series axes:

 

Note

 

The Tick Marks drop-down list, Reverse Order check box, and Cross 
Axis At text box are not available in the Category or Series Axis dialog 
box for three-dimensional graphs.

Three (3D Graph) Category X
Series Y
Values Z

Number of Axes Axis Name Axis 

Labels area

Tick marks drop-down list
Reverse order check box

Cross Axis at box

Show One Label out of box
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The following dialog box enables you to customize the Values axis:

Note Only the Labels and Scale areas are available in the Axis dialog box for 
three-dimensional graphs. The Date Increment drop-down lists are 
available only when dates are being graphed on the Values axis.

Customizing the Axis 
Labels

4D Chart automatically labels the axes when it generates a graph. You 
can change the position, orientation, and format of the labels, or you 
can decide not to display them with your graph.

■ Label Positions
You can choose one of the following label positions from the Position 
drop-down list:

■ None

■ Top

■ Bottom

■ Left

■ Right

Depending on the orientation of the axis, either Top and Bottom or 
Left and Right will be unavailable.

When the position is None, the label does not appear on the graph. 

Tick Marks area

Labels area
Scale

Z-axis Crosses at 
Category box

Logarithmic 
check box

Reverse Value 
Order check box

area
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■ Label Orientation
The following label orientations are available for each axis:

■ Label Formats
You can change the way data in your labels is displayed by using 
display formats. For instance, you can use a display format to display 
dollar amounts using the dollar sign ($), commas, and decimals. 

The following table shows some examples of the effects of display 
formats:

When you select one of the formats from the Format drop-down list, it is 
entered into the Format text box, located to the right of the drop-down 
list. If you want to use a custom format, you can enter it in that area.

You can use one of 4th Dimension’s built-in formats, edit a format, or 
create one of your own. For more information, see the 
4th Dimension Design Reference manual.

■ Labeling Data from Boolean Fields
If you create graphs using Boolean fields from the database, the default 
axis labels are “0” and “1”, corresponding to FALSE and TRUE. You can 
label your graph more informatively by changing the label format. 

To create more meaningful labels for Boolean fields, change the label 
format to the following:

TrueLabel;;FalseLabel

For example, you might change the format to “Female;;Male” or 
“Experimental;;Control”.

Orientation

Normal Vertical Rotated 
Left

Rotated 
Right Staggered Wrap

R
e
s
u
l
t

Label L
a
b
e
l

La
be

l Label

Label1 Label3
Label2

Lab
el

Data in Default Format Display Format Data in Display Format
3400 $###,###.00 $3,400.00
3/4/99 Month Date, Year March 4, 1999
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Reducing the Number of 
Labels

You can reduce the number of labels displayed on the X-axis or Y-axis 
of a graph. This feature is useful when you create graphs with a large 
number of categories (more than 100).

When this option is used, 4D Chart displays only one label per N labels 
on the selected axis. To use this option, enter a value between 2 and 
255 in the “Show One Label out of” box. For example, if you enter 10, 
4D Chart will display one label per 10 categories. The value 1 is the 
standard setting (all labels are displayed).

■ Auto: if you check the Auto box, 4D Chart will calculate the appropri-
ate number of labels to display, according to the amount of room.

Customizing the Tick 
Marks

Tick marks show the increments of the axes. You can choose among 
different styles of tick marks, or you can decide not to show the tick 
marks. You can customize this option for each axis in a two-
dimensional graph.

Note You cannot customize the tick marks for a three-dimensional graph.

The following tick mark styles are available:

■ Cross ( )

■ Inside ( )

■ Outside ( )

Changing the Values 
Axis Scale

You can change the minimum and maximum values shown on the 
Values axis. You can also change the major and minor units of the axis. 

If dates are being graphed, you can specify whether the major and 
minor units are measured in days, weeks, months, or years.

In addition, you can specify that the graph use the default value for 
any of these items. To use the default value, simply check the check 
box located to the left of the desired option.
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In the following graphic, the default minimum and maximum values 
and the user-specified major and minor units are used.

■ Using a Logarithmic Scale
You can change the scale from normal to logarithmic by checking the 
Logarithmic check box, located in the Values axis dialog box.

Reversing the Order of 
the Data 

You can reverse the order of the data on an axis by checking the 
Reverse Order check box. You can reverse the order of data only in a 
two-dimensional graph.

Positioning the Origin You can change the position of the origin — the place where one axis 
crosses another — for each axis in a two-dimensional graph.

■ Changing the Origin of the Values (Y) Axis
The origin of the Z-axis is the value at which the Category (X) axis 
crosses the Z-axis. Usually, the origin is the minimum value on the 
graph or zero. Sometimes, you will want to change the position of the 
origin.

❿❿❿❿ To change the origin of the Values axis:

1 Choose Category (X) from the Axis submenu of the Chart menu.
The Category (X) dialog box appears.

2 Enter a value in the “Cross Axis At” text box.
The value you enter is the numerical value of the desired origin 
position.

3 Click OK to close the dialog box.

■ Changing the Origin of the Category (X) Axis
The origin of the X-axis is the category at which the Values axis crosses 
the X-axis. Usually, the origin is placed to the left of the first category. 
Sometimes, you will want to move the origin.

Scale area

Date increment 
drop-down list
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❿❿❿❿ To change the origin of the Category (X) axis:

1 Choose Values (Z) from the Axis submenu of the Chart menu.
The Values (Z) dialog box appears.

2 Enter a number in the “Z-Axis Cross at Category” text box.
The number you enter is the number of the category at which the 
origin should cross. The categories are numbered from left to right, (or 
from bottom to top in a horizontal chart). The Z-axis crosses to the left 
of the specified category.

To move the origin to the right of the last category on the graph, 
specify the number of categories plus 1. 

If the specified number is higher than the number of categories plus 1, 
the value is ignored and the origin is reset to the left of the first 
category.

3 Click OK to close the dialog box.

Adding Axis Titles You can add a title for each axis. Usually, the titles describe the data 
graphed on the axis.

❿❿❿❿ To add a title to any axis:

1 Choose the appropriate axis from the Titles submenu of the Chart 
menu.
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The Titles dialog box appears.

2 Type the title into the “Title” text box.

3 Choose a position for the title from the “Position” drop-down list.
This specifies the position of the title relative to the graph. 

You can choose one of the following title positions:

■ None

■ Top

■ Bottom

■ Left

■ Right

The default position is None. When the position is None, the title does 
not appear on the graph. 

Depending on the orientation of the axis, either Top and Bottom or 
Left and Right will be unavailable.

4 Choose an orientation for the title from the “Orientation” drop-down 
list.
The following orientations are available for each axis:

■ Normal

■ Vertical

■ Rotated Left

■ Rotated Right

5 Click OK.

Showing and Hiding 
Grid Lines

You can display grid lines for the major and minor increments of each 
axis. Grid lines can make a graph easier to read.

The major and minor increments are set in the Axis dialog box for the 
Values axis.

Title text box
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❿❿❿❿ To display the grid lines for any axis:

1 Choose the appropriate axis from the Grid Lines submenu of the Chart 
menu.

The Grid Lines dialog box appears.

2 Click the desired check boxes and click OK.

Displaying the 
Series Values

You can display information for each series directly in the graph. You 
can display the following information:

■ Values  The actual number or date, in Arabic numerals. You can show 
the values on the graph instead of using labels on the Values axis, or 
use them to supplement the axis labels.

■ Percentages  The value of the data point divided by the sum of all the 
values in the category, as a percentage.

■ Categories  The name of the category, identical to the axis label for the 
category.
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The following graph shows the values at the tops of the columns.

You can select the location at which the values, percentages, or 
category labels should appear, their orientation, and their format. 

This feature is not available for three-dimensional graphs.

❿❿❿❿ To display information about the data in a series:

1 Choose Values from the Chart menu.
The Values dialog box appears.
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2 Select the location at which the information should appear. 
You can select one of the following options from the Position drop-
down list:

3 Select the type of information you wish to display.
You can select one of the following options from the Display drop-
down list:

■ Values

■ Percentage

■ Category

■ Value & Percent

■ Categories & Percent

4 If you wish, select a format from the “Format” drop-down list.
You can change the way values are displayed by using display formats. 
For instance, you can use a display format to display dollar amounts 
using the dollar sign ($), commas, and decimals. 

The following table shows some examples of the effects of display 
formats:

When you select one of the formats from the Format drop-down list, it 
is entered into the Format text box, located below the drop-down list.

You can use one of 4th Dimension’s built-in formats, edit a format, or 
create one of your own. For more information, see the 4th Dimension 
Design Reference manual.

Pie Charts All Other Graph Types 
None None
Inside Outside Top
Outside Outside Bottom

Inside Top
Inside Centered
Inside Bottom
At Axis

Data in Default Format Display Format Data in Display Format

3400 $###,##.00 $3,400.00

3/4/99 Month Date, Year March 4, 1999
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5 Select an orientation from the “Orientation” drop-down list.
You can select one of the following options:

■ Normal

■ Vertical

■ Rotated Left

■ Rotated Right

6 When you are finished making your selections, click OK.

Customizing the 
Legend

4D Chart automatically creates a legend for you when it generates the 
graph. By default, the legend is based on value labels. You can 
customize the legend’s location, order, and text.

Displaying and Hiding 
the Legend

To display or hide the legend for the selected chart:

1 Choose Legend from the Chart menu.
The Legend dialog box appears.

2 Click the Display Legend check box.
If this check box is checked, the legend is displayed as part of the chart 
object. If this check box is unchecked, the legend is hidden.

3 Click OK to close the dialog box.

The next section explains how to position the legend in the chart 
object.

Display Legend 
check box
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Positioning the Legend The legend is part of the chart object. You can position the legend 
using the eight built-in legend locations, or you can move it using the 
mouse. You can move the legend anywhere in the document, includ-
ing placing it inside the graph itself. 

In addition, you can display the legend vertically or horizontally. In 
other words, the series in the legend can be placed left-to-right or 
top-to-bottom.

Positioning the Legend 
Using the Built-in 
Locations

To use the built-in locations for the legend:

1 Choose Legend from the Chart menu.
The Legend dialog box appears.

2 Select a legend position by clicking one of the model legends in the 
Location area.
The location you choose will determines whether the orientation is 
horizontal or vertical.

3 Click OK to close the dialog box.

Positioning the Legend 
with the Mouse

You can position the legend anywhere in the 4D Chart document by 
moving it with the mouse.

❿❿❿❿ To position the legend with the mouse:

1 Hold down the Ctrl key (qqqq key on Macintosh) and click the legend to 
select it.

Horizontal orientation

Vertical orientation
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2 While continuing to hold down the Ctrl or qqqq key, click and drag the 
legend to the desired location.

3 Release the mouse button and the Ctrl or qqqq key.

Maintaining the Legend 
Location

When you use the Legend dialog box, click the User Specified button 
to maintain the legend location. If you select one of the built-in 
locations, the User Specified option is automatically deselected.

Setting the Legend 
Order

You can reverse the order of the series in the legend. In addition, you 
can reverse the order of the legend key and legend text.

❿❿❿❿ To change these options:

1 Choose Legend from the Chart menu.
The Legend dialog box appears. The following options are available:

■ Reverse Legend Order  Reverses the order of the series in the leg-
end.

■ Reverse Key and Text  If this check box is checked, the square con-
taining the color or pattern code for each series is displayed after 
the series name.

2 Check or uncheck the check boxes as desired.

3 Click OK to close the dialog box.

Customizing the Legend 
Text

You can customize the text of any or all of the series in a legend. 

❿❿❿❿ To customize legend text:

1 Choose Legend from the Chart menu.
The Legend dialog box appears.

2 Click the Legend Titles tab.
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The Legend Titles page appears.

The series labels for the legend are displayed in a list. 

3 Choose the series label to edit by clicking its name in the list.
The series label is highlighted in the list and the text of the label 
appears in the Text Editing box.

4 Edit the text in the Text Editing box.

5 Click the Set button.
You must click Set in order for the change to take effect.

6 Repeat the previous steps until you have made all the changes you 
want.

7 Click OK.
The Edit Legend dialog box closes. If you are displaying the legend, 
you will see your changes in the legend text.

Modifying Depth in 
a Two-dimensional 
Graph

A three-dimensional graph plots three fields or variables in three 
dimensions. However, you can add the appearance of a third dimen-
sion to a two-dimensional graph by adding “depth.” The third dimen-
sion does not represent the values of any of the fields or formulas 
plotted in the graph.

By default, 4D Chart adds the illusion of depth to two-dimensional 
graphs. You can remove it to make the values in the graph easier to 
read or modify the three-dimensional illusion.

Text Editing box
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❿❿❿❿ To modify or remove the depth illusion in a two-dimensional graph:

1 Choose View from the Chart menu.
This menu item is enabled only when the currently selected object is a 
graph. 
The Depth dialog box appears.

2 Modify the horizontal and vertical depth, measured in points, by 
typing values in the appropriate text boxes.
To remove the depth illusion, enter zeros in both entry areas. You can 
also enter negative values to invert the three-dimensional illusion axis. 

When you press Tab or click outside a text box, the value you have 
entered is reflected in the Depth preview area.

3 Click OK.
Your Depth specifications are applied to the graph.

Changing the 
Perspective of a 
Three-dimensional 
Graph

You can change the perspective from which a three-dimensional graph is 
viewed. You can change both the rotation and the elevation of a graph.

❿❿❿❿ To change the perspective from which a three-dimensional graph is 
viewed:

1 Choose View from the Chart menu.
The View menu item is enabled only when the currently selected 
object is a graph.

Depth preview 
area
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The 3D View dialog box appears.

2 If you wish, you can change the rotation by entering a new value 
(from 0 to 90) in the Rotation text box or by moving the Rotation 
slider to the left or right.
Rotation is the rotation of the graph around the Values axis.

The model graph reflects the change you have made.

3 If you wish, you can change the elevation by entering a new value 
(from 0 to 90) in the Elevation text box or by moving the Elevation 
slider up or down.
Elevation is the rotation of the graph around a horizontal line, 
perpendicular to the Values axis.

The model graph reflects the change you have made.

4 Click OK.
Your graph is redrawn from the new perspective.

Rotation slider

Elevation slider
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Customize Tips in 
Charts

Tips — information about a graph and its data — are available for both 
XY and non-XY graphs. The user can display tips from any position of 
the pointer in the graph. 

Tips display the following types of information:

■ Value (on which the pointer is located).

■ Ratio between a value (on which the pointer is located) and the total of 
values in that category. This ratio is expressed as a percentage.

■ Category.

The following table lists the graph types and the information that can 
be displayed in the associated tips:

Tip

Type of Graph Tips
2D Column Values and percentages
2D Line None
2D Pie Values and percentages
2D Area None
2D XY Values only
2D Picture Values and percentages
2D Polar Values only
3D Column Values only
3D Line None
3D Area None
3D Surface None
3D Triangle Values only
3D Spike Values only
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The values in the tips are based on the data as displayed in the graph, 
and thus may be approximations based on the screen resolution.

Tip attributes are accessed manually in the Tips dialog box (from the 
Tips item in the Chart menu) or programmatically using the 
commands CT GET TIPS ATTRIBUTES and CT SET TIPS ATTRIBUTES.

The Tips dialog boxes differ for XY and non-XY graphs.

■ XY Graph:

■ Non-XY Graph:

In the Tips dialog box, you can change the properties of the tips 
displayed for any graph.

The Tips list box enables you to select when to display tips. The 
choices are Never, Always, and On Request.

Selecting the Messages in Toolbar option displays the tips in the 
toolbar. If this check box is not selected, the tip will be displayed in an 
independent message box only. The default is to display the tips in the 
toolbar.
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Selecting the Show Category option displays the value of the Category 
axis in the tips. The default is to display the Category axis value.

Selecting the Show Second Category displays the value of the second 
Category axis in the tips. The default is to not show the second 
category. In the case of a 2D graph, selecting this option displays the 
field name of the Category axis value.

Selecting the Show Value option displays the value of the Values axis 
in the tips. The default is to display the Values axis value.

The Display list box enables you to choose to display the category 
value, percentage (the ratio between the value on which the pointer is 
located and the total of values in that category) or both.

The Format list box enables you to select the display format for values 
displayed. The default is General. If the Format selected is General, the 
text box below the Format list box allows you to enter text for the 
Values axis. In the case of XY graphs, there are two Format list boxes 
and text boxes, to accommodate the X and Y Values axes.

Changing the 
Attributes of Chart 
Objects

This section describes how to select individual chart objects (axis lines, 
grid lines, series elements, etc.) and change their graphic attributes, 
such as color, pattern, and line width. You can also change the font 
attributes of chart text objects (such as axis labels and titles).

❿❿❿❿ To select an individual chart object:

■ Hold down the Ctrl key (Windows) or Command key (Macintosh) and 
click the object.
The following chart objects can be selected:

■ Each series in a two-dimensional graph

■ Each of the three visible sides of a series in a 3D graph

Note To select all sides of a series in a three-dimensional graph at once, hold 
down the Shift and Ctrl keys (Windows) or Command key (Macintosh) 
and click an object in the series.

■ Each axis (includes the tick marks)

■ Axis labels for each axis

■ Major grid lines for each axis

■ Minor grid lines for each axis

■ Titles for each axis
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■ The legend

■ Values displayed for the series.

Changing Object 
Attributes

After you have selected an object, you can modify its graphic attributes 
using items in the Object menu.

Each of the following object attributes can be changed in the Object 
menu:

■ Fill Pattern  The pattern displayed inside the border of an object. All 
objects except lines have fill patterns. 

■ Fill Color  The color displayed inside the border of an object.

Note The number of colors displayed depends on the number of colors that 
your monitor supports.
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■ Line Pattern  The pattern of a line or border. The default line pattern is 
solid.

■ Line Color  The color of a line or border. The default line color is black. 
The color palette used for Fill Color is also used for Line Color.

■ Line Width  The width of a line or border measured in points. The 
default line width is 0.25 points (also called a hairline).

■ Arrowhead  If the selected object is a line, the Arrowhead menu item is 
enabled. The Arrowhead submenu has the following items.

You can choose to add an arrowhead to either or both ends of the line.

■ Round Corners  If the selected object is a rectangle that you created 
with a rectangle tool, the Round Corners menu item is enabled. When 
you choose Round Corners, the following dialog box appears:
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When you enter a value in the entry area, the preview area shows the 
effect of the value:

Changing Text 
Attributes

Text attributes apply only to axis labels, axis titles, legend text, and 
series values. Each of the following text attributes can be changed in 
the Text menu:

■ Font  The typeface of the text.

■ Size  Font size is measured in points. 

■ Style  Styles include plain, bold, and italic. The default style is plain.

■ Color  The default color is black.

You cannot change the justification of graph text. You can only change 
the justification of text added with the Text tool. For more information 
about adding text with the Text tool, see the section “Adding Text” on 
page 278.

Exploding Wedges 
from a Pie Chart

You can “explode” a pie chart by pulling one or more wedges away 
from the center of the pie. 

❿❿❿❿ To explode a wedge from a pie chart:

1 Hold down the Ctrl key (Windows) or Command key (Macintosh) and 
click a wedge of the pie chart to select it.

Exploded 
wedge
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Selection handles appear around the wedge.

2 While holding down the Ctrl key (Command key on Macintosh), click 
and drag the wedge away from the center of the pie.

3 When the wedge is where you want it, release the mouse button and 
the Ctrl key (Command key on Macintosh).

Adding Pictures to a 
Picture Chart

When you create a picture chart, the columns are filled with a default 
picture. You can add your own picture for each series by pasting it from 
the Clipboard.

❿❿❿❿ To paste a picture into the columns for a series:

1 Make sure that the picture you want to paste into the column is on the 
Clipboard.

2 Hold down the Ctrl key (Windows) or Command key (Macintosh) and 
click a picture column for the desired series.

3 Choose Paste from the 4th Dimension or 4D Chart Edit menu.
The picture is pasted into each column for the series.

You can repeat this process for each series. 

Adjusting the 
Pictures Within the 
Columns

To customize the proportions of the pictures within the series 
columns:

1 Double-click the graph to display the Options dialog box for picture 
graphs. 
OR
Select the graph and choose Options from the Chart menu.
The Picture Chart Options dialog box appears.
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In addition to the chart options, which are discussed in section 
“Choosing a Graph Type” on page 221, you will find the following 
options for aligning and adjusting the pictures:

■ Alignment  This option specifies the horizontal alignment of the 
picture: center, left, or right.

■ Vertical  This option specifies how the picture uses the vertical space 
of the column. The options are: clipped, stretched, and stacked. For 
more information about these options, see the table at the end of 
this section.

■ Horizontal  This option specifies how the picture uses the horizon-
tal space of the column. The options are: clipped, stretched, and 
stacked. For more information about these options, see the table at 
the end of this section.

The following table explains the Vertical and Horizontal options.

2 Choose the desired options from the drop-down lists and click OK.

Adding Objects and Text
With 4D Chart you can add a variety of objects to your documents, 
including lines, rectangles, ovals, polygons, and text. You can also add 
dynamic references to fields or to 4th Dimension expressions by 
inserting expressions in text objects.

Option Description

Clipped If the picture is too tall or too wide to be displayed in its 
entirety, it is truncated at the edges of the column. The 
proportions of the picture remain unchanged.

Stretched The picture is stretched or shrunk so that its dimensions 
match those of the column.

Stacked If the picture is either too short or too narrow to fill the 
column, the picture is repeated until the column’s height or 
width is reached. When the edge of the column is reached, 
the picture is truncated.
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The following graph uses objects and text to identify the series.

Topics covered in this section include:

■ Drawing objects

■ Modifying object attributes

■ Adding text

■ Modifying text attributes

■ Adding a dynamic reference to a 4th Dimension field or expression

■ Resizing objects

■ Arranging objects in a document

Drawing Graphic 
Objects

You can draw the following objects:

■ Lines  

■ Rectangles  

■ Rounded rectangles  

■ Ovals  

■ Polygons  

Selecting a Drawing Tool To draw an object, you must first select a tool from the Object Tool 
palette. You make a tool active for drawing when you select it.

The mouse pointer changes depending upon its use. If the Arrow tool 
is selected, then the pointer is an arrow . You use the Arrow tool to 
select menu items and objects.

JBC

Industrial
Average
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When you select any of the graphic object tools, the pointer changes 
to a crosshair . You use the crosshair to draw graphic objects.

Locking a Drawing Tool When you select a tool, it is in effect only while you draw one object, 
after which the Arrow tool is selected. However, you can lock a tool so 
that you can continue to use it as long as you need it, by double-
clicking it. When you lock a tool, it remains in use until you select 
another tool.

Drawing an Object

❿❿❿❿ To draw all objects except polygons:

1 Select a tool in the 4D Chart toolbar. 

1 Hold down the mouse button in the document area and drag the 
mouse to draw the object.

2 Release the mouse button to finish drawing the object.

❿❿❿❿ To draw a polygon:

1 Click to anchor the first vertex.

2 Drag the mouse to draw a side and then click to anchor the next 
vertex.

3 Continue anchoring vertices and drawing sides as necessary.

4 Close the polygon by clicking the first vertex to close the polygon, or 
by pressing Alt+Ctrl+Enter (Windows) or Option+Command+Enter 
(MacOS).
OR
Leave an open side to the polygon by double-clicking the mouse 
button to anchor the last vertex or by pressing Enter.

Open polygonClosed polygon
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Constraining Graphic 
Objects As You Draw

By constraining graphic objects as you draw, you can control the 
drawing process — in particular, the height and width of objects. For 
example, a square is really just a constrained rectangle. 

The following table lists the effects of constraining each object.

Changing Object 
Attributes

Each of the following object attributes can be changed using 
commands in the Object menu:

■ Fill Pattern  The pattern displayed inside the border of an object. All 
objects except lines have fill patterns. The default fill pattern is solid 
white.

■ Fill Color  The color displayed inside the border of an object. All objects 
except lines have fill color. The default fill color is black.

■ Line Pattern  The pattern of a line or border. The default line pattern is 
solid.

■ Line Color  The color of a line or border. The default line color is black.

■ Line Width  The width of a line or border measured in points. The 
default line width is 0.25 points (also called a hairline).

■ Arrowhead  The arrows that appear on one or both ends of a line; only 
lines have arrowheads. The default is to have no arrowheads.

■ Round Corners  The amount of rounding of the corner of a rounded 
rectangle. The default rounding is 1/4 inch.

Object Key Constraint
Lines Shift Constrain line to 45° angles

Rectangles

Shift Draw a square

V (for vertical) Constrain height

H (for horizontal) Constrain width

Rounded 
Rectangles

Shift Draw a rounded square

V Constrain height

H Constrain width

Ovals

Shift Draw a circle

V Constrain height

H Constrain width

Polygons Shift Constrain sides to 45° angles
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Adding Text Most of the text that you want to add to a graph — such as axis labels, 
titles, legends — can be added using menu items in the Chart menu.

To add extra text to a graph, you must first create a text object and 
then enter the text. A text object is a container for text. 

❿❿❿❿ To create a text object:

1 Select the Text tool .
The pointer changes to an I-beam .

2 Hold down the mouse button and drag the mouse to create a 
rectangular text area.

3 Release the mouse button.
You can also simply click in the window after you have selected the 
Text tool to create a text object of default size (three inches in width). 
The default height is determined by the font and font size you have 
selected.

4 If you have not already done so, click inside the text object to insert 
the pointer.
When you place the pointer in the text object, it becomes an insertion 
point .

5 Type your text.

Text object

I-beam pointer

Insertion point
278 4th Dimension User Reference



Adding Objects and Text
6 When you have finished typing the text, select any other tool.
Unlike other objects, text objects are not selected after you create 
them. 

Once you have created a text object and added text, you can change 
the text by editing it — for example, copying, cutting, or pasting it. 
You can also change its attributes, such as its font, size, style, and 
justification. For more information about changing text attributes, 
refer to the next section, “Changing Text Attributes”. 

Changing Text 
Attributes

Text attributes are applied only to text inside a text object. Each of the 
following text attributes can be changed in the Text menu:

■ Font  The typeface of the text. 

■ Size  Font size is measured in points. The default size is 12 point.

■ Style  Styles include plain, bold, and italic. The default style is plain.

■ Color  The default color is black.

■ Alignment  Text can be left, right, or center aligned. The default align-
ment left.

Adding Dynamic 
References

Using field references and 4th Dimension expressions, you can create 
4D Chart documents that incorporate information from your database. 
For example, you can use field information from the records to make 
chart titles. You can use 4th Dimension expressions to perform tasks 
such as computing numeric values or concatenating text information.

In this section, you will find information about the following topics:

■ Inserting field values into a 4D Chart document,

■ Inserting a 4th Dimension expression into a 4D Chart document,

■ Displaying field and expression values,

■ Formatting field and expression values,

■ Changing a dynamic reference to static text.

Understanding Values 
and References

You can display the information from 4th Dimension as either values or 
references. A value is the actual information stored in a field or calcu-
lated from an expression. A reference is the name of the field or the 
text of the expression.
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When expressions and fields are displayed as references, they are 
surrounded by the following symbols: « and ». 

For example, a reference to the First Name field in the [Stationery 
Order] table would appear as:

«[Stationery Order]First Name»

4D Chart inserts these symbols when a field is inserted into a text 
object. When you insert any other type of reference, such as a 
4th Dimension function or variable, you must indicate that it is a 
reference. 4D Chart will then add the « and » symbols to differentiate 
the reference from normal text. For more information on referencing 
expressions, see the section “Inserting 4th Dimension Expressions” on 
page 283.

When references are displayed as values, the « and » symbols do not 
appear; for example, a field value for First Name might be:

James

The field value appears as standard text.

Field references and 4th Dimension expressions always refer to the 
current record and are updated whenever the current record changes. 
If there is no current record, no value is displayed. 

Inserting Field 
References

By inserting a field reference in a 4D Chart document, you add 
dynamic information to the document. As the field is updated, so is 
the value in 4D Chart. You can use fields from any table in the data-
base, except subtables.

The field reference or value appears in a text object, except for refer-
ences to picture fields. The text object containing a reference acts as 
any other text object; you can change its attributes, move it, and so on.

■ Using Field References in a Plug-in Window
When you insert a field reference in a 4D Chart plug-in window, the 
value that is displayed when you choose Show Values from the 
Database menu is the field’s value for the current record. If no record is 
currently loaded there will be no value displayed in the 4D Chart plug-
in window. 
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In order to show the value stored in a field for a particular record, make 
sure that the record is loaded — by displaying the record in an input 
form, for instance. If the current record changes, the value displayed in 
the field changes.

■ Using Field References in a 4D Chart Area on a Form
When you insert a field reference in a 4D Chart area on an input form, 
the value that is displayed when you choose Show Values from the 
Database menu is the field’s value for the current record.

You can use the Paste Field dialog box to paste a field reference into a 
document.

❿❿❿❿ To paste a field reference into a 4D Chart document using the Paste 
Field dialog box:

1 Click the mouse button where you want to insert the reference.
If you click inside a text object, you cannot insert a Picture field.

2 Choose Paste Field from the Database menu.
The Paste Field dialog box appears. All tables in the database are listed 
in the Tables drop-down list. The fields for the selected table are 
displayed in the Fields list.

3 Select the table from which you wish to paste a field reference from 
the Tables drop-down list.
The fields in the selected table are displayed in the Fields list.

4 Select the field you wish to paste from the Fields list and click OK.
A reference to the field is pasted into the document in a text object.

Tables drop-down list

Fields list
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You can select fields from a drop-down list containing all available 
tables and fields. You cannot paste references to Picture fields when 
you select a field from a drop-down list.

When you are working in a form, you can choose fields from a drop-
down list that displays the fields in the current table, or from a drop-
down list of fields for all tables in the database. 

When you use 4D Chart in a plug-in window, the drop-down list 
always contains both tables and fields. 

❿❿❿❿ To insert a field into a 4D Chart document using the Tables and Field 
pop-up menu:

1 Create a text object where you want to paste the field.
If you need information about creating text objects, see the section 
“Adding Text” on page 278.

2 Position the I-beam pointer  over the text object.
Make sure that the insertion point is in the text object.

3 To choose a field from the same table as the form, hold down the Alt 
key (Windows) or Option key (Macintosh) as you press the mouse 
button.
A pop-up menu of fields for the table in which you are working 
appears. If you are working in a plug-in window, the pop-up menu 
contains both tables and fields.

4 To choose a field from another table, hold down the Shift and Alt 
(Windows) or Option (Macintosh) keys while you press the mouse 
button. 
If you are working in a plug-in window, you do not need to hold down 
the Shift key.

4D Chart displays a hierarchical pop-up menu of the tables in the 
database. Each table has a submenu containing its fields. 

5 Select a field.
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A reference to the selected field is pasted into a text object in the 
4D Chart document at the insertion point location.

Inserting 4th Dimension 
Expressions

You can insert any valid 4th Dimension expression into a document. 
The expression can be a 4th Dimension variable, a 4th Dimension func-
tion, a plug-in function, or a method that returns a value.

With expressions you can use the power of 4th Dimension’s language 
within 4D Chart documents. You can perform calculations, concate-
nate information from several fields, and so on. 

The following table contains some examples of expressions:

An expression is evaluated only when you perform one of the 
following actions:

■ Open the document

■ Choose Show Values from the Database menu

■ Print the document

For more information about expressions, refer to the 4th Dimension 
Language Reference. 

❿❿❿❿ To insert a 4th Dimension expression into a 4D Chart document:

1 Create a text object where you want to place the expression.
Since the expression is created from text, you must first create the text 
object.

2 Enter the expression text and then select it.

3 Choose Reference from the Database menu.
The text is now enclosed in the « and » symbols, which indicate that it 
is an expression:

«Current date»

4 When you have finished, select the Arrow tool.
To display the value of the reference, choose Show Values from the 
Database menu.

Expression Comment
vDate A variable containing a date
Current date A 4th Dimension function
Current date–vDate A statement that performs a calculation
DateCalc A method that returns a value
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Displaying Values or 
References

When you display values, you show the actual values stored in refer-
enced fields and the values calculated by referenced 4th Dimension 
expressions. For example, if the reference is «Current date», today’s date 
is displayed. 

❿❿❿❿ To display values:

■ Choose Show Values from the Database menu.
The value of each reference is displayed.

Note The values of all references are displayed, regardless of the selected 
reference.

❿❿❿❿ To display references:

■ Choose Show References from the Database menu.
The reference for each value is displayed.

Changing the Value in a 
Reference to Text

You can change the value in a dynamic reference into static text that 
will not be updated when the value changes. 

For instance, you can use the 4th Dimension expression «Current date» 
to display the date you created a graph, and then change that date to a 
static text object. No matter what the current date is, the text object 
will always display the creation date of the graph.

Changing a value to text is called unreferencing the value, because the 
value no longer has a dynamic reference to the database. Once you 
have unreferenced a value, you cannot change it back to a reference. 

❿❿❿❿ To change a value in a field reference or expression to text:

1 Choose Show Values from the Database menu to display all values.

2 Select the text block containing the value you want to unreference.
If the text block contains more than one field or expression, select only 
the value you want to change.

3 Choose Unreference from the Database menu.
The value becomes text.

Changing a Reference to 
Text

You can change a reference into text by unreferencing it. When you 
change a reference to text, you change the words of the reference, not 
the value to which the reference refers. 
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For instance, if you change the reference «Current date» to text, the text 
object displays the following:

Current date

When you choose Show Values from the Database menu, this text does 
not change, and the current date is not displayed, because the text no 
longer refers to a 4th Dimension expression.

You may want to edit a reference or permanently change it to standard 
text. If you want to edit a reference, you must unreference it, edit it, and 
then reference it again. 

❿❿❿❿ To unreference a field reference or expression:

1 Choose Show References from the Database menu to display all 
references.

2 Select the text block containing the reference you want to 
unreference.
If the text block contains more than one field or expression, select only 
the reference you want to change.

3 Choose Unreference from the Database menu.
The « and » symbols are removed, and the reference becomes text.

Formatting References You can use a display format for the value of any numeric, date, or 
time field or expression in 4D Chart. For instance, you can use a 
display format to display dollar amounts using the dollar sign ($), 
commas, and decimals. 

The following table shows some examples of display formats:

❿❿❿❿ To format a reference:

1 Select the reference.
Since the entire expression is a single value, you can select it by 
clicking it with the Text tool.

2 Choose Format from the Database menu.

Data in Default Format Display Format Data in Display Format
3400 $###,##.00 $3,400.00
3/4/03 Month Date, Year March 4, 2003
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The Field Format dialog box appears.

3 Select an appropriate format from the list.
The format appears in the text box below the list of formats.

If you want, you can edit a number format or enter a new number 
format in the Format text box. You cannot edit date or time formats.

For more information about display formats, refer to the 
4th Dimension Design Reference manual.

4 Click OK.
The format is listed after the reference. For instance:

«Current date; Abbr.: Month Day, Year»

When you choose Show Values, the value of the reference is displayed 
using the format.

Resizing Objects You can make an object larger or smaller by resizing it. You can select 
one or more objects to resize. If you select more than one object, all 
selected objects are resized by the same amount. 

You can resize the height and width at the same time, maintaining the 
sizing proportion between the two. 

❿❿❿❿ To resize an object:

1 Select the object.

2 Hold the mouse button down on a selection handle and drag it up, 
down, or diagonally to change the object’s size.

Format list

Edit format area
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If you drag a corner, the height and width change. If you drag a side 
either the height or the width changes.

To display the object’s outline — rather than its rectangular frame —
hold down the Alt key (Option key on Macintosh) while resizing. 

To resize the object so that the height and width retain the same 
proportion to each other, hold down the Shift key while you are 
resizing.

3 Release the mouse button when you have finished.
The object is resized.

Arranging Objects When you have two or more objects in a 4D Chart document, you can 
use the items in the Arrange submenu of the Object menu to arrange 
them. The Arrange submenu is shown below.

You can choose from the following actions in the Arrange submenu:

■ Bringing an item to the front 

■ Sending an item to the back 

■ Moving an item forward one level

■ Moving an item backward one level

Object’s frame

Object
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■ Aligning objects in relation to each other

■ Grouping a set of objects

■ Ungrouping a set of objects.

The following sections describe these actions in more detail.

Changing the Stacking 
Order

When you draw objects, they can partially or entirely overlap one 
another. The order in which objects are placed when they overlap one 
another is called the stacking order. The sample screen below displays 
several objects and their stacking order.

As you work with objects, you may want to change the stacking order 
of objects; to do so, you can move one or more objects in front of or 
behind other objects.

■ Moving an Object in Front of All Others  By moving an object in front 
of all others, you move it to the top layer.

■ Moving an Object Behind All Others  By moving an object behind all 
other objects, you move it to the bottom layer.

■ Moving One Object in Front of Another  Moving an object in front of 
another object allows you to move the selected object one layer higher 
— that is, place it closer to the top layer.

■ Moving One Object Behind Another  Moving an object behind 
another object allows you to move the selected object one layer lower 
— that is, place it closer to the bottom layer.

❿❿❿❿ To modify the stacking order:

1 Use the arrow pointer to select an object.

2 Choose a command on the Arrange submenu in the Object menu. 

Middle object

Top object

Bottom object
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The Arrange submenu is shown below.

Aligning Objects When you align objects to each other, you position them in relation to 
each other. Aligning objects to each other ensures that objects are 
placed precisely in relation to each other. You can align objects both 
horizontally and vertically. 

The object that is farthest in the selected alignment direction is the 
reference for object alignment. For example, if you want to align the 
left sides of several selected objects, the selected object that is furthest 
to the left remains fixed, and the other objects are aligned to it.

When you select Align Objects from the Arrange submenu, the 
Align Objects dialog box appears:

Use the following icons to align the selected objects to each other:

Vertical alignment buttons

Model objects

Horizontal alignment buttons

Icon Meaning

 Align the left edges of selected objects.
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Select a maximum of one vertical and one horizontal alignment. The 
model objects move to indicate the effects of the alignment.

Note To deselect an icon, click it again.

❿❿❿❿ To align objects:

1 Select the objects to be aligned.
Shift-click to select several objects.

2 Choose Align Objects from the Arrange submenu of the Objects menu.
The Align objects dialog box appears.

3 Click the desired alignment icons and click the Align button.

Grouping and 
Ungrouping Objects

By grouping objects, you can combine several objects into one. A 
grouped object acts like a single object when you manipulate or edit it. 
You can work with a grouped object as you would any other object; 
you can change its attributes, resize it, and so on.

When you group several objects, all attributes of the individual objects 
are retained. However, if you change any attribute of the group, that 
change affects all objects in the group. For example, if you select a new 
fill pattern for the group, it is applied to each object in the group. 

Ungrouping an object breaks it into its component objects. When an 
object is ungrouped, each piece becomes a separate object again. 
Ungrouped objects retain any changes made to them while part of a 
group.

You can make a single object from several selected objects by grouping 
them. Once you create a group, you can manipulate it the same way 
you would a single object.

 Align the centers of select objects along a vertical axis.

 Align the right edges of selected objects.

 Align the top edges of selected objects.

 Align the centers of select objects along a horizontal axis.

 Align the bottom edges of selected objects.

Icon Meaning
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❿❿❿❿ To group objects:

1 Select all objects to group.

2 Choose Group from the Arrange submenu of the Object menu.
The objects become one object.

You can break a grouped object into its separate objects by ungrouping it.

❿❿❿❿ To ungroup objects:

1 Select an object to ungroup.

2 Choose Ungroup from the Arrange submenu of the Object menu.
The object is ungrouped and each object is selected.

Printing 4D Chart Documents
You can print any 4D Chart document. This section discusses printing 
4D Chart documents in the following ways:

■ As a single 4D Chart document

■ As part of a 4th Dimension form

■ As a part of a print merge, in which you print a 4D Chart document for 
each record in a selection of records

Setting the Print 
Order

The order in which a multi-page document is printed (either horizon-
tally or vertically) is determined by the print order selected in the Prop-
erties dialog box. You can select printing by row , or printing by 
column . The print order affects only the order in which the docu-
ment prints; it does not affect the page orientation. The default is to 
print pages by row.

❿❿❿❿ To set the order in which a multi-page document is printed:

1 Choose Properties from the 4D Chart Edit menu.
2914th Dimension User Reference



Chapter 10  Graphs
The Properties dialog box appears.

2 Click the desired Print Order icon.

3 Click OK.

Printing the 
Document

You can print 4D Chart documents from a plug-in window or from a 
4D Chart area in a form. If the document is more than one page in 
length, you can select the pages you want to print.

❿❿❿❿ To print a document:

1 Choose Print from the 4D Chart File menu.

The Print dialog box appears.

2 Select options as necessary.

3 Click the Print button to begin printing.

Printing a 4D Chart 
Area as Part of a 
Form

If a 4D Chart area is on a 4th Dimension form, you can print it with 
the record. In this case, you print from 4th Dimension, rather than 
from 4D Chart. 

Before printing, be sure to select the records you want to print. For 
more information about selecting records in 4th Dimension, see 
Chapter 4, “Selecting Records”, on page 81.

Print 
Order icons
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❿❿❿❿ To print a 4D Chart document as part of a record:

1 Choose Print from the 4th Dimension File menu.
A dialog box appears so that you can choose the print form.

2 Choose the print form.

3 Click OK.
The Page Setup dialog box appears.

4 Select options from the Page Setup dialog box as necessary.

5 Click OK.
The Print dialog box appears.

6 Select options as necessary.

7 Click the Print button when you want to begin printing.
The selected records are printed, including the 4D Chart documents.

Creating a Print 
Merge

You can perform a print merge of a 4D Chart document. Performing a 
print merge allows you to print a 4D Chart document for each record 
in a selection of records.

Note The values in any graphs in the document are not updated for each 
record.

Print merges are most useful when performed from 4D Chart plug-in 
windows. 

You can perform print merges only for documents that contain 
references to 4th Dimension fields. The value in a field reference is 
determined by the current record being printed. The advantage to 
performing a print merge is that you can print a document for an entire 
selection of records without having to load and print for each record 
separately. 

Note For information on adding field references, see the section “Inserting 
Field References” on page 280.
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❿❿❿❿ To perform a print merge:

1 Choose Print Merge from the 4D Chart File menu.

The Create Merge Selection dialog box appears. 

2 Choose the table whose records should be included in the print merge. 
The dialog box displays the number of records currently selected for 
that table. 

4D Chart will print the document only for the selected records. 

3 If you want to change the selection of records, click the Query button. 
The 4th Dimension Query editor appears. After you do the query in the 
Query editor, you will return to the Create Merge Selection dialog box. 
For more information about the 4th Dimension Query editor, see the 
section “Query Editor” on page 90.
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4 If you want the selected records to be sorted, click the Order by 
button. 
The 4th Dimension Order By editor appears. After you sort the records, 
you will return to the Create Merge Selection dialog box. For more 
information about the Order By editor, see the section “The Order By 
Editor” on page 123.

When you have selected the appropriate records, you can print the 
records.

5 Click OK in the Create Merge Selection dialog box.
The Print dialog box appears.

6 Select the appropriate options and click OK.
4D Chart prints the document for each record in the selection.
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11 Executing Methods

The Execute Method command in the Special menu is used to execute 
a method from the User environment. You can execute methods to 
perform tasks such as printing a report, performing a global update, or 
importing or exporting data1. Also, if you are in the process of writing 
methods, you can test your methods by switching to the User 
environment and using Execute Method. 

You can use Execute Method to start a new process. If you check the 
New Process check box in the Execute Method dialog box, the selected 
method executes in a new process (rather than the User/Custom 
Menus process). 

If you are running the database in the client-server environment, you 
can choose to execute the method on the server machine or on other 
clients’ machines. Time-consuming tasks that process data, print 
reports, or import or export data can be run more efficiently as stored 
procedures. See the 4th Dimension Language Reference for more 
information on stored procedures.

A method can also be executed from the Custom Menus environment 
by assigning it to a menu command on a Form menu bar. When you 
choose a menu command on a menu bar, the associated method is 
automatically executed. For more information about form menu bars, 
see the 4th Dimension Design Reference manual.

1. While you are debugging your code, you can also execute a method 
directly in Trace mode. For more information, see the 4th Dimension Language 
Reference.
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Executing Methods
Use the Execute Method command in the Special menu to select and 
execute a method created with the 4th Dimension language. The menu 
command is dimmed unless at least one method has been written.

For more information about writing methods, see the 4th Dimension 
Design Reference and the 4th Dimension Language Reference manuals.

❿❿❿❿ To execute a method:

1 Choose Execute Method from the Special menu.

4th Dimension displays the Execute Method dialog box, as shown 
below.

2 Select the name of a method in the list.

3 If you want to start a new process for the method, check the “New 
Process” check box.
If you check the New Process check box, the method you selected 
executes in another process. If the method is performing a time-
consuming task such as printing a large set of records, you can 
continue to work with your database, adding records to a table, 
creating a graph to display data, and so on. 
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For a definition of processes, see the section “Multi-tasking in 
4th Dimension” on page 22. For a detailed description of processes, 
including how to create, use, and manage processes, refer to the 
4th Dimension Design Reference manual.

4D Server • If you are using the database on 4D Client, you can choose to run the 
method on the server machine. To do so, select the On 4D Server 
option in the To Be Executed menu. Most methods can be executed on 
the server machine unless the method must create or modify interface 
elements on a client workstation.
• You can also choose to run the method on another client 
workstation. Other client workstations will not appear in the menu, 
unless they have been previously “registered” (for more information, 
please refer to the description of the routine REGISTER CLIENT in the 
4th Dimension Language Reference, as well as the paragraph “Registering 
4D Client” in the 4D Server Reference manual.

The On 4D Server option in the To Be Executed menu is dimmed if you 
are not running in the client-server mode environment 4D Server and 
4D Client.

4 Click the Execute button (or double-click the method name).
OR
If you want to trace the method, click the Debug button.

4D Server The Debug option is not available if you execute the method on the 
server.

4th Dimension executes the method. What happens next depends on 
what the method does. A method can perform calculations, change the 
current selection, print reports, and even exit the application and 
return to the Program Manager or Finder.
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12 Importing and Exporting 
Data

4th Dimension’s data importing and exporting capabilities provide a 
fast and reliable way to transfer information to and from your data-
base. If you are upgrading to 4th Dimension from another database or a 
spreadsheet, you can avoid the work of re-entering the data from the 
keyboard by importing your data. You can import data from Windows 
data management applications or any non-Windows application 
whose data has been transferred to Windows.

You can also export data from 4th Dimension so that it can be used in 
other types of programs that process information. For example, you 
can export data to a specialized graphics or statistics program. You can 
also transfer the exported data to another type of computer.

You can import or export data using the settings in the appropriate dia-
log boxes or using a form. Importing or exporting using the dialog 
boxes is faster than using a form. However, if you use a form you can 
use object and form methods to process data. When you import or 
export data using a form, the form and object methods are executed 
for every record that is processed.

When importing or exporting data, you specify the file format, the 
field and record delimiters, the fields to be imported or exported. Once 
you have defined your import or export settings, you can save or load 
them into or from Import/Export Settings files.

Note You can also use the Quick Report editor to export records. See the 
section “Disk File” on page 185 for more information.
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File Formats
The file format describes the way in which fields and records are 
arranged in the import or export file. Some file formats also include 
formatting information. 4th Dimension supports the following file 
formats:

■ Text (ASCII)  This format separates fields within a record with the end-
of-field delimiter and records with the end-of-record delimiter. The 
default field and record delimiters are the Tab and Return, respectively. 
You can also include field names as the first row of an export Text file. 
If you include field names as the first row of an import Text file, you 
can tell 4th Dimension to use those names when it imports the file; 
otherwise, you can instruct 4th Dimension to ignore the row of field 
names. 

■ Fixed Length Text Format  The Fixed Length Text format allocates a 
specific number of characters per field. No end-of-field delimiter is 
used. All records have the same number of characters even if a the 
record’s values can fit into fewer characters. When this happens, a fill 
character — usually a space — is used to pad fields. You can specify the 
fill character for each data type or use default characters (see the sec-
tions “Filling Page” on page 315 and “Filling Page” on page 325). How-
ever, if a value has more characters than the number of characters 
allocated to the field, the value will be truncated. 

■ SYLK  This stands for SYmbolic LinK format. 

■ DIFF  This stands for Data Interchange Format. 

■ DBF (dBase)  dBase is a file format commonly used in DOS and Win-
dows database applications.

■ XML  XML (eXtensible Markup Language) is a data exchange standard. 
This language is based on the use of tags that enable precise 
description of the exchanged data as well as its structure. XML files are 
Text format files; their content is parsed by the applications importing 
the data. Many applications support this format. 
For more information about XML terminology, refer to the 
4th Dimension Design Reference manual.
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■ 4th Dimension Format  This format, which is specific to 
4th Dimension, makes it easy to exchange records between different 
4th Dimension databases. This format supports all of 4th Dimension’s 
data types, including Picture and Blob. The 4D export file extension is 
“.4IE”. 

Macintosh and 
Windows Files

When you import or export data, you can specify whether the 
import/export file will be for either the Macintosh or Windows 
environments. This option affects the choice of field and record 
delimiters1 for Text files and whether an ASCII map is used: 

■ Macintosh file  The delimiters will be the standard ones used on 
MacOS (End of field= Tab, End of record= Return, End of file= <None>).

■ Windows file: The delimiters will be the standard ones used on Win-
dows (End of field = Tab, End of record= Return+Line feed, End of file = 
<None>). In this case 4th Dimension’s MacOS/Windows conversion fil-
ter is used (remember that an internal filter ensures multi-platform 
compatibility of 4th Dimension databases. 4th Dimension stores the 
data in Macintosh ASCII format). 

For example, if you choose Macintosh file, the Carriage return (ASCII 
code 13) will be used as the record delimiter. When importing a Text 
file, 4th Dimension automatically converts any instances of Return 
plus Line Feed to Return only.

Note ASCII codes in 4th Dimension are given in decimal (base 10) numbers. 
A table of ASCII codes is included in the 4th Dimension Language 
Reference.

Field, Record, and File Delimiters
End-of-field delimiters are placed between fields in a record and the 
end-of-record delimiter is placed after each record. End-of-file 
delimiters are placed at the end of the import or export file. They may 
be necessary when exchanging files with certain applications. 
Delimiters are used only when using Text and Fixed Length Text 
formats. The Fixed Length Text format does not use Field delimiters; 
generally, neither text format uses an explicit File delimiter.

1. This option allows you to pre-enter values in the Delimiters Page of the 
Import or Export editor. You can also modify them directly on this page. 
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The following figure shows a text file as displayed in a word processor. 
The file is in Text format. This word processor displays the Tab 
character as an arrow  and the Carriage return as a paragraph symbol 

This is a Text format file.

When importing data using the Text format, 4th Dimension uses the 
delimiters embedded in the file to determine where fields and records 
end. When exporting data, 4th Dimension automatically places these 
delimiters in the file for you.

Be certain that fields do not contain embedded characters that are also 
used as field or record delimiters. For example, if the Carriage return is 
used as the record delimiter, no field should contain a Carriage return. 
When importing data, 4th Dimension will interpret any Carriage 
return as a record delimiter. Thus, a Carriage return inside a field will 
be erroneously interpreted as the end of that record. An improperly 
placed Carriage return will disrupt the importing process.

When you export data that includes a Text field, a Carriage return 
might be embedded within a Text field. If this is a possibility, choose 
another record delimiter or remove the embedded Carriage returns 
prior to exporting the data.
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Using an ASCII Map
An ASCII map is sometimes needed when transferring information to 
or from other applications. On both Macintosh and Windows, the 
internal database engine and the 4th Dimension language work with 
the Macintosh extended ASCII set.

When entering data in Windows using the keyboard (adding records, 
editing methods, and so on) 4th Dimension automatically converts 
what comes from the keyboard (and is therefore expressed using the 
Windows ASCII set) to the Macintosh ASCII set. However, 
4th Dimension automatically converts the data back to Windows ASCII 
when exporting.

As a result, diacritical characters such as “é” or “ñ” will be correctly 
converted by 4th Dimension when you import or export data between 
Windows and MacOS versions of 4th Dimension. In this case, you do 
not need to create an ASCII map when you are importing or exporting 
data. However, if you are importing or exporting data between 
4th Dimension (Macintosh or Windows) and applications in the 
Windows environment, you will need to create an ASCII map if your 
data includes diacritical characters such as those shown above. 

The principle of the use of ASCII maps is described in the following 
figure:

The 4th Dimension Import and Export dialog boxes select the 
appropriate ASCII maps when you select the Windows file option, 
depending on the origin of the import file or the destination of the 
export file. 

4D MacOS

Other MacOS Application

Other Windows Application 

4D Windows
Import-export 
not requiring 
an ASCII map

Import-export 
requiring an 
ASCII map
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For more information, please refer to the section “Macintosh and 
Windows Files” on page 303. In this case, the use of an ASCII map is 
not necessary. 

However, in some cases, you may want to use a customized ASCII map, 
for example to filter diacritical characters in a special way. You can 
maintain two types of ASCII maps, input ASCII maps and output ASCII 
maps. You use an input ASCII map for importing data and an output 
ASCII map for exporting data. For further information about creating 
and using ASCII maps, refer to Appendix A on page 331.

An ASCII map can also be used when the language is used to import or 
export data or to send or receive data using the serial port. For more 
information about using ASCII maps in connection with the language, 
refer to the 4th Dimension Language Reference.

❿❿❿❿ To use an ASCII map:

1 Choose either Edit Input ASCII Map or Edit Output ASCII Map from 
the Special menu.
4th Dimension displays a dialog box you can use to edit an ASCII map.

2 Load or create your ASCII map.
For information on how to load or create an ASCII map, refer to 
Appendix A on page 331.

3 Click the Use map button.
Any subsequent import or export operations will use the ASCII map.

Importing Data
You can import data from files in XML, 4th Dimension, SYLK, DIFF, 
DBF, Text, or Fixed Length Text formats. If you are importing data that 
has been exported from another application, see that application’s doc-
umentation for information about exporting the data in one of these 
formats. If the other application uses a different format for exporting 
data, you may need to modify the file in advance using a text editor or 
word processor.

If you are importing data from another application running on the 
same platform as your database, first export the data using the other 
application. 
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Note the order in which the fields were exported, the format the 
application uses to save the data, and, if the Text format was used, the 
delimiters used by the application. When importing the data, you 
must match these settings.

You do not need to build your entire table structure before you import 
data. You can create the required tables directly from the Import dialog 
box.

You have the option of selecting the fields for which data will be 
imported in the Import dialog box or specifying an input form that 
contains the fields for which data will be imported. 

❿❿❿❿ To import data:

1 Choose Import Data from the File menu.
4th Dimension displays an open-file dialog box.

2 Select the type of file to be imported: XML, Text, DIFF, DBF, SYLK, or 
4IE (optional).
For more information about the type of files, please refer to the section 
“File Formats” on page 302. 

3 Select the file to import and click Open.
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The Import Editor appears:

The File area shows the pathname of the file to be imported. If you 
want to import another file, click the Browse button to choose the file.

4 In the Format area, select the type of the import file and its format 
(Macintosh or Windows).
For more information on these choices, please refer to the sections 
“File Formats” on page 302 and “Macintosh and Windows Files” on 
page 303. 

5 In the Table and Field Selection Area, choose the table and the fields 
into which you want to import the data. 
You can choose one of the following options:

■ Import data into an existing table and fields  Select a table from the 
Import Table drop-down list (by default the first table is selected). 
The hierarchical list allows you to view and select the fields into 
which you want to import data.

■ Create a new table for the data import  Check the Create Table 
check box. 4th Dimension will then create a new table into which it 
will import the data. 4th Dimension determines the number of 
fields and the type of each field according to the data being 
imported.

Table and Field 
Selection Area 

Command Area

Preview Area

Options Area

File Area

Format Area
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If you want to change the name of the new table or a field, double-
click on it in the Table and Field Selection area so that it becomes 
editable1. You can also change the data type for the new fields by 
clicking on the field’s title bar in the Preview Area. 
A pop-up menu displays the different types available. 

The table is created only during the import. If you cancel the import 
or deselect the option, the database structure remains unmodified.

Note With the Password Access System, you can deactivate the Create Table 
option to prevent users from creating a new table in the database from 
the Import Data dialog box. To do so, use the Preferences dialog box to 
create an access group that has access to the Design environment (of 
course, the 4th Dimension password access system must first be 
activated). Users not included in this access group are not allowed to 
select the Create Table option in the Import dialog box. For more 
information, please refer to the 4th Dimension Design Reference manual. 

■ Import data using a form  This option is discussed in detail in the 
section “Importing Data Using a Form” on page 311. 

The Preview Area displays the contents of the import file as columns of 
data. If you import data using a form, all the fields of the form are 
displayed. You can resize each column by selecting and dragging the 
boundaries of the title bar with the mouse. 

1. If the Text file contains a row of field names, you can instruct 
4th Dimension to use those names. For more information, please refer to the 
section “Header Page” on page 312. 
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6 If necessary, in the Preview Area, use the pop-up menus in the header 
area to select the fields into which each column in the import file will 
be imported.

Note This feature is not available if you checked the Create Table option or 
import data using a form. 

Resizing a column affects the number of characters allocated to the 
column if you are using the Fixed Length Text format. Otherwise, it 
only affects your view of the columns.

The title bar for each column indicates name of the field into which 
the column will be imported and its data type. If necessary, use the 
pop-up menu to select a different field: 

You can also select the Not imported option. In this case, the column 
of data is not imported. 

■ Value to Field  This button allows you to “intelligently” assign col-
umns from the import file to the fields in the table according to 
their type and not according to the order in which they appear. The 
data type of each column is estimated and it is assigned to a com-
patible field. The interpretation is done in the following manner: 

If no compatible field is found, the column is not imported. If you 
want to import the column, you must assign a field to it manually 
using the column’s pop-up menu in the header area in the Preview 
Area. 

Note This option is not available if you use a form for the import or if you 
check the Create Table box. 

Estimated Field Type 4D Type
All numbers Real (Number)
True/False Boolean
Date in one of 4D formats Date 
Time Time
Other Alpha

Value to Field 
button
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■ Number of characters for the Fixed Length Text file format  When 
importing a Fixed Length Text file, the Preview Area displays the 
number of characters for each column below the field’s data type 
icon. The number of characters assigned to each column is based on 
the first row of data. You can change the distribution of characters 
among the columns by dragging the column dividers in the header 
area or entering values in the field length areas, but you can’t add 
characters to the row.

7 In the Records area, indicate if the imported records should replace 
the current selection (the Replace option) or if they are to be added to 
the existing data (the Append option). 

8 Choose any other import options using the Header, Delimiters, Fill, 
XML and/or Format pages (optional).
These options are discussed in the section “Import Options” on 
page 312.

9 If you want to save your settings, click the Save Settings button. 
This option is discussed in the section “Saving and Loading Import and 
Export Settings” on page 326.

10 Click the Import button to begin importing the text file.
4th Dimension displays a progress indicator as it imports the data into 
your database. 

Importing Data 
Using a Form

If you want to import a text file into a form, click the Form tab located 
at the top of the Table and Field Selection Area. The advantage of using 
a form is that the form and object methods associated with the form 
are executed as each record is imported. This allows you to process data 
while importing data from the User environment (i.e., without writing 
a custom import routine).

The list of forms in the selected table is displayed, so that you can 
choose a form for the import. The data will be imported into the fields 
on the form using the entry order of the form.
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You can use forms that contain enterable variables and fields, but not 
buttons. The form method and the methods associated with variables 
and fields will be executed when each record is imported. Note, 
however, that the effects of these methods are not shown in the 
Preview area.

If you use a form for the import, please keep the following consider-
ations in mind:

■ The entry order of the form determines the order in which the col-
umns of data are imported. You should take care that the entry order of 
the form matches the order of the columns in the text file. 

■ If there are fewer fields and variables on the form than columns in the 
text file, extra columns will be ignored. 

■ A form used for import should not contain buttons. Also, subform 
objects are ignored.

Import Options 4th Dimension offers you various import options that are accessible 
through tabs in the Options area. The number of tabs (between 1 and 
5) as well as their contents vary and depend on the type of file used 
and the options selected.

Header Page This page is available only for imports from Text and Fixed Length Text 
files. Two options are available:

■ Import from line #: This option allows you to specify the first line in 
the text file that will be imported. Use this feature to tell 
4th Dimension to skip over header information — such as titles or field 
names — in the import file. It is particularly useful when the import 
file starts with unformatted lines (title, date, etc.) because the import 
columns are calculated according to the format of the first line. 

■ Column Titles as Field Name: This option tells 4th Dimension to use 
the column titles as field names if you have selected the Create Table 
option.
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Use these two options together, if needed. For example, if the import 
file starts with a title, followed by field names, followed by the first row 
of data, set the Import from Line # parameter to 2 and then check the 
Column Titles as Field Names check box.

Delimiters Page This page allows you to specify the field, record, and file delimiters 
used in Text and Fixed Length Text files.

Delimiters are discussed in detail in the section “Field, Record, and File 
Delimiters” on page 303. To change the default delimiters, use the 
drop-down lists to the left of each area. These menus contain the 
values most frequently used for each delimiter. 

You can also enter a delimiter into the entry areas on the right. 

The drop-down list at the top of the page allows you to view the 
delimiters in different formats: Character, Decimal (default format), 
and Hexadecimal. Please note that, if you use unprintable characters as 
delimiters (such as Tab, Linefeed, and Return), the Character option 
will not show anything. 

Note The delimiters are reset to their default values if you click the Default 
button or if the type of the document is modified in the File page. 
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XML Page This page is available for XML files only. It allows you to configure the 
parsing mode of the imported XML content. 

At the time of data import, 4th Dimension interprets the contents of 
the XML document in order to extract the information. By default, this 
operation is carried out without any specific validation. The XML 
document is assumed to be “well-formed”, meaning that its structure is 
correct and its interpretation is unambiguous. 

You can, however, request “validation” of the document at the time of 
import: to do this, check the Validation option. In this case, 
4th Dimension parses the contents of the document based on its DTD 
(Document Type Definition) and checks that it corresponds to this 
definition. Import is only carried out if the document is validated. 

Note For more information on the DTD, refer to the paragraph “XML Page” 
on page 322. 

If the DTD of the imported document is not included in the document 
itself, but is in a separate file, or if you want to use another DTD to 
validate the document, check the Use alternate DTD option and 
indicate the file containing the DTD using the Browse button.

Once the import is completed, the dialog box is closed and the table 
into which the data were imported becomes the current table. 
314 4th Dimension User Reference



Importing Data
Format Page This page is available for Text, Fixed Length Text and XML files. It 
allows you to set the formats for imported Boolean fields. 

The syntax to use is True_Value;False_Value. For example, if you import 
a column into a Boolean field whose values are “Black” (for true) and 
“White” (for false), you can enter Black;White. 
The combo-box displays the most commonly used Boolean formats. 
You can enter any format that is not in the combo-box.

Filling Page This page appears only for Fixed Length Text files. It allows you to 
define the fill characters to use for each data type. The default fill 
character is the space:

For more information about the Fixed Length Text file format, please 
refer to the section “File Formats” on page 302. 

Different fill characters can be used for three data types: 
Alpha/Boolean (Boolean fields are imported as alphas), Numeric 
(Integer, Longint, and Real) and Date/Time. 

Normally, the space is used to pad fixed format fields. The drop-down 
lists contain other choices. The entry areas to the right display the 
selected fill character. If you wish to use other characters, enter them 
directly in the entry areas.
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The menu at the top of the page allows you to view the fill characters 
in different formats: Character, Decimal (default format), and 
Hexadecimal. An unprintable fill character will not appear if you use 
the Character format.

Exporting Data
When you export data, you create a 4th Dimension, XML, SYLK, DIFF, 
DBF, Text, or Fixed Length Text file that can be opened by or imported 
by other applications. If you are exporting data for use with another 
application, see that application’s documentation for information 
about importing data. Choose a file format and delimiters compatible 
with the other application. 

In some cases, you need to use one or more export options to structure 
the export file correctly for the target application. For example, some 
programs accept the Text file format but require that the first record 
consist of the names of the fields. You can add this record using a 
Header option that is available in the Options Area. See the section, 
“Header Page” on page 321 for more information.

4th Dimension exports the records in the current sort order. You can 
choose to export all the records of a table or the current selection only. 

You have the option of selecting the fields to be exported in the Export 
Data dialog box or specifying a form. If you use a form, the fields on 
the form will be exported. 

❿❿❿❿ To export data:

1 Choose Export Data from the File menu.
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The Export Data dialog box appears.

2 Choose the export format from the Format drop-down list— Text, 
Fixed Length Text, DIFF, DBF, SYLK, XML, or 4IE.

For more information, please refer to the section “File Formats” on 
page 302. 

3 Choose the file type — Macintosh or Windows.
This option sets the record delimiters and ASCII map that will be used 
in the export file. For more information, see the section “Macintosh 
and Windows Files” on page 303.

4 Click the Browse button, enter a name and a location for the export 
file and click Save (optional). 
The Export Data dialog box reappears, with the export file’s pathname 
shown in the File area. This step does not start the export.

Note If you skip these steps, you can also specify the name and location of 
the export file when you click the Export button. 

Table and Field 
Selection Area 

Command Area

Preview Area

Options Area

Export format
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5 In the Table and Field Selection Area, select the table and the fields 
that you want to export. 
You can choose either of the following options:

■ Select the fields to export in the Export Data dialog box
If you use this option, choose a table from the Export From Table 
drop-down list to populate the Fields list with the eligible fields for 
the export. You then choose fields using the two blue buttons just 
above the Preview area. You can remove fields from the Preview area 
using the red buttons:

■ Export the data using a form
This option exports the fields on the form. This option is discussed 
in detail in the section “Exporting Data Using a Form” on page 320. 

6 In the Preview Area, modify the fields from which the data will be 
exported (optional).

Note This feature is not available if you export data using a form.

Several modifications can be made using the Preview Area:

■ Choosing other fields  The Preview area displays the contents of the 
export file as columns of data. The Header area for each column is a 
pop-up menu that you can use to change the field assigned to that 
column. 

■ Specifying the export format  The icon to the left of the field name 
indicates its data type. You can right-click (Control-click on Macin-
tosh) to display a contextual menu of formats that are appropriate 
for the column’s data type. If desired, choose a format from the con-
textual menu.

Inserts the selected field in the Preview Area 
Inserts all the fields in the table in the Preview Area
Removes the selected field from the Preview Area
Removes all the fields from the Preview Area 
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If you don’t assign a format, the Default Format is used. A format can 
also be selected in the Format options page. For more information, see 
the section “Format Page” on page 324.

■ Changing the lengths of Fixed Length Text fields  If you choose the 
Fixed Length text format, the Preview Area indicates the number of 
characters for each column. You can resize each column by drag-
ging the column divider in the title bar with the mouse. If you are 
using the Fixed Length Text format, this changes the number of 
characters allocated to the column in the export file. You can set the 
number of characters precisely by entering a value in the entry area 
below the field’s data type icon. The default number of characters is 
as follows: Text fields have a length of 80 characters, Alpha fields 
have the maximum length assigned in the Design environment, 
and numeric fields have a length of 10 characters.

The fill characters are added at the end of alphanumeric fields and 
at the beginning of numeric fields.

■ Removing fields from the export file  You can remove a column 
from the export file and the Preview Area. To do so, click the col-
umn’s header and click the Delete button in the button panel . To 
delete all the fields, click the Delete All button in the button panel 

.

7 In the Records area, indicate if you want to export all the records of 
the selected table (the Export all Records option) or only the current 
selection (the Export Selection option).
In both cases, the number of records to be exported is displayed in this 
area. 

Number of characters for 
the column

Number of 
records to be 
exported
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8 Specify any other export options using the Header, Delimiters, 
Format, XML, and Filling pages (optional).
These options are discussed in the section “Export Options” on 
page 320.

9 If you want to save your settings, click the Save Settings button. 
This feature is discussed in the section “Saving and Loading Import 
and Export Settings” on page 326. 

10 Click Export to begin exporting to the disk file.
If you have not specified the pathname for the export file (as described 
in step 4 on page 317), a standard save file dialog appears. 

4th Dimension displays a progress indicator while the data is being 
exported.

Exporting Data 
Using a Form

If you want to use a form for the export, click on the Form tab, located 
at the top of the Export dialog box. You can then choose a form from 
the list of forms for the selected table. 

The main advantage of using a form is that the form method and the 
object methods associated with fields and variables are executed when 
each record is exported. This allows you to process the data during the 
export. Fields and variables will be exported in the order specified by 
the entry order of the form. Note, however, that the effects of these 
methods are not shown in the Preview Area.

Do not place buttons on the form. Subform objects are ignored.

4D Server It is not possible to export data using a form that includes methods in 
a stored procedure on the server. In fact, since form events are not 
managed by the server, the associated methods will not be called. 

Export Options 4th Dimension offer you various export options that are accessible 
through tabs in the Options area. The number of tabs as well as their 
contents depend on the type of export file and the selected options.

This section describe all the Export options pages; some may only be 
available for certain export file types.
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Header Page This page is available for Text and Fixed Length Text exports only.

This page allows you to add a title, row of field names, and/or a record 
number to the export file: 

■ Title This option allows you to enter a title for the export docu-
ment. Enter the title in the area below the check box. 

■ Column Titles This option exports the field names as the first 
‘record’ in the export file. 

■ Line numbering This option numbers each line, which is each 
exported record. The numbering starts at 1 and increments by 1.

If Title is selected, it is the first row in the export file even if Column 
Titles is also selected. If Column Titles is selected, the field names fol-
low the title (if also present) and precede the first row of data; for Text 
files, the field names are separated by the field delimiter.

If Line Numbering is selected, the line number precedes the first field 
in each row, i.e., the first field as specified in the Preview Area becomes 
the second field, and so on.

Delimiters Page This page allows you to specify the delimiters used in Text and Fixed 
Length Text files. It is not relevant for other export file types.
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Delimiters are discussed in detail in the section “Field, Record, and File 
Delimiters” on page 303. To modify the delimiters, you can use the 
drop-down menus to the left of each area. These menus contain the 
values most frequently used for each delimiter type. 

You can also directly enter a delimiter in the area on the right. 

The menu at the top of the page allows you to modify or view the 
delimiters in different formats: Character, Decimal (default format), 
and Hexadecimal. Please note that if you use an unprintable character 
as a delimiter (such as a tab, linefeed, or return), the Character option 
will not show anything. The Decimal and Hexadecimal formats can 
display any character’s ASCII code.

Note The delimiters are reinitialized to their default value if you click the 
Default button or if the type of the document is modified in the File 
page. 

XML Page This page of parameters is available for XML exports only. It enables 
the configuration of the exported XML file contents:

■ Encoding
This pop-up menu is used to select the encoding (i.e. the set of charac-
ters) to be used for the XML document. The choice of encoding 
depends on the contents of the data to be exported and the application 
that will be using them. By default, ISO-8859-1 (ISO Latin 1, West Euro-
pean) coding is selected. 

■ DTD options
When exporting in XML format, 4th Dimension allows you the choice 
of whether or not to generate a DTD (Document Type Declaration). A 
DTD records the set of specific rules and properties that the XML must 
follow. These rules define, more particularly, the name and contents of 
each tag as well as its context. 
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This formalization of elements enables you to check an XML 
document to make sure it is “valid” and is particularly useful in the 
case of recurrent tags in an XML document. Note that a DTD is not 
mandatory. 

To define the handling of the DTD, you must select one of the three 
following options:

■ No DTD (default option): When this option is selected, a DTD is not 
generated during export. 

■ Generate DTD: generates a DTD during export. When this option is 
checked, the following subset of radio buttons enables you to spec-
ify the location of the DTD to be generated:
- Inside the XML Export: A DTD will be included in the XML file itself 
(internal DTD). The generated XML file is thus independent. 
- As specific document: A DTD will be generated in a separate file 
(external DTD). An external DTD can be shared between several 
users and thus enables the harmonization of XML document struc-
tures generated from different sources. 

Note 4th Dimension allows a table and a field to have the same name. 
However, the XML language prohibits the use of different elements 
having the same name. Consequently, when the “Generate DTD” 
option is used, the exported 4D data must not include a table and field 
having the same name, otherwise the XML file generated is invalid and 
cannot be opened by an XML parser. 

■  Refer to existing DTD: Using the associated Browse button, this 
option allows you to designate an existing external DTD file. 
4th Dimension will include a reference to this DTD in the exported 
file. 

■ XSL document
XSL (eXtensible Stylesheet Language) enables visual representation of the 
elements defined in an XML document. This language is used to sche-
matically define the style sheets that can be used to process and display 
the contents of an XSL document. 

Using the associated Browse button, the Refer to existing XSL option 
allows you to designate an XSL file. The exported XML file will 
therefore contain references to this XSL file. 
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■ Replacing spaces
The Replace spaces option causes “space” characters to be replaced by 
underlines (“_”) in value name fields of the XML file generated. This 
option is checked by default since spaces are not allowed in XML value 
name fields. 

However, it is possible to uncheck the option when necessary for 
specific purposes. In this case, of course, the generated file will not be 
in conformity with the general syntax rules defined by the W3C for 
XML.

Format Page This page allows you to set the export formats for Alpha, Numeric, 
Date, Time, and Boolean fields. This option is available for Text and 
Fixed Length Text exports. By default, 4th Dimension’s standard 
formats are used. 

❿❿❿❿ To assign an export format:

1 Select a column in the Preview Area.
The combo-box corresponding to its data type becomes enabled. 

2 Choose a format from the combo box or (for Alpha, Numeric, or 
Boolean data types) enter a custom format.

Note You can also set a column’s export format using the contextual menu 
in the column’s header are (see the section “Exporting Data” on 
page 316). 
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■ About Date Time Format

The DateTime display format is available for exporting date or time 
data. This format corresponds to the XML date and time 
representation standard (ISO8601 format). For example, in this format 
the date/time May 31, 2003 at 1:20 p.m. is noted 2003-05-31T13:20:00.

4th Dimension does not allow both a date and time to be stored in a 
single field. However, you can export data in this format so that the 
dates or times are recorded in conformity with the XML standard. If 
you export dates, the exported values will be of the style: 2003-05-
31T00:00:00; whereas if you export times, they will be of the style: 
0000-00-00T13:20:55. 

Note You can import XML data recorded in this format. They can be stored 
either in a date or time field, depending on the information that you 
want to keep. 

Filling Page This page is relevant only for Fixed Length Text exports. It allows you 
to define the fill character to use for each data type. You can specify a 
different fill character for Alpha/Boolean (Boolean fields are exported 
as Alpha fields), Numeric (Integer, Longint, and Real), and Date/Time

For a description of the Fixed Length Text file format, please refer to 
the section “File Formats” on page 302. 
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Most often, the Space character is used. The drop-down lists contain 
other possible values. The entry areas to the right display the charac-
ters selected. If you wish to use other characters, enter them directly in 
the entry areas. 

The drop-down list at the top of the page allows you to view the fill 
characters in different formats: Character, Decimal (default format), 
and Hexadecimal. Please note that an unprintable character will be 
invisible if you select the Character format. The Decimal and 
Hexadecimal formats can display any character’s ASCII code.

Saving and Loading Import and Export Settings
The import and export dialog boxes allow you to save and load your 
settings to and from disk. A settings file stores all the settings specified 
in the Import or Export editor: 

■ File name and its access path,

■ Tables and fields selected and the name of the form, the export uses 
a form,

■ Import and export options (file type, delimiters, etc.).

■ To save or load the import or export settings, click the corresponding 
button in the Command area: 

Import and export settings files have the extension “.4SI” on Windows 
(they are of type “4DSI” on MacOS).This feature allows you to 
automate the import or export process. Using a settings file is 
particularly useful in conjunction with the commands IMPORT DATA 
and EXPORT DATA. For more information, please refer to the 
4th Dimension Language Reference. 

Note An import/export settings file does not store filters because they are 
also related to the serial communication. If necessary, you will need to 
load an import or export filter before the operation. 

Save Settings Load Settings
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4th Dimension, as well as 4D Server and 4D Client have the ability to 
publish databases on the World Wide Web. When a database is 
published on the Web, a user can access the database using a Web 
browser such as Netscape or Microsoft Internet Explorer. A Web user 
can perform all the standard data management tasks, such as viewing, 
adding, modifying, and deleting records. You can design a Web site 
using 4th Dimension by creating forms that function as Web “pages” 
and using the 4th Dimension engine as the Web server. 

■ A 4D database can be published “as-is”, so that Web browsers connect 
in the same manner as the 4D Client in Custom menus environment.

■ You can also define custom methods and HTML pages to manage all 
the data sent and received by the Web server by programming.

When 4th Dimension publishes “as-is” a database on the Web, it 
transparently translates the database’s forms and design components 
into HTML pages. A Web user accesses the database through HTML 
versions of your custom menus and forms. You can also use 
4th Dimension to publish static HTML pages, prepared, for example, 
using a WYSIWYG HTML generator. You can also encapsulate HTML 
on a 4th Dimension form. Within the encapsulated HTML, you then 
can implement JavaScript code that performs actions and data control 
on the user’s Web browser, without requiring a request to be sent back 
to 4th Dimension.

When they become 4D clients, Web browsers are treated as “normal” 
database clients. For example, if a Web user modifies a record, 
4th Dimension automatically locks the record, preventing any other 
concurrent user (4th Dimension/4D Client or Web browser) from 
modifying it. After the user validates or cancels the data entry, 
4th Dimension automatically unlocks the record. 
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For a complete description of the process of setting up and managing a 
database as a Web site, see the section “Web Server” in the 
4th Dimension Language Reference manual.

The following subjects will be addressed in this chapter:

■ Conditions for publishing the database as a Web server

■ Publishing and stopping publication of a database from the User envi-
ronment.

Database publishing conditions
In order for a database to be published as a Web server, the following 
conditions must be met:

■ You must have a “Web Extension” license. For more information on 
this, please refer to the 4th Dimension Installation Manual. If you do not 
have such a license, the Web server will function as a demo for one 
hour.

■ Your computer must be connected to a network (Internet or Intranet) 
and the TCP/IP protocol must be installed on your operating system.

■ Under MacOS X, you should be logged as the root user (this user must 
have been activated previously), or you should have changed the 
default TCP port number for Web server publishing. For more informa-
tion, refer to the “Web server configuration and connection manage-
ment” section in the 4th Dimension Language Reference manual. 

Starting and Stopping Web Server
The 4D Web server is not completely automatic; it must be started and 
stopped by a database administrator.

Note The Web server can also be started and stopped by programming 
(using the START WEB SERVER and STOP WEB SERVER commands). For 
more information, please refer to the 4th Dimension Language Reference 
manual.
328 4th Dimension User Reference



Starting and Stopping Web Server
Starting Web Server

❿❿❿❿ To start the Web server:

1 Check that the publishing conditions are met. 
These conditions are described in the paragraph “Database publishing 
conditions” on page 328. 

2 Choose Start Web Server from the Web Server menu in the User 
environment (4th Dimension and 4D Client). 

OR
Choose Start Web Server from the Web menu (4D Server). 
The command is dimmed when the Web Server is already running. If 
the network is not available, a warning dialog box will inform you of 
the fact.

The “Web Server” process, intended to manage Internet and/or 
Intranet access to the database, is then opened and the database is 
accessible to browsers.

When a database is published on the Web, the access rights defined for 
the User and/or Custom Menus environments are preserved in their 
entirety. 
In the case of simultaneous and multiple accesses to the database (for 
example, when several different browsers connect to it), 
4th Dimension automatically ensures the control of data integrity and 
the locking of records if necessary. In this case, the control of data 
integrity is identical to that carried out during 4D Client connections.

While your database is published on the Web, you can continue to 
work in the User environment, or continue to develop the database 
using the Design environment.

Stopping Web 
Server

❿❿❿❿ To stop the Web server:

1 Choose Stop Web Server from the Web Server menu in the User 
environment (4th Dimension and 4D Client). 
OR
Choose Stop Web Server from the Web menu (4D Server). 
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The command is dimmed when the Web Server is not actually run-
ning. 

Choosing this command immediately stops the database publication 
on the Web.

4D Server Of course, this menu command does not stop database publication for 
4D Client machines.

Automatic 
publication

All databases created using 4th Dimension or 4D Server can be 
published as a Web server by default once it has been executed.

You can configure these settings in the Design environment, in the 
Preferences dialog box, Web/Publishing page: select Publish Database 
at Startup. For more information on this dialog box, please refer to the 
4th Dimension Design Reference manual.
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An ASCII map acts as a translation table for interpreting character 
codes when data is transferred to or from 4th Dimension. The transfer 
can be a file import or export or a transfer through the computer’s 
serial port.

In 4th Dimension for Windows and Macintosh, the internal database 
engine and 4th Dimension language use the Macintosh extended ASCII 
character set. When you edit an ASCII map using the dialog boxes 
described later in this chapter, the columns show the Macintosh 
extended ASCII character set by default. 

When you import or export data within the Windows environment, 
4th Dimension automatically converts the Macintosh ASCII codes to 
their equivalents in Windows. Since 4th Dimension converts the codes 
for you, you do not have to create an ASCII map when you are import-
ing or exporting data between 4th Dimension for Windows and other 
Windows applications.

If you are importing or exporting data between the Macintosh and 
Windows environments and if you don’t use the Windows File option 
in the Import or Export dialog box, you may need to create an ASCII 
map. When transferring data between Windows and Macintosh, the 
conversion can be done either during the import process or the export 
process. Whether you choose to perform the conversion during the 
export or import process depends on your own needs and the 
requirements of your source and destination applications.

4D Server If you are using 4D Server, any ASCII maps you create are stored locally 
on your client machine. 

ASCII codes for Macintosh and Windows are listed in the 4th Dimension 
Language Reference manual.
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Creating an ASCII Map
An ASCII map is a tool that 4th Dimension uses to interpret characters 
as they are transferred to or from another program or source. The map 
is used only during the transfer process. The transfer can be done in 
the User environment using the Import Data or Export Data 
commands in the File menu or using the commands in the language.

During the information transfer, the map is placed between 
4th Dimension and the source or destination file. The ASCII map is 
consulted for each character that is processed. For each character that 
is passed to the ASCII map, the map specifies the character to be 
returned. 

When you create an ASCII map, 4th Dimension first displays a default 
ASCII map. A default ASCII map always returns the same ASCII 
character that is passed. You can modify the map by changing the 
characters the map will return. You can change as few or as many 
entries in the map as you like.

Use the Edit Output ASCII Map and Edit Input ASCII Map menu 
commands to create, edit, load or save ASCII maps. You can create as 
many ASCII maps as you like.

Note If you create an ASCII map, you should also create a default ASCII map 
and save it as a disk file. Load the default ASCII map whenever you 
need to return to standard Windows or Macintosh ASCII.

❿❿❿❿ To create an ASCII map:

1 Choose either the Edit Output ASCII Map or Edit Input ASCII Map 
menu command from the Special menu.

Use the Edit Output ASCII Map menu command for exporting data and 
the Edit Input ASCII Map menu command for importing data.

4th Dimension displays either the Input ASCII Map or Output ASCII 
Map dialog box. In both dialog boxes, a scrollable area displays two 
sets of ASCII codes and characters in two columns: a 4D column and 
an ASCII column. 
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In the Output ASCII Map dialog box, the Mac column represents the 
characters sent from 4th Dimension during an export and the ASCII 
column represents the characters received by the other application. 
Notice that there is a one-to-one correspondence between these 
columns. 

In the Input ASCII Map dialog box, the ASCII column represents the 
characters received from the file being imported and the Mac column 
represents the characters being stored in the 4th Dimension database.

2 Click the ASCII code that you want to map. 
4th Dimension displays the ASCII code that the map returns in the 
ASCII Code box.

3 Enter an ASCII code for the character in the ASCII Code box.
The ASCII code you entered appears in the ASCII column in the scrol-
lable area.

ASCII Code box

Characters received by 
the other application

Characters sent from 
4th Dimension

ASCII Code box

Characters actually 
stored by 4th Dimension

Characters received 
from the imported file
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During data transfer, when 4th Dimension encounters the ASCII code 
that you mapped, it will substitute the ASCII code that you entered in 
the ASCII code box.

For example, if you wanted each uppercase “A” character in a file to be 
replaced by a lowercase “a”, you would map ASCII code 97 (lowercase 
a) to ASCII code 65 (uppercase A). Each time the ASCII map is sent an 
uppercase “A”, it will replace that character with a lowercase “a”. Your 
output file will contain a lowercase “a” in place of every uppercase “A” 
that was in the original file.

4 Modify as many additional codes as you require.

5 (Optional) Click the Save button to save the ASCII map to a disk file 
that can be loaded later for use or for editing.
The Windows extension for 4D ASCII filters is “.4FI”.

6 Click the Use Map button to apply the map you have edited or loaded.
When you transfer information after clicking the Use Map button, the 
current ASCII map will be used.

Loading an ASCII Map
❿❿❿❿ To load and use an ASCII map for exporting or importing data:

1 Choose either the Edit Output ASCII Map or Edit Input ASCII Map 
menu command from the Special menu.
Use the Edit Output ASCII Map menu command for exporting data 
and the Edit Input ASCII Map menu command for importing data.

4th Dimension displays either the Input ASCII Map or Output ASCII 
Map dialog box.

2 Click the Load button. 
A standard open-file dialog box appears. 

3 Select the ASCII map from the list of files.
The map specified by the file will be represented in either the Input 
ASCII Map or Output ASCII Map dialog box. 

If needed, modify any entries in the map.

4 Click the Use Map button to apply the map.

Note The same map loaded for both input and output carries out the 
translation in reverse. That is, if a map translates “A” to “a” during an 
import, it will translate “a” to “A” during an export.
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4D Draw. . . . . . . . . . . . . . . . . . . . . . . . . . . .  17
4D View . . . . . . . . . . . . . . . . . . . . . . . . . . . .  17
4D Write  . . . . . . . . . . . . . . . . . . . . . . . . . . .  17
4th Dimension

application.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  36
as single-user database   .  .  .  .  .  .  .  .  .  .  .  18
fields. See fields
Format (Import-Export) .  .  .  .  .  .  .  .  .  .  303
multi-tasking in   .  .  .  .  .  .  .  .  .  .  .  .  .  .  22

4th Dimension expressions. See expressions
4th Dimension forms. See forms
4th Dimension functions. See functions

A
About 4th Dimension  . . . . . . . . . . . . . . . . . .  36
Accept button

accepting records .  .  .  .  .  .  .  .  .  .  .   55, 101
adding records .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  76
saving new records  .  .  .  .  .  .  .  .  .  .  .  .  .  52

access privileges for databases . . . . . . . . . . . 26–28
ACCUMULATE command. . . . . . . . . . . . . . .  133
active objects

changing appearance of .  .  .  .  .  .  .  .  200–201
duplicating   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  199

Add Formula button
in Formula editor .  .  .  .  .  .  .  .  .  .  .  .  .  124
in Order By editor   .  .  .  .  .  .  .  .  .  .  .  .  125
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aligning objects . . . . . . . . . . . . . . . . . . .  196, 289
using alignment tools .  .  .  .  .  .  .  .  .  196–197

Alignment of text objects (Text menu) . . . . . .  279
alignment tools

Align Center Vertical tool .  .  .  .  .  .  .  .  .  197
Align Right tool   .  .  .  .  .  .  .  .  .  .  .  .  .  197

Alpha field formats  . . . . . . . . . . . . . . . . . . . .  59
in quick reports   .  .  .  .  .  .  .  .  .  .  .  .  .  176

And conjunction . . . . . . . . . . . . . . .  88, 100, 101
Append button (for choice lists). . . . . . . . . . . .  72
Arrow tool  . . . . . . . . . . . . . . . . . . . . . . . . .  275
As specific document (DTD)  . . . . . . . . . . . . .  323
ascending sorts . . . . . . . . . . . . . . . . . . . . . .  122
ASCII codes. . . . . . . . . . . . . . . . . . . . . . . . .  303
ASCII maps

creating  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  332–334
loading   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  334
using   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  305

at sign (@). . . . . . . . . . . . . . . . . . . . . . . . . . .  87
attributes

of axis labels, setting  .  .  .  .  .  .  .  .  .  269, 272
of axis titles, setting.  .  .  .  .  .  .  .  .  .  269, 272
of chart lines, setting  .  .  .  .  .  .  .  .  .  .  .  269
of chart objects, setting .  .  .  .  .  .  .  .  269, 270
of chart text, setting   .  .  .  .  .  .  .  .  .  .  .  272
of lines, setting .  .  .  .  .  .  .  .  .  .  .  .  .  .  277
of objects, setting .  .  .  .  .  .  .  .  .  .  .  .  .  277
of text, setting  .  .  .  .  .  .  .  .  .  .  .  .  .  .  279

Auto option  . . . . . . . . . . . . . . . . . . . . . . . .  254
Automatic Width check box (Quick Report 

editor) . . . . . . . . . . . . . . . . . . . . . .  157
axes

attributes of, setting   .  .  .  .  .  .  .  .  .  269, 270
customizing  .  .  .  .  .  .  .  .  .  .  .  .  .  250–257
positioning origins of .  .  .  .  .  .  .  .  .  .  .  255
reversing data order of   .  .  .  .  .  .  .  .  .  .  255

axis labels
adding.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  252
display formats for  .  .  .  .  .  .  .  .  .  .  .  .  253
displaying  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  252
for Boolean fields .  .  .  .  .  .  .  .  .  .  .  .  .  253
graphic attributes of, setting .  .  .  .  .  .  .  .  269
hiding .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  252
orientations for.  .  .  .  .  .  .  .  .  .  .  .  .  .  253
positions for  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  252
text attributes of, setting   .  .  .  .  .  .  .  .  .  272

axis scale
setting .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  254
using defaults for .  .  .  .  .  .  .  .  .  .  .  .  .  254

Axis submenu  . . . . . . . . . . . . . . . . . . . . . . .  251
axis titles

adding .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   256–257
graphic attributes of, setting  .  .  .  .  .  .  .  .  269
orientations for .  .  .  .  .  .  .  .  .  .  .  .  .  .  257
positions for  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  257
text attributes of, setting .  .  .  .  .  .  .  .  .  .  272

B
Boolean fields

as check boxes   .  .  .  .  .  .  .  .  .  .  .  .  . 62–63
as radio buttons .  .  .  .  .  .  .  .  .  .  .  .  . 62–63
default value  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   62
labelling  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  253
See also fields

borders
dialog box (Quick Report editor)  .  .  .  .  .  .  152
See also lines
setting  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  163
setting patterns of .  .  .  .  .  .  .  .  .  .  .  .  .  201

Break columns (description of) . . . . . . . . . . . .  175
break fields  . . . . . . . . . . . . . . . . . . . . . . . . .  132

labeling break rows  .  .  .  .  .  .  .  .  .  .  .  .  172
BREAK LEVEL command . . . . . . . . . . . . . . . .  133
break levels

description of .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  132
printing reports with   .  .  .  .  .  .  .  .  .  .  .  132
using in a report   .  .  .  .  .  .  .  .  .  .  .  .  .  171

break processing . . . . . . . . . . . . . . . . . . . . . .  132
buttons

page navigation .  .  .  .  .  .  .  .  .  .  .  .  .  .   57
record navigation .  .  .  .  .  .  .  .  .  .  .  .  .   56

C
C1...Cn (report variables). . . . . . . . . . . . . . . .  159
calculations

adding to reports  .  .  .  .  .  .  .  .  .  .   173–174
in quick reports .  .  .  .  .  .  .  .  .  .  .  .  .  .  173
performed by methods   .  .  .  .  .  .  .  .  .  .  299

Cancel button
canceling data entries  .  .  .  .  .  .  .  .  .  .  .   55
canceling searches.  .  .  .  .  .  .  .  .  .  .  .  .   95
discarding record changes  .  .  .  .  .  .  .  .  .   52
for choice lists   .  .  .  .  .  .  .  .  .  .  .  .  .  .   73

case sensitivity, in passwords . . . . . . . . . . . . . .  28
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categories
displaying in a graph .  .  .  .  .  .  .  .  .  258–261
grouping  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   245
see also Category axis
sorting in reports   .  .  .  .  .  .  .  .  .  .  .  .   171

Category axis (for a 2D graph), definition of. . .  222
Category axis (for a 3D graph)

definition of .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   230
selecting a field for .  .  .  .  .  .  .  .  .  .  .  .   241

Chart editor . . . . . . . . . . . . . . . . . . . . . . . . . .  34
chart objects

attributes of, setting  .  .  .  .  .  .  .  .  .  .  .   269
definition of .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   269
selecting   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   269

chart text (attributes of, setting) . . . . . . . . . . .  272
Chart tips  . . . . . . . . . . . . . . . . . . . . . . . . . .  267
Chart Tool palette. . . . . . . . . . . . . . . . . . . . .  237

displaying/hiding  .  .  .  .  .  .  .  .  .  .  .  .   214
Check boxes (formatting Boolean fields as)  . . . .  62
choice lists. . . . . . . . . . . . . . . . . . . . . . . .  71–73

modifying .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   72–73
using  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  71

Choice of Mode palette . . . . . . . . . . . . . . . . . .  65
Choose button (Choose Table/Form dialog box) .  79
Choose Print Form dialog box  . . . . . . . . . . . . .  31
Choose Table/Form dialog box . . . . . . . . . . . . .  30

using  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   77–79
circles (drawing) . . . . . . . . . . . . . . . . . .  275–276
Clipboard

copying graphs to  .  .  .  .  .  .  .  .  .  .  .  .   211
graphing data from   .  .  .  .  .  .  .  .  .  243–245
graphing dates from  .  .  .  .  .  .  .  .  .  .  .   242

closing plug-in windows  . . . . . . . . . . . . . . . .  213
color

in labels .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   201
of chart lines, setting .  .  .  .  .  .  .  .  .  .  .   271
of chart object borders, setting   .  .  .  .  .  .   271
of chart objects, setting .  .  .  .  .  .  .  .  269, 270
of chart text, setting  .  .  .  .  .  .  .  .  .  .  .   272
of lines, setting   .  .  .  .  .  .  .  .  .  .  .  .  .   277
of objects, setting   .  .  .  .  .  .  .  .  .  .  .  .   277
of text objects, setting  .  .  .  .  .  .  .  .  .  .   279

column indicators (Quick Report editor)  . . . . .  144
Column Titles as Field Name  . . . . . . . . . . . . .  312
Command–/ for creating records in subforms . . .  74
commands

ACCUMULATE   .  .  .  .  .  .  .  .  .  .  .  .  .   133
BREAK LEVEL  .  .  .  .  .  .  .  .  .  .  .  .  .  .   133

Commands list . . . . . . . . . . . . . . . . . . . . . . .  114

comparison operators. . . . . . . . . . . . . . . . . . .  86
conjunction operators

And  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  87
Except  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  88
in searches .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  94
Or .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  88

constraining graphic objects . . . . . . . . . . . . .  277
Create Merge Selection dialog box . . . . . . . . .  294
Create Table (Importing data) . . . . . . . . . . . .  308
create-file dialog box (saving quick report 

designs) . . . . . . . . . . . . . . . . . . . . .  140
creating

formulas .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  113–115
labels  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  192–195
log files  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  24
new documents   .  .  .  .  .  .  .  .  .  .  .  .  .  215
quick reports .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  139
records   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  75

crosshair/crossbar pointer (for creating objects)  196
Ctrl+clicking to select records . . . . . . . . . . . . .  50
Ctrl+Space bar to display List of Tables window .  79
Ctrl+Tab for creating records in subforms . . . . .  74
current selection

changing   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  21, 82
description of   .  .  .  .  .  .  .  .  .  .  .  20–21, 81
modifying records   .  .  .  .  .  .  .  .  .  .  .  .  108
multiple .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  82
printing records in  .  .  .  .  .  .  .  .  .  .  .  .  130
sorting.  .  .  .  .  .  .  .  .  .  .  .  .   123, 124–125

custom menus. . . . . . . . . . . . . . . . . . . . . . . .  36

D
data

editing.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  58
entering in subforms  .  .  .  .  .  .  .  .  .  .  74–76
entering using choice lists .  .  .  .  .  .  .  .  .  .  71
exporting  .  .  .  .  .  .  .  .  .  .  .   301, 316–320
graphing from a database  .  .  .  .  .  .  .  234–242
graphing from other applications   .  .  .  .  .  242
graphing from the Clipboard   .  .  .  .  .  .  .  242
importing  .  .  .  .  .  .  .  .  .  .  .   301, 306–311
in fields with attributes  .  .  .  .  .  .  .  .  .  68–73
reversing the order of .  .  .  .  .  .  .  .  .  .  .  255
updating in graphs  .  .  .  .  .  .  .  .  .  .  .  .  241

data entry
changing order .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  54
interrupting  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  58
3374th Dimension User Reference



Index
data files. . . . . . . . . . . . . . . . . . . . . . .  22, 39–45
segmenting   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  45

Data Import dialog box  . . . . . . . . . . . . . . . . .  30
data resource files  . . . . . . . . . . . . . . . .  23, 39, 40
data series. See series
databases

data files in   .  .  .  .  .  .  .  .  .  .   23, 39, 42–45
data resource files in   .  .  .  .  .  .  .  .  .  .  23, 39
entering password-protected.  .  .  .  .  .  .  26–28
graphing data from .  .  .  .  .  .  .  .  .  .  234–242
opening  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  42
pasting information from .  .  .  .  .  .  .  279–283
publishing conditions.  .  .  .  .  .  .  .  .  .  .  328
searching   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  84–89
structure files in   .  .  .  .  .  .  .  .  .  .  22, 39–45
structure resource files in  .  .  .  .  .  .  .  .  23, 39

Date fields (display formats for) . . . . . . . . . . . .  61
dates, graphing from the Clipboard . . . . . . . .  242
DateTime Format. . . . . . . . . . . . . . . . . . . . .  325
dBase format . . . . . . . . . . . . . . . . . . . . . . . .  302
DBF format . . . . . . . . . . . . . . . . . . . . . . . . .  302
Debug button . . . . . . . . . . . . . . . . . . . . . . .  299
default look (restoring in Label Wizard)  . . . . .  202
Default User Mode . . . . . . . . . . . . . . . . . . . . .  26
Delete button

deleting records   .  .  .  .  .  .  .  .  .   53, 57, 117
for choice lists  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  73

deleting objects (Label Wizard)  . . . . . . . . . . .  202
delimiters

embedded characters in .  .  .  .  .  .  .  .  .  .  304
specifying  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  313

depth (setting for graphs) . . . . . . . . . . . . . . .  264
Depth menu item  . . . . . . . . . . . . . . . . . . . .  265
descending sorts  . . . . . . . . . . . . . . . . . . . . .  122
Design environment

access to .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  26–28
designing reports in.  .  .  .  .  .  .  .  .  .  .  .  135
specifying default forms .  .  .  .  .  .  .  .  .  .  .  76
writing methods  .  .  .  .  .  .  .  .  .  .  .  .  .  .  22

Detail row in quick reports . . . . . . . . . . . . . .  160
DIF format . . . . . . . . . . . . . . . . . . . . . . . . .  302
directories, naming  . . . . . . . . . . . . . . . . . . . .  40
display formats

Alpha field formats .  .  .  .  .  .  .  .  .  .  .  .  .  59
assigning   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  177
Date field formats   .  .  .  .  .  .  .  .  .  .  .  .  .  61
for axis labels.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  253
for expressions .  .  .  .  .  .  .  .  .  .  .  .  285–286
for field references  .  .  .  .  .  .  .  .  .  .  285–286

for fields  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   58
for series values .  .  .  .  .  .  .  .  .  .  .  .  .  .  260
in quick reports .  .  .  .  .  .  .  .  .  .  .   176–178
Number field formats  .  .  .  .  .  .  .  .  .  .  .   59
Text field formats .  .  .  .  .  .  .  .  .  .  .  .  .   60
Time field formats.  .  .  .  .  .  .  .  .  .  .  .  .   61

Displaying lines and/or points option (Line and 
Scatter graphs) . . . . . . . . . . . . . . . . .  226

documents
clearing   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  215
creating   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  215
expressions in.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  283
field references in .  .  .  .  .  .  .  .  .  .   280–283
opening  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  216
printing   .  .  .  .  .  .  .  .  .  .  .  .  .  .   291–293
saving  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   216–219
saving as files (4D Chart)   .  .  .  .  .  .  .  .  .  217
saving as templates  .  .  .  .  .  .  .  .  .   218–219
setting size  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  220

Done button, choosing forms. . . . . . . . . . . . . .  79
drawing graphic objects. . . . . . . . . . . . .  275–276
drawing tools. See tools

E
Edit menu . . . . . . . . . . . . . . . . . . . . . . . .  31–32

Clear menu command .  .  .  .  .  .  .  .  .  .  .  118
Copy menu command.  .  .  .  .  .  .  .  .  .  .   58
Cut menu command   .  .  .  .  .  .  .  .  .  .  .   58
Edit Column menu command  .  .  .  .  .  .  .  158
Insert Column menu command   .  .  .  .  .  .  155
Paste menu command .  .  .  .  .  .  .  .  .  .  .   58
Select All menu command .  .  .  .  .  .  .  .  .   51
Undo menu command   .  .  .  .  .  .  .  .  .  .   58

editing legend text . . . . . . . . . . . . . . . . . . . .  263
elevation of 3D graphs, setting . . . . . . . . . . . .  265
Encoding (Exporting)  . . . . . . . . . . . . . . . . . .  322
Enter button

accepting modified records.  .  .  .  .  .  .  .  .  110
accepting records  .  .  .  .  .  .  .  .  .  .  .  .  .  107

Enter in List mode  . . . . . . . . . . . .  33, 48, 49, 111
Enter key . . . . . . . . . . . . . . . . . . . . . . . . . . . .  55
Enter menu . . . . . . . . . . . . . . . . . . . . . . . . . .  33

Apply Formula menu command  .  .  .  .  .  .   33
Enter in List menu command   .  .  .   33, 52, 107
Modify Record menu command  .  .  .  .  33, 109
New Record menu command.  .  .  .  33, 106, 107

Enter Password dialog box . . . . . . . . . . . . . . . .  27
entry filters  . . . . . . . . . . . . . . . . . . . . . . . . . .  70
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Index
environments (changing between)  . . . . . . . . . .  32
Except conjunction . . . . . . . . . . . . . . . . . . . . .  88
Execute button . . . . . . . . . . . . . . . . . . . . . . .  299
Execute Method dialog box  . . . . . . . . . . .  35, 297
Export

4D Chart document in PICT form .  .  .  .  .   220
Delimiters Page   .  .  .  .  .  .  .  .  .  .  .  .  .   321
Filling Page  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   325
Format page .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   324
Header Page .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   321
XML page .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   322

Export all Records option. . . . . . . . . . . . . . . .  319
Export Data dialog box  . . . . . . . . . . . . . .  30, 317
Export Selection as (File menu) . . . . . . . . . . . .  220
Export Selection option . . . . . . . . . . . . . . . . .  319
expressions

changing to text .  .  .  .  .  .  .  .  .  .  .  .  .   284
changing values to text .  .  .  .  .  .  .  .  .  .   284
evaluating .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   283
formatting   .  .  .  .  .  .  .  .  .  .  .  .  .  285–286
referencing  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   283
showing as references   .  .  .  .  .  .  .  .  .  .   284
showing as values  .  .  .  .  .  .  .  .  .  .  .  .   284
unreferencing  .  .  .  .  .  .  .  .  .  .  .  .  .  .   285
using in documents  .  .  .  .  .  .  .  .  .  .  .   283

F
field attributes . . . . . . . . . . . . . . . . . . . . .  68–73
field display formats . . . . . . . . . . . . . . . . . . . .  58

Alpha fields  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  59
Date fields.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  61
Number fields .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  59
Picture fields.  .  .  .  .  .  .  .  .  .  .  .  .  .   63–65
Text fields .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  60
Time fields   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  61

Field Format dialog box . . . . . . . . . . . . . . . . .  286
field references

changing to text .  .  .  .  .  .  .  .  .  .  .  .  .   284
changing values to text .  .  .  .  .  .  .  .  .  .   284
in plug-in windows   .  .  .  .  .  .  .  .  .  .  .   280
inserting   .  .  .  .  .  .  .  .  .  .  .  .  .  .  280–283
showing as references   .  .  .  .  .  .  .  .  .  .   284
showing as values  .  .  .  .  .  .  .  .  .  .  .  .   284
unreferencing  .  .  .  .  .  .  .  .  .  .  .  .  .  .   285

field types
Alpha .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  59
Boolean .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   62–63
Date   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  61

Integer.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  59
Long Integer .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  59
Picture.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  63–65
Real .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  59
Text .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  60
Time   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  61

fields
blank in label reports .  .  .  .  .  .  .  .  .  .  .  194
Boolean, labelling   .  .  .  .  .  .  .  .  .  .  .  .  253
entry filters for .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  70
graphing data from .  .  .  .  .  .  .  .  .  .  234–242
inserting in 4D Chart documents   .  .  .  280–283
invisible .  .  .  .  .  .  .  .  85, 114, 123, 144, 191
mandatory .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  68
see also field references
sorting indexed.  .  .  .  .  .  .  .  .  .  .  .  .  .  127
unique   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  69
updating graphs from .  .  .  .  .  .  .  .  .  .  .  241
using pop-up menu of   .  .  .  .  .  .  .  .  .  .  282

Fields list
in Order By editor   .  .  .  .  .  .  .  .  .  .  .  .  123
in Quick Report editor   .  .  .  .  .  .  .  .  .  .  144

file formats supported by 4th Dimension. . . . .  302
File menu . . . . . . . . . . . . . . . . . . . . . .  23, 30–31

Choose Table/Form menu command .  .  .  30, 77
Export Data menu command  .  .  .  .  .   30, 316
Import Data menu command  .  .  .  .  .   30, 307
Log File menu command  .  .  .  .  .  .  .  .  23, 30
No Log File menu command   .  .  .  .  .  .  26, 30
Open Database menu command .  .  .  .  .  30, 31
Page Setup menu command .  .  .  .  .  .  .  .  .  30
Print menu command   .  .  .  .  .  .  .  .  .  .  .  31
Quit menu command .  .  .  .  .  .  .  .  .  .  .  .  31

files
creating log   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  26
data .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  22–43
data resource .  .  .  .  .  .  .  .  .  .  .  .  23, 39, 40
naming  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  40
structure .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  22–43
structure resource.  .  .  .  .  .  .  .  .  .  .  .  23, 39

fill patterns, setting . . . . . . . . . . . . . . . . . . .  201
Filling Page (Export dialog box) . . . . . . . . . . .  325
First Page button . . . . . . . . . . . . . . . . . . . . . .  57
First Record button  . . . . . . . . . . . . . . . . . . . .  56
Fixed Length text format (Import-Export) . . . .  302
Flipped option for 3D Triangle graphs  . . . . . .  233
folders, naming of . . . . . . . . . . . . . . . . . . . . .  40
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font/font size
of chart text, setting   .  .  .  .  .  .  .  .  .  .  .  272
of text objects, setting.  .  .  .  .  .  .  .  .  .  .  279

Form editor
changing data entry order .  .  .  .  .  .  .  .  .  .  54
creating labels with .  .  .  .  .  .  .  .  .  .  .  .  189
reports in   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  135

Format menu item . . . . . . . . . . . . . . . . . . . .  285
Format page

Export .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  324
Import.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  315

formatting
axis labels  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  253
data for the Clipboard   .  .  .  .  .  .  .  .  .  .  242
references  .  .  .  .  .  .  .  .  .  .  .  .  .  .  285–286
series values  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  260

forms
4D Chart areas in .  .  .  .  .  .  .  .  .  .  .  .  .  213
changing between   .  .  .  .  .  .  .  .  .  .  .  .  .  80
choosing.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  77–80
custom menus  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  36
default input and output  .  .  .  .  .  .  .  .  .  .  78
graphing in   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  235
parent .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  74
printing 4D Chart areas with   .  .  .  .  .  .  .  292
role of .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  20
using 4D Chart in   .  .  .  .  .  .  .  .  .  .  213–214

Formula dialog box  . . . . . . . . . . . . . . . . . . .  247
Formula editor  . . . . . . . . . .  33, 34, 104, 113–116

constructing searches .  .  .  .  .  .  .  .  .  .  .  .  90
constructing sorts.  .  .  .  .  .  .  .  .  .  .  .  .  125
constructing sorts using .  .  .  .  .  .  .  .  .  .  126
formulas in quick reports  .  .  .  .  .  .  .  .  .  159
invisible tables and fields in .  .  .  .  .  .  .  .  114
performing global updates.  .  .  .  .  .  .  .  .  112
writing formulas  .  .  .  .  .  .  .  .  .  .  .  .  .  102

formulas
adding.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  247
adding to quick reports  .  .  .  .  .  .  .  .  .  .  158
building .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  115
sorting on  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  126
using with graphs   .  .  .  .  .  .  .  .  .  .  .  .  247

full-page forms  . . . . . . . . . . . . . . . . . . . . . . .  74
functions

graphing .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  246
See also expressions
Subtotal  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  133

G
Generate DTD option . . . . . . . . . . . . . . . . . .  323
global updates . . . . . . . . . . . . . . . . . . . . . . .  112

of records.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  105
Go to Full Window menu item. . . . . . . . . . . .  213
graph options

changing .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  248
descriptions of  .  .  .  .  .  .  .  .  .  .  .   224–234

graph size, changing . . . . . . . . . . . . . . . . . . .  249
graph types

2D XY  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  228
3D Area   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  232
3D Column .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  230
3D Line   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  231
3D Spike  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  234
3D Triangle .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  233
Area  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  223
Bar.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  224
changing .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  247
Column  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  224
Line  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  225
options for  .  .  .  .  .  .  .  .  .  .  .  .  .   224–234
Picture .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  227
Pie .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  226
Polar .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  228
Scatter  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  225
Surface .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  232

graphic objects
changing appearance of  .  .  .  .  .  .  .   200–201
See also objects
specifying fill patterns .  .  .  .  .  .  .  .  .  .  .  201

graphing
4th Dimension functions.  .  .  .  .  .  .  .  .  .  246
data from other applications .  .  .  .  .  .  .  .  242
data from the Clipboard .  .  .  .  .  .  .   242–245
data from the database   .  .  .  .  .  .  .   235–242
dates from the Clipboard   .  .  .  .  .  .  .  .  .  242
in forms  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  235
in plug-in windows  .  .  .  .  .  .  .  .  .  .  .  .  235

graphs
Auto option   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  254
creating from data in the database  .  .   234–242
creating from data on the Clipboard  .   242–245
modifying  .  .  .  .  .  .  .  .  .  .  .  .  .   249–274
printing   .  .  .  .  .  .  .  .  .  .  .  .  .  .   291–295
resizing with the mouse  .  .  .  .  .  .  .  .  .  .  250
Showing One Label out of  .  .  .  .  .  .  .  .  .  254
updating data in   .  .  .  .  .  .  .  .  .  .  .  .  .  241
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grid lines
attributes of, setting  .  .  .  .  .  .  .  .  .  .  .   269
displaying and hiding   .  .  .  .  .  .  .  .  .  .   257

Grid Lines submenu  . . . . . . . . . . . . . . . . . . .  258
Group Category check box. . . . . . . .  241, 245, 246
Group menu item . . . . . . . . . . . . . . . . . . . . .  291
Group Series check box . . . . . . . . . . . . . . . . .  241
grouping

categories .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   245
objects  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  290–291
series  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   245

H
Header Page

Export   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   321
Import  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   312

Headers and Footers dialog box (Quick Report 
editor). . . . . . . . . . . . . . . . . . . . . . .  180

Help menu  . . . . . . . . . . . . . . . . . . . . . . . . . .  36
Horizontal option

for Area graphs   .  .  .  .  .  .  .  .  .  .  .  .  .   224
for Column graphs .  .  .  .  .  .  .  .  .  .  .  .   225
for Line graphs   .  .  .  .  .  .  .  .  .  .  .  .  .   226
for Picture graphs  .  .  .  .  .  .  .  .  .  .  .  .   227

I
Import

Delimiters Page   .  .  .  .  .  .  .  .  .  .  .  .  .   313
Format page .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   315
Header Page .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   312
PICT document  .  .  .  .  .  .  .  .  .  .  .  .  .   219
XML page .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   314

Import from line #  . . . . . . . . . . . . . . . . . . . .  312
Import-Export

Filling Page  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   315
Save Settings.  .  .  .  .  .  .  .  .  .  .  .  .  .  .   326
Settings .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   326

indexed fields, sorting on. . . . . . . . . . . . . . . .  127
indexed searches. . . . . . . . . . . . . . . . . . . . . . .  86
Input ASCII Map dialog box . . . . . . . . . . . . . .  333
input forms

adding new records   .  .  .  .  .  .  .  .  .  106–107
deleting records  .  .  .  .  .  .  .  .  .  .  .  .  .   117
modifying records in .  .  .  .  .  .  .  .  .  .  .   109
role of   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  20
searching in .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  85
using  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   52–58

Insert button (for choice lists) . . . . . . . . . . . . .  73
Inside the XML Export (DTD) . . . . . . . . . . . .  323
ISO-8859-1 . . . . . . . . . . . . . . . . . . . . . . . . .  322
Items in List dialog box  . . . . . . . . . . . . . . . . .  72

J
justification of text objects, setting  . . . . . . . .  279

K
keyboard equivalents (creating new records) . . .  75

L
Label Wizard. . . . . . . . . . . . . . . . . . . . . . . . .  34

concatenating data .  .  .  .  .  .  .  .  .  .  .  .  194
deleting objects   .  .  .  .  .  .  .  .  .  .  .  .  .  202
description of   .  .  .  .  .  .  .  .  .   189, 189–190
invisible tables and fields in .  .  .  .  .  .  .  .  191
Label Preview area  .  .  .  .  .  .  .  .  .  .  .  .  206
opening .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  190
toolbar   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  192

labels
creating  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  192–195
layouts for reports   .  .  .  .  .  .  .  .  .  .  205–208
printing  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  209
saving design of   .  .  .  .  .  .  .  .  .  .  .  .  .  208
See axis labels
Showing One out of   .  .  .  .  .  .  .  .  .  .  .  254

Last Page button . . . . . . . . . . . . . . . . . . . . . .  57
Last Record button. . . . . . . . . . . . . . . . . . . . .  56
layering

Move to Back menu item  .  .  .  .  .  .  .  198–199
Move to Front menu item .  .  .  .  .  .  .  198–199

layouts for labels . . . . . . . . . . . . . . . . . .  205–208
Legend dialog box . . . . . . . . . . . . . . . . . . . .  263
Legend menu item. . . . . . . . . . . . .  261, 262, 263
legend text (editing). . . . . . . . . . . . . . . . . . .  263
legends

displaying  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  261
graphic attributes of, setting .  .  .  .  .  .  .  .  270
hiding .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  261
reversing key and text.  .  .  .  .  .  .  .  .  .  .  263
reversing series order  .  .  .  .  .  .  .  .  .  .  .  263
text attributes of, setting   .  .  .  .  .  .  .  .  .  272
text of, customizing   .  .  .  .  .  .  .  .  .  .  .  263

licenses (updating). . . . . . . . . . . . . . . . . . . . .  36
Line tool  . . . . . . . . . . . . . . . . . . . . . . . . . .  275
3414th Dimension User Reference



Index
line width (Label Wizard) . . . . . . . . . . . . . . .  202
lines

attributes of, setting   .  .  .  .  .  .  .  .  .  269, 277
drawing  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  275–276

Lines appearance option (2D XY graph types) .  228
List of Tables window. . . . . . . . . . . . . .  77, 79–80
lists

choice .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  71–73
excluded .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  71

Lock icon in Enter Password dialog box  . . . . . .  28
locked records . . . . . . . . . . . . . . . . . . . . . . .  109

deleting  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  119
locking, tools (graphs)  . . . . . . . . . . . . . . . . .  276
log files

creating  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  24
creating for 4D Backup  .  .  .  .  .  .  .  .  .  .  .  26
file extension for .  .  .  .  .  .  .  .  .  .  .  .  .  .  24
on 4D Server .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  26
opening  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  23
using across platforms   .  .  .  .  .  .  .  .  .  .  .  25

M
Mandatory attribute. . . . . . . . . . . . . . . . . . . .  68
Many table . . . . . . . . . . . . . . . . . . . . . . . . . .  91
maximum and minimum values . . . . . . . . . . .  69
menu bar . . . . . . . . . . . . . . . . . . . . . . . . . .  213

custom   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  36
displaying  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  214
hiding .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  214

methods (executing)  . . . . . . . . . . . . . . . . . .  298
Modify button, for choice lists. . . . . . . . . . . . .  72
Move to Back menu item  . . . . . . . . . . . .  198–199
Move to Front menu item . . . . . . . . . . . .  198–199
multi-line forms  . . . . . . . . . . . . . . . . . . . . . .  74
multi-tasking  . . . . . . . . . . . . . . . . . . . . . . . .  19

using processes .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  22

N
New Chart menu item . . . . . . . . . . . . . . . . .  237
New menu item. . . . . . . . . . . . . . . . . . . . . .  215
New Process check box . . . . . . . . . . . . . .  297, 298
Next Page button. . . . . . . . . . . . . . . . . . .  57, 131
Next Record button . . . . . . . . . . . . . . . . . . . .  56
No DTD . . . . . . . . . . . . . . . . . . . . . . . . . . .  323
Number field formats . . . . . . . . . . . . . . . . . . .  59

O
Object menu

Move to Back menu item   .  .  .  .  .  .  .  .  .  198
Move to Front menu item  .  .  .  .  .  .  .  .  .  198

Object Tool palette
displaying/hiding .  .  .  .  .  .  .  .  .  .  .  .  .  214
using to draw objects  .  .  .  .  .  .  .  .  .  .  .  275

objects
aligning   .  .  .  .  .  .  .  .  .  .  .  .  .  .   196–197
arranging .  .  .  .  .  .  .  .  .  .  .  .  .  .   287–291
attributes of, setting .  .  .  .  .  .  .  .  .  .  .  .  277
border patterns  .  .  .  .  .  .  .  .  .  .  .  .  .  .  201
borders of, setting .  .  .  .  .  .  .  .  .  .  .  .  .  277
constraining  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  277
drawing   .  .  .  .  .  .  .  .  .  .  .  .  .  .   275–276
duplicating .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  199
fill attributes of, setting  .  .  .  .  .  .  .  .  .  .  277
fill patterns for  .  .  .  .  .  .  .  .  .  .  .  .  .  .  201
grouping .  .  .  .  .  .  .  .  .  .  .  .  .  .   290–291
layering   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  198
line attributes of, setting .  .  .  .  .  .  .  .  .  .  277
resizing with the mouse  .  .  .  .  .  .  .  .  .  .  286
setting color of  .  .  .  .  .  .  .  .  .  .  .  .  .  .  201
stacking order of, setting.  .  .  .  .  .  .  .  .  .  288
ungrouping .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  291

One table  . . . . . . . . . . . . . . . . . . . . . . . . . . .  91
Open Data File dialog box . . . . . . . . . . . . . . . .  41
Open Database dialog box . . . . . . . . . . . . . . . .  30
Open menu item  . . . . . . . . . . . . . . . . . . . . .  216
Open Subform button . . . . . . . . . . . . . . . . . . .  76
open-file dialog box (choosing label design files) 209
opening

documents  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  216
new documents .  .  .  .  .  .  .  .  .  .  .  .  .  .  215
plug-in windows   .  .  .  .  .  .  .  .  .  .  .  .  .  212

Operators toolbar (Formula editor) . . . . . . . . .  113
Options (DTD) . . . . . . . . . . . . . . . . . . . . . . .  322
options for graphs, changing . . . . . . . . . . . . .  248
Options menu item (Chart menu)  . . . . . . . . .  249
Or conjunction. . . . . . . . . . . . . . . . . . . . . . . .  88
Order By button . . . . . . . . . . . . . . . . . . . . . .  126
Order By editor  . . . . . . . . . . . . . . . . . . .  34, 123
Order By menu command . . . . . . . . . . .  124–126
origins of axes, positioning  . . . . . . . . . . . . . .  255
Output ASCII Map dialog box  . . . . . . . . . . . .  333
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output forms
adding records .  .  .  .  .  .  .  .   51–52, 107–108
deleting records  .  .  .  .  .  .  .  .  .  .  .  .  .   118
Enter in List mode .  .  .  .  .  .  .  .  .  .  .  .  .  49
modifying records  .  .  .  .  .  .   51–52, 110–111
role of   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   20, 48
searching in .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  85
selecting records in.  .  .  .  .  .  .  .  .  .  .  .  .  50
using  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   49–52

Oval tool . . . . . . . . . . . . . . . . . . . . . . . . . . .  275
ovals (drawing). . . . . . . . . . . . . . . . . . .  275–276

P
Page Setup dialog box . . . . . . . . . . . . . .  130, 133

printing .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  30
parent forms  . . . . . . . . . . . . . . . . . . . . . . . . .  74
password access system . . . . . . . . . . . . . . .  26–28
Passwords (Web server) . . . . . . . . . . . . . . . . . .  28
Paste Field menu item . . . . . . . . . . . . . . . . . .  281
pattern

of chart objects, setting .  .  .  .  .  .  .  .  .  .   269
of lines, setting   .  .  .  .  .  .  .  .  .  .  .  .  .   277
of objects, setting   .  .  .  .  .  .  .  .  .  .  .  .   277

percentages
displaying in a graph .  .  .  .  .  .  .  .  .  258–261
graphing   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   227

perspective (of 3D graphs, setting)  . . . . . . . . .  265
PICT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  220

4D Chart document  .  .  .  .  .  .  .  .  .  .  .   220
Exporting a 4D Chart document   .  .  .  .  .   220
Importing in a 4D Chart window  .  .  .  .  .   219

picture charts
See also two-dimensional graphs

Picture fields  . . . . . . . . . . . . . . . . . . . . . .  63–65
entering pictures in   .  .  .  .  .  .  .  .  .  .  .  .  63
on background   .  .  .  .  .  .  .  .  .  .  .  .  .  .  65
scaling to fit .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  64
truncating .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   63–64

pictures
adjusting in Picture graphs  .  .  .  .  .  .  .  .   273
picture charts  .  .  .  .  .  .  .  .  .  .  .  .  .  .   273

pie charts
exploding .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   272
rotating .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   227
See also two-dimenional graphs

Plots shapes option (2D XY graph type) . . . . . .  228
plug-in areas. See 4D Chart areas

plug-in windows
closing   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  213
graphing in   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  235
opening .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  212
using 4D Chart in   .  .  .  .  .  .  .  .  .  .  212–213
using field references in .  .  .  .  .  .  .  .  .  .  280

Plug-Ins menu. . . . . . . . . . . . . . . . . . . . . . . .  36
pointers

crosshair/crossbar.  .  .  .  .  .  .  .  .  .  .  .  .  196
multi-directional arrow .  .  .  .  .  .  .  .  .  .  200

Polygon tool . . . . . . . . . . . . . . . . . . . . . . . .  275
polygons (drawing)  . . . . . . . . . . . . . . . .  275–276
preferences, setting  . . . . . . . . . . . . . . . . . . .  221
Preview on Screen check box. . . . . .  131–132, 133
Previous Page button . . . . . . . . . . . . . . . . . . .  57
Previous Record button  . . . . . . . . . . . . . . . . .  56
Print dialog box. . . . . . . . . . . . . . . . . . .  131, 133
Print Form dialog box  . . . . . . . . . . . . . .  130, 133
Print menu item  . . . . . . . . . . . . . . . . . . . . .  292
Print Merge menu item  . . . . . . . . . . . . . . . .  294
print merges, creating  . . . . . . . . . . . . . . . . .  293
print order, setting in 4D Chart . . . . . . . . . . .  291
Print with Variable Frame check box  . . . . . . . .  64
printing documents . . . . . . . . . . . . . . . .  291–293

as part of a record   .  .  .  .  .  .  .  .  .  .  .  .  292
in a print merge  .  .  .  .  .  .  .  .  .  .  .  293–295
to a graph  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  186

processes
current selections with  .  .  .  .  .  .  .  .  .  .  .  82
deleting records   .  .  .  .  .  .  .  .  .  .  .  .  .  119
for multi-tasking  .  .  .  .  .  .  .  .  .  .  .  .  .  .  22
locked records  .  .  .  .  .  .  .  .  .  .  .  .  .  .  109

Properties menu item (4D Chart) . . . . . . .  220, 292

Q
Queries menu . . . . . . . . . . . . . . . . . . . . . . 33, 89

Order By menu command .  .  .  .  .  .  .  .  .  .  34
Query and Modify menu command  .  .   34, 101
Query by Example menu command  . 21, 34, 100
Query by Formula menu command   .  .   34, 104
Query Editor menu command .  .  .  .  .  .  .  .  92
Query menu command .  .  .  .  .  .  .  .  .  .  .  34
search menu commands   .  .  .  .  .  .  .  .  .  .  89
Show All menu command .  .  .  .  .  .  21, 33, 83
Show Subset menu command  .  .  .  .  .  .  33, 83

Query and Modify command  . . . . . . . . . .  89, 100
Query by Example menu command . . . . . . . . .  89
Query by Example searches. . . . . . . . . . . .  98–100
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Query by Example window . . . . . . . . . . . . . 98, 99
Query by Formula editor. . . . . . . . . . . . .  102–104
Query by Formula menu command . . . . . . . . .  90
Query editor . . . . . . . . . . . . . . . . .  34, 88, 90–97

description of   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  91
invisible tables and fields in .  .  .  .  .  .  .  .  .  85

Query in Selection button. . . . . . . . . . . . . . . .  92
Query menu command  . . . . . . . . . . . . . . . . .  89
Quick Report editor . . . . . . . . . . . . . . . . .  34, 129

cells .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  144
description of   .  .  .  .  .  .  .  .  .   135, 142–145
invisible files and fields in .  .  .  .  .  .  .  .  .  144
sizing columns .  .  .  .  .  .  .  .  .  .  .  .  .  .  157
sorting records .  .  .  .  .  .  .  .  .  .  .  .  124, 167

quick reports
adding columns to  .  .  .  .  .  .  .  .  .  .  .  .  154
adding text to  .  .  .  .  .  .  .  .  .  .  .  .  .  .  153
break levels in  .  .  .  .  .  .  .  .  .  .  .  .  .  .  171
C1...Cn (report variables)  .  .  .  .  .  .  .  .  .  159
calculations in  .  .  .  .  .  .  .  .  .  .  .  .  .  .  173
contextual menus   .  .  .  .  .  .  .  .  .  .  147–148
creating  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  139
formulas in   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  158
hiding columns and rows .  .  .  .  .  .  .  .  .  178
loading designs.  .  .  .  .  .  .  .  .  .  .  .  .  .  140
printing  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  181
printing options  .  .  .  .  .  .  .  .  .  .  .  .  .  184
printing to disk.  .  .  .  .  .  .  .  .  .  .  .  .  .  185
saving .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  140
sizing columns in.  .  .  .  .  .  .  .  .  .  .  157–158
specifying font size .  .  .  .  .  .  .  .  .  .  .  .  160
specifying fonts   .  .  .  .  .  .  .  .  .  .  .  .  .  160
specifying justification  .  .  .  .  .  .  .  .  .  .  160
specifying style .  .  .  .  .  .  .  .  .  .  .  .  .  .  160
using display formats in .  .  .  .  .  .  .  .  176–178

QuickTime Compression  . . . . . . . . . . . . . . . .  66

R
radio buttons (formatting Boolean fields as)  . . .  62
records

adding.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  106–108
creating  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  75
deleting  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  117–119
deleting locked .  .  .  .  .  .  .  .  .  .  .  .  .  .  119
entering in input forms .  .  .  .  .  .  .  .  .  .  .  52
entering in output forms  .  .  .  .  .  .  .  .  51–52
entering in subforms  .  .  .  .  .  .  .  .  .  .  .  .  74
graphing .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  234–242

locked  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  109
modifying  .  .  .  .  .  .  .  .  .  .  .  .  .   108–111
modifying in output forms.  .  .  .  .  .  .  . 51–52
navigation buttons for .  .  .  .  .  .  .  .  .  .  .   56
saving 4D Chart areas with.  .  .  .  .  .  .  .  .  217
selecting  .  .  .  .  .  .  .  .  .  .  .  .  .  .  20–21, 83
selecting in output forms   .  .  .  .  .  .  .  .  .   50
sorting .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   121–127
sorting for reports .  .  .  .  .  .  .  .  .  .  .  .  .  132
updating globally .  .  .  .  .  .  .  .  .  .  .  .  .  112

Rectangle tool  . . . . . . . . . . . . . . . . . . . . . . .  275
rectangles (drawing) . . . . . . . . . . . . . . .  275–276
Refer to existing DTD  . . . . . . . . . . . . . . . . . .  323
Refer to existing XSL . . . . . . . . . . . . . . . . . . .  323
Reference menu item  . . . . . . . . . . . . . . . . . .  283
references

changing to text   .  .  .  .  .  .  .  .  .  .  .  .  .  284
displaying   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  284
formatting  .  .  .  .  .  .  .  .  .  .  .  .  .   285–286
see also field references

related tables . . . . . . . . . . . . . . . . . . . . . . . . .  74
searches on .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   91
searching on fields in  .  .  .  .  .  .  .  .  .  .  .   96

Replace spaces (XML)  . . . . . . . . . . . . . . . . . .  324
Report menu . . . . . . . . . . . . . . . . . . . . . . . . .  34

Chart menu command   .  .  .  .  .  .  .  .  .  .   34
Labels menu command  .  .  .  .  .  .  .  .  34, 190
Quick menu command   .  .  .  .  .  .  .  .  34, 139

reports
creating with forms  .  .  .  .  .  .  .  .  .  .  .  .  129
printing standard  .  .  .  .  .  .  .  .  .  .   130–132
printing with break levels  .  .  .  .  .  .   132–133

resizing
automatic for labels .  .  .  .  .  .  .  .  .  .  .  .  204
graphs  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  249
graphs with the mouse   .  .  .  .  .  .  .  .  .  .  250
handles   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  200
objects (graphs) .  .  .  .  .  .  .  .  .  .  .  .  .  .  286
objects (labels)  .  .  .  .  .  .  .  .  .  .  .  .  .  .  200
objects with the mouse   .  .  .  .  .  .  .  .  .  .  286

Return to Form menu item  . . . . . . . . . . . . . .  214
rotation

of 3D graphs, setting   .  .  .  .  .  .  .  .  .  .  .  265
of axis labels, setting   .  .  .  .  .  .  .  .  .  .  .  253
of axis titles, setting .  .  .  .  .  .  .  .  .  .  .  .  257
of pie charts   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  227

Rounded rectangle tool . . . . . . . . . . . . . . . . .  275
rounding rectangle corners  . . . . . . . . . . . . . .  277
rulers, displaying/hiding . . . . . . . . . . . . . . . .  214
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Index
Run Compiled Mode (Use menu)  . . . . . . . . . . .  32
Run Interpreted Mode (Use menu)  . . . . . . . . . .  32

S
Save as menu item  . . . . . . . . . . . . . . . . . . . .  217
Save as Template menu item  . . . . . . . . . . . . .  218
saving documents. . . . . . . . . . . . . . . . .  217–219

as desktop files.  .  .  .  .  .  .  .  .  .  .  .  .  .   217
as templates .  .  .  .  .  .  .  .  .  .  .  .  .  218–219
with 4th Dimension records.  .  .  .  .  .  .  .   217

scale of the Values axis, setting . . . . . . . . . . . .  254
scroll bars, displaying/hiding . . . . . . . . . . . . .  214
scrolling

in quick reports  .  .  .  .  .  .  .  .  .  .  .  .  .   145
in text fields .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  60

search conditions
combining   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  87
elements of  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  84
modifying .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  95
removing  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  95
saving to disk  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  90

searches. . . . . . . . . . . . . . . . . . . . . . . . . .  84–85
comparison operators   .  .  .  .  .  .  .  .  .   86–87
compound   .  .  .  .  .  .  .  .  .  .  .  .  .  .   87–89
indexed .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  86
sequential .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  86
simple   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   87–89

selection handles, definition of. . . . . . . . . . . .  249
series (graphic attributes of, setting)  . . . . . . . .  269
Series axis

definition of .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   230
selecting a field for .  .  .  .  .  .  .  .  .  .  .  .   240

series values
display formats for .  .  .  .  .  .  .  .  .  .  .  .   260
displaying in a graph .  .  .  .  .  .  .  .  .  258–261
graphic attributes of, setting   .  .  .  .  .  .  .   270
see also values
text attributes of, setting  .  .  .  .  .  .  .  .  .   272

Shift key to constrain object shape  . . . . . . . . .  196
Shift+clicking for selecting records  . . . . . . . . . .  50
Show Both Points option (Line and/or 

Stacked graphs)  . . . . . . . . . . . . . . . .  226
Show Lines option (Line and/or Stacked graphs)  226
Show Points option (Line and/or Stacked 

graphs) . . . . . . . . . . . . . . . . . . . . . .  226
Show References menu item. . . . . . . . . . . . . .  284
Show Regression Line option (2D XY graph 

types) . . . . . . . . . . . . . . . . . . . . . . .  228

Show Values menu item . . . . . . . . . . . . . . . .  284
Showing One Label out of (graph option) . . . .  254
size

font attribute.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  149
of columns (automatic) .  .  .  .  .  .  .  .  .  .  157
of labels (radio button)  .  .  .  .  .  .  .  .  .  .  204
of objects (labels) .  .  .  .  .  .  .  .  .  .  .  .  .  200
of objects, changing   .  .  .  .  .  .  .  .  .  200, 286
of page (radio button in Label editor)   .  .  .  204
See also resizing
setting for 4D Chart document   .  .  .  .  .  .  220

Sort area (Order By editor)  . . . . . . . . . . . . . .  126
Sort button for choice lists  . . . . . . . . . . . . . . .  73
Sort list (Quick Report editor)  . . . . . . . . . . . .  145
sorts

ascending  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  122
descending.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  122
levels  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  122
on modified records   .  .  .  .  .  .  .  .  .  .  .  126

Special menu  . . . . . . . . . . . . . . . . . . . . . . . .  35
Edit Input ASCII Map menu command .   35, 306
Edit Output ASCII Map menu command   35, 306
Execute Method menu command  .  .  .   35, 297

squares (drawing)  . . . . . . . . . . . . . . . . .  275–276
Stacked option

for Area graphs .  .  .  .  .  .  .  .  .  .  .  .  .  .  224
for Bar graphs   .  .  .  .  .  .  .  .  .  .  .  .  .  .  225
for Column graphs .  .  .  .  .  .  .  .  .  .  .  .  225
for Line graphs .  .  .  .  .  .  .  .  .  .  .  .  .  .  226
for Picture graphs.  .  .  .  .  .  .  .  .  .  .  .  .  227

Stacked Proportional option
for Area graphs .  .  .  .  .  .  .  .  .  .  .  .  .  .  224
for Bar graphs   .  .  .  .  .  .  .  .  .  .  .  .  .  .  225
for Column graphs .  .  .  .  .  .  .  .  .  .  .  .  225
for Picture graphs.  .  .  .  .  .  .  .  .  .  .  .  .  227

stacking order (setting) . . . . . . . . . . . . . . . . .  288
Start Angle option, for Pie charts . . . . . . . . . .  227
Start Web Server menu item (Web Server menu)  329
Stop Web Server menu item (Web Server menu)  329
structure files  . . . . . . . . . . . . . . . . . . .  22, 39–45
structure resource files . . . . . . . . . . . . . . . . 23, 39
style

of chart text, setting   .  .  .  .  .  .  .  .  .  .  .  272
of text objects, setting   .  .  .  .  .  .  .  .  .  .  279

subfields (in search conditions) . . . . . . . . . . . .  90
subforms  . . . . . . . . . . . . . . . . . . . . . . . . . 74–76

double-clickable  .  .  .  .  .  .  .  .  .  .  .  .  .  .  74
enterable   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  74
entering data in   .  .  .  .  .  .  .  .  .  .  .  .  74–76
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subtables
entering data in   .  .  .  .  .  .  .  .  .  .  .  .  .  .  74
searching on .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  90

Subtotal function. . . . . . . . . . . . . . . . . . . . .  133
Subtotal rows

hiding .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  178
labeling  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  172

SYLK format . . . . . . . . . . . . . . . . . . . . . . . .  302
System configuration (information about)  . . . .  36

T
tables

choosing.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  77–80
creating for importing data  .  .  .  .  .  .  .  .  308
current selection in .  .  .  .  .  .  .  .  .  .  .  .  .  82
invisible .  .  .  .  .  .  .  .  85, 114, 123, 144, 191
related .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  74
role of .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  20
updating contents of  .  .  .  .  .  .  .  .  .  .  .  105

Tab-Tab-Return (TTR) format. . . . . . . . . . . . .  242
templates

creating  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  218–219
definition of  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  218

text attributes, setting  . . . . . . . . . . . . . . . . .  279
Text fields. . . . . . . . . . . . . . . . . . . . . . . . . . .  60
Text format. . . . . . . . . . . . . . . . . . . . . . . . .  302

using delimiters   .  .  .  .  .  .  .  .  .  .  .  .  .  303
text objects

adding to labels   .  .  .  .  .  .  .  .  .  .  .  .  .  194
changing attributes (for charts)   .  .  .  .  .  .  279
creating  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  278
creating for charts   .  .  .  .  .  .  .  .  .  .  .  .  278
See also objects
setting fill patterns for   .  .  .  .  .  .  .  .  .  .  201

Text tool  . . . . . . . . . . . . . . . . . . . . . . . . . .  278
text. See chart text, text attributes, text objects
three-dimensional graphs

3D Area graph type .  .  .  .  .  .  .  .  .  .  .  .  232
3D Column graph type  .  .  .  .  .  .  .  .  .  .  230
3D Line graph type .  .  .  .  .  .  .  .  .  .  .  .  231
3D Spike graph type   .  .  .  .  .  .  .  .  .  .  .  234
3D Surface graph .  .  .  .  .  .  .  .  .  .  .  .  .  232
3D Triangle graph type  .  .  .  .  .  .  .  .  .  .  233
from data in the database .  .  .  .  .  .  .  236–241
parts of   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  229
perspective of, setting .  .  .  .  .  .  .  .  .  .  .  265
see also graphs and 3D graphs

tick marks, customizing  . . . . . . . . . . . . . . . .  254

Time fields (display formats for) . . . . . . . . . . . .  61
Tips in 4D Chart. . . . . . . . . . . . . . . . . . . . . .  267
Titles submenu. . . . . . . . . . . . . . . . . . . . . . .  256
titles, axis. See axis titles
titles, graph. See text objects
toolbar (Label Wizard). . . . . . . . . . . . . . . . . .  192
tools

Line  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  275
locking .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  276
Oval .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  275
Polygon   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  275
Rectangle .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  275
Rounded Rectangle  .  .  .  .  .  .  .  .  .  .  .  .  275
see also Chart Tool palette, Object Tool palette
selecting  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  275
Text  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  278

Tops Only option
for 3D Column graphs .  .  .  .  .  .  .  .  .  .  .  231
for 3D Surface graphs  .  .  .  .  .  .  .  .  .  .  .  233

Totals row
calculations in   .  .  .  .  .  .  .  .  .  .  .  .  .  .  173
hiding  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  178

two-dimensional graphs
adding depth to .  .  .  .  .  .  .  .  .  .  .  .  .  .  264
Area graph type .  .  .  .  .  .  .  .  .  .  .  .  .  .  223
Bar graph type   .  .  .  .  .  .  .  .  .  .  .  .  .  .  224
Column graph type  .  .  .  .  .  .  .  .  .  .  .  .  224
from data in the database  .  .  .  .  .  .   236–241
from data on the Clipboard   .  .  .  .  .   243–245
Line graph type .  .  .  .  .  .  .  .  .  .  .  .  .  .  225
parts of .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  221
Picture graph type.  .  .  .  .  .  .  .  .  .  .  .  .  227
Pie graph type   .  .  .  .  .  .  .  .  .  .  .  .  .  .  226
Polar graph type   .  .  .  .  .  .  .  .  .  .  .  .  .  228
Scatter graph type .  .  .  .  .  .  .  .  .  .  .  .  .  225
see also graphs

U
Ungroup menu item . . . . . . . . . . . . . . . . . . .  291
Unique attribute. . . . . . . . . . . . . . . . . . . . . . .  69
Unreference menu item. . . . . . . . . . . . .  284, 285
unreferencing

expressions .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  285
fields .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  285

Update License (Help menu)  . . . . . . . . . . . . . .  36
Update menu item . . . . . . . . . . . . . . . . . . . .  241
Use alternate DTD  . . . . . . . . . . . . . . . . . . . .  314
Use map button . . . . . . . . . . . . . . . . . . . . . .  306
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Use menu  . . . . . . . . . . . . . . . . . . . . . . . . . . .  32
Custom Menus command   .  .  .  .  .  .  .  .  .  32
Design menu command   .  .  .  .  .  .  .  .  .  .  32
User menu command   .  .  .  .  .  .  .  .  .  .  .  32

User environment. . . . . . . . . . . . . . . . . . .  15–37
changing between tables  .  .  .  .  .  .  .  .  .  .  76
creating quick reports in  .  .  .  .  .  .  .  .  .   139
custom menus in   .  .  .  .  .  .  .  .  .  .  .  .  .  36
Edit menu .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   31–32
Enter menu  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  33
File menu .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   30–31
Help menu   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  36
menus in  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   29–36
Plug-Ins menu .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  36
Queries menu  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  33
Report menu   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  34
role of   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  19
Special menu   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  35
testing methods  .  .  .  .  .  .  .  .  .  .  .  .  .   297
Use menu .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  32

V
Validation option (Import dialog) . . . . . . . . . .  314
Value to Field (Import Editor). . . . . . . . . . . . .  310
values

changing references to  .  .  .  .  .  .  .  .  .  .   284
displaying in Break columns   .  .  .  .  .  .  .   176
displaying references to.  .  .  .  .  .  .  .  .  .   284
for series, displaying  .  .  .  .  .  .  .  .  .  .  .   258
maximum and minimum.  .  .  .  .  .  .  .  .  .  69
see also series values

Values axis (for a 2D graph)
definition of .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   222
scale of, setting   .  .  .  .  .  .  .  .  .  .  .  .  .   254

Values axis (for a 3D graph)
definition of .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   230
scale of, setting   .  .  .  .  .  .  .  .  .  .  .  .  .   254
selecting a field for .  .  .  .  .  .  .  .  .  .  .  .   241

Values menu item (Chart menu). . . . . . . . . . .  259
View menu item . . . . . . . . . . . . . . . . . . . . . .  265

W
Web Server

automatic publication  .  .  .  .  .  .  .  .  .  .   330
menu .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  35
passwords .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  28
starting/stopping   .  .  .  .  .  .  .  .  .  .  .  .   328

WEDD resource . . . . . . . . . . . . . . . . . . . . . . .  40
wildcard (@) character (in searches) . . . .  87, 94, 99
windows

opening 4D Chart in plug-in   .  .  .  .  .  212–213
opening multiple 4D Chart  .  .  .  .  .  .  .  .  212

X
X-axis. See Category axis (for a 2D graph), 

Category axis (for a 3D graph) . . . . . .  222
XML format . . . . . . . . . . . . . . . . . . . . . . . .  302
XML page

Export .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  322
Import.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  314

XSL (Exporting). . . . . . . . . . . . . . . . . . . . . .  323

Y
Y-axis. See Series axis, Values axis (for a 2D graph)

Z
Zoom button in previewed report  . . . . . . . . .  131
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